FactoryTalk® Alarms and Events

SYSTEM CONFIGURATION GUIDE

PUBLICATION FTAE-RM001A-EN-E–May 2009
Contents

Preface

What you need to get started ................................................. 1
Required software ................................................................. 1
Recommended hardware and supported operating systems .............. 2
  Logix5000 controllers .......................................................... 3
  Compatible firmware ............................................................ 3
  Older controllers ................................................................. 4
How to get the information you need ......................................... 4
Special considerations for using this release of FactoryTalk Alarms and Events ......................................................... 4

Chapter 1
Overview of FactoryTalk Alarms and Events services ................... 5
Choosing between HMI Tag Alarm Monitoring and FactoryTalk Alarms and Events ......................................................... 6
Where to start ........................................................................... 8
FactoryTalk Alarms and Events components ................................. 9
About monitoring for alarm conditions ....................................... 11
  About software-based alarm monitoring ...................................... 11
  About device-based alarm monitoring ........................................ 12
Choosing between tag-based and device-based alarm monitoring .... 14
Graphic objects in FactoryTalk Alarms and Events ....................... 14

Chapter 2
Plan your system ..................................................................... 15
Decide what type of application you are building ......................... 15
Decide what type of alarm monitoring you need ............................ 16
What you need ......................................................................... 16
Follow these steps .................................................................... 17
Install and activate FactoryTalk software ..................................... 18
  Typical stand-alone system ....................................................... 18
Install FactoryTalk software ....................................................... 19
Install Microsoft SQL Server 2005 Express ................................. 19
Chapter 3 Define device-based alarms in Logix5000 controllers ................................. 21
  Alarm buffering during loss of connection to the controller ................................. 21
  Before you begin ........................................................................................................... 22
  What you need .............................................................................................................. 22
  Follow these steps ......................................................................................................... 23
  Define a digital alarm .................................................................................................... 24
    Configure the alarm and download to the controller ................................................. 24
  Define an analog alarm ................................................................................................. 32
    Configure the alarm and download it to the controller ............................................... 33

Chapter 4 Add a device server for Logix5000, PLC-5, or SLC 500 controllers ............ 43
  Before you begin ........................................................................................................... 43
  What you need .............................................................................................................. 43
  Follow these steps ......................................................................................................... 44
  Add a device server ....................................................................................................... 45

Chapter 5 Add an OPC Data Server for third-party controllers ................................. 53
  Before you begin ........................................................................................................... 53
  What you need .............................................................................................................. 53
  Follow these steps ......................................................................................................... 54
  Add an OPC Data Server to an application .................................................................... 54

Chapter 6 Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-
party controllers57
  Before you begin ........................................................................................................... 57
  What you need .............................................................................................................. 57
  Follow these steps ......................................................................................................... 58
  Create an application ..................................................................................................... 59
  Add a data server .......................................................................................................... 61
  Add a Tag Alarm and Event Server ............................................................................. 64
  Define alarm conditions ............................................................................................... 65
  Next steps .................................................................................................................... 67
### Chapter 7  Set up graphic displays  
**Before you begin**  
**What you need**  
**Follow these steps**  
**Create a graphic display**  
**Create an Alarm and Event Summary**  
**Create an Alarm and Event Banner display**  
**Create a startup macro for the Banner display**  
**Use color animation to indicate alarm state changes**  
**Next steps**

### Chapter 8  Monitor and interact with alarms at run time  
**Before you begin**  
**What you need**  
**Follow these steps**  
**Create and then run a FactoryTalk View Client configuration**  
**Monitor alarms and events**  
**Security for alarms and events**  
**Acknowledge an alarm**  
**Disable or enable an alarm**  
**Suppress or unsuppress an alarm**

### Chapter 9  Set up historical alarm and event logging  
**Before you begin**  
**What you need**  
**Follow these steps**  
**Confirm that the Microsoft SQL Server software is installed**  
**Add a database definition to your FactoryTalk system**  
**Associate a database definition with an alarm server**  
**Create an Alarm and Event Log Viewer display**  
**Create a button to open the Alarm and Event Log Viewer display**  
**Create a startup macro for the Menu Bar display**  
**View historical alarm data in a FactoryTalk View SE Client**  
**Run the application**
<table>
<thead>
<tr>
<th>Appendix A</th>
<th>Getting started with language switching</th>
<th>137</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Before you begin</td>
<td>137</td>
</tr>
<tr>
<td></td>
<td>What you need</td>
<td>138</td>
</tr>
<tr>
<td></td>
<td>Follow these steps</td>
<td>139</td>
</tr>
<tr>
<td></td>
<td>Create device-based alarm messages</td>
<td>139</td>
</tr>
<tr>
<td></td>
<td> Translate alarm messages using import and export</td>
<td>140</td>
</tr>
<tr>
<td></td>
<td> Translate alarm messages in RSLogix 5000 v.16 or earlier</td>
<td>140</td>
</tr>
<tr>
<td></td>
<td> Translating alarm messages using RSLogix 5000 v. 17 or later</td>
<td>144</td>
</tr>
<tr>
<td></td>
<td>Create tag-based alarm messages</td>
<td>147</td>
</tr>
<tr>
<td></td>
<td> Entering text strings in FactoryTalk View Studio</td>
<td>147</td>
</tr>
<tr>
<td></td>
<td>Add languages to the application</td>
<td>152</td>
</tr>
<tr>
<td></td>
<td>Add buttons to a graphic display to switch languages at run time</td>
<td>153</td>
</tr>
<tr>
<td></td>
<td>Enter alarm messages in other languages</td>
<td>157</td>
</tr>
<tr>
<td></td>
<td>Create a Display Client configuration file to test alarm messages</td>
<td>166</td>
</tr>
<tr>
<td></td>
<td>Test alarm messages at run time</td>
<td>170</td>
</tr>
<tr>
<td></td>
<td>Summary and tips for setting up language switching</td>
<td>172</td>
</tr>
<tr>
<td></td>
<td> Text that supports language switching</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td> Text that does not support language switching</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td> Alarm and Event Summary and Alarm and Event Banner</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td> Alarm and Event Log Viewer</td>
<td>174</td>
</tr>
<tr>
<td>Appendix B</td>
<td>System performance and limits</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Controller specifications</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Tested system limits</td>
<td>176</td>
</tr>
<tr>
<td></td>
<td>Tested topology</td>
<td>177</td>
</tr>
<tr>
<td>Appendix C</td>
<td>Install FactoryTalk Alarms and Events manually</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Summary of steps</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>Step 1: Confirm that the FactoryTalk Services Platform is installed</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>Step 2: Install FactoryTalk Alarms and Events</td>
<td>180</td>
</tr>
</tbody>
</table>
Appendix D  Install Microsoft SQL Server 2005 Express . . . . . . . . 183
  Operating systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
  Summary of steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
  Step 1: Open the Redist folder . . . . . . . . . . . . . . . . . . . . . . . 184
  Step 2: Install the .NET Framework and other prerequisite software . 185
    .NET Framework . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
    MDAC 2.8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
    MSXML6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
    Windows Installer 3.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
  Step 3: Run the SQL Server Install batch file (not the .exe) . . . . . . 186
  Step 4: Install Microsoft SQL Server Management Studio Express . . 189
    Error message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
  Step 5: Configure the Windows firewall . . . . . . . . . . . . . . . . . . . . 190

Appendix E  Use an existing Microsoft SQL Server database . . . . . . . . . . . . . 191
  Supported SQL Server databases . . . . . . . . . . . . . . . . . . . . . . . 191
  Remote connections to the SQL Server database . . . . . . . . . . . . 191
  Summary of steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
  Step 1: Install Microsoft SQL Server Management Tools . . . . . . . 192
  Step 2: Specify Mixed Mode authentication for the SQL Server database 193
  Step 3: Configure TCP/IP protocol for the database . . . . . . . . . . 194
  Step 4: Enable the SQL Server Browser service . . . . . . . . . . . . 194
  Step 5: Configure the Windows Firewall . . . . . . . . . . . . . . . . . . 195

Appendix F  Alarm time stamping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
  Overview of Logix clocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
  Coordinated System Time (CST) . . . . . . . . . . . . . . . . . . . . . . . . 197
  Coordinated Universal Time (UTC) . . . . . . . . . . . . . . . . . . . . . . 198
  Local Time (Wall Clock Time) . . . . . . . . . . . . . . . . . . . . . . . . 198
  FactoryTalk Alarms and Events: features for alarm monitoring . . 200
    ALMD and ALMA alarm blocks . . . . . . . . . . . . . . . . . . . . . . . . 200
  Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
<table>
<thead>
<tr>
<th>Appendix G</th>
<th>Time synchronization.</th>
<th>203</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinating multiple controllers’ wall clocks</td>
<td>203</td>
<td></td>
</tr>
<tr>
<td>Install the Logix5000 Clock Update Tool</td>
<td>204</td>
<td></td>
</tr>
<tr>
<td>Start the Logix5000 Clock Update Tool</td>
<td>204</td>
<td></td>
</tr>
<tr>
<td>Starting the Update Tool automatically</td>
<td>204</td>
<td></td>
</tr>
<tr>
<td>Using the Logix5000 Clock Update Tool</td>
<td>205</td>
<td></td>
</tr>
<tr>
<td>Create a synchronization schedule</td>
<td>206</td>
<td></td>
</tr>
<tr>
<td>Remove a synchronization schedule</td>
<td>207</td>
<td></td>
</tr>
<tr>
<td>Modify a synchronization schedule</td>
<td>207</td>
<td></td>
</tr>
<tr>
<td>Enable or disable a synchronization schedule</td>
<td>207</td>
<td></td>
</tr>
<tr>
<td>Add devices</td>
<td>208</td>
<td></td>
</tr>
<tr>
<td>Remove a device</td>
<td>209</td>
<td></td>
</tr>
<tr>
<td>View details about a device</td>
<td>209</td>
<td></td>
</tr>
<tr>
<td>Assign devices to synchronization schedules</td>
<td>210</td>
<td></td>
</tr>
<tr>
<td>Synchronize devices manually</td>
<td>211</td>
<td></td>
</tr>
<tr>
<td>View the log file</td>
<td>211</td>
<td></td>
</tr>
<tr>
<td>Change the location of the log file</td>
<td>211</td>
<td></td>
</tr>
<tr>
<td>Time stamps with tag-based alarms</td>
<td>212</td>
<td></td>
</tr>
<tr>
<td>Supported devices</td>
<td>213</td>
<td></td>
</tr>
</tbody>
</table>

| Appendix H | Reference for building a distributed system | 215 |
| Installing FactoryTalk Alarms & Events software | 215 |
| Typical distributed system on a network | 215 |

| Appendix I | Language identifiers for language switching | 217 |
| Language identifiers | 217 |
What you need to get started

The FactoryTalk System Configuration Guide describes the tasks that are required to install, configure, and use FactoryTalk Alarms and Events services as part of a FactoryTalk-enabled automation system. This guide also includes references to additional documentation that provides more detail.

This guide describes how to set up a Local application. However, the procedure for setting up a Network application is similar. This guide provides information about Network applications where it is necessary. See the Help for the individual software products used to configure and use Alarms and Events services.

Required software

The following software is required to configure and operate FactoryTalk Alarms and Events services:

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>FactoryTalk Services Platform</td>
<td>2.10 or later</td>
</tr>
<tr>
<td>FactoryTalk Alarms and Events</td>
<td>2.10 or later (included with FactoryTalk View Site Edition and RSLinx Enterprise)</td>
</tr>
<tr>
<td>RSLinx Enterprise</td>
<td>5.00</td>
</tr>
<tr>
<td>RSLinx 5000</td>
<td>16.03 or later</td>
</tr>
<tr>
<td>RSLinx 500 (optional)</td>
<td>version that supports FactoryTalk Services Platform 2.10 or later</td>
</tr>
<tr>
<td>RSLinx 5 (optional)</td>
<td>version that supports FactoryTalk Services Platform 2.10 or later</td>
</tr>
<tr>
<td>FactoryTalk View Site Edition</td>
<td>5.00 or later</td>
</tr>
<tr>
<td>FactoryTalk View Studio</td>
<td>5.00 or later</td>
</tr>
<tr>
<td>RSLinx Classic (used for Logix programming)</td>
<td>2.50.20 or later</td>
</tr>
<tr>
<td>ControlFlash</td>
<td>4.00.09 (used to download firmware)</td>
</tr>
<tr>
<td>SoftLogix (optional)</td>
<td>16.03 or later</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>2000 (SP4), 2005, or 2005 Express (SP2). SQL Server 2005 Express, Service Pack 2 is provided on both the FactoryTalk View and RSLinx Enterprise installation CDs. To install, see “Install Microsoft SQL Server 2005 Express” on page 183 for instructions.</td>
</tr>
</tbody>
</table>
Recommended hardware and supported operating systems

The hardware and supported operating systems that are recommended to run FactoryTalk Alarms and Events are the same hardware and operating systems that are recommended to run FactoryTalk View Site Edition. For details, see the *FactoryTalk View Site Edition Installation Guide*. To open it, in FactoryTalk View Studio, click the Help menu, point to Online Books, and then click Installation Guide.
Logix5000 controllers

The Logix5000 controllers listed in the following table, support FactoryTalk Alarms and Events services. When you use built-in alarm instructions in Logix5000 controllers, these controllers require a firmware update to version 16.20 or later. If you do not want to update the firmware in your controllers, use a Tag Alarm and Event Server for software-based alarms and events. See “Decide what type of alarm monitoring you need” on page 16.

<table>
<thead>
<tr>
<th>Catalog number</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1756-L61</td>
<td>ControlLogix Processor</td>
</tr>
<tr>
<td>1756-L62</td>
<td>ControlLogix Processor</td>
</tr>
<tr>
<td>1756-L63</td>
<td>ControlLogix Processor</td>
</tr>
<tr>
<td>1756-L64</td>
<td>ControlLogix Processor</td>
</tr>
<tr>
<td>1756-5555</td>
<td>5555 ControlLogix Processor</td>
</tr>
<tr>
<td>1768-L43</td>
<td>CompactLogix L43 Controller</td>
</tr>
<tr>
<td>1769-L31</td>
<td>CompactLogix L31 Controller</td>
</tr>
<tr>
<td>1769-L32C</td>
<td>CompactLogix L32C Controller</td>
</tr>
<tr>
<td>1769-L32E</td>
<td>CompactLogix L32E Controller</td>
</tr>
<tr>
<td>1769-L35CR</td>
<td>CompactLogix L35CR Controller</td>
</tr>
<tr>
<td>1769-L35E</td>
<td>CompactLogix L35E Controller</td>
</tr>
<tr>
<td>1794-L34</td>
<td>FlexLogix L34 Controller</td>
</tr>
<tr>
<td>1756-L61S</td>
<td>ControlLogix Safety Processor</td>
</tr>
<tr>
<td>1756-L62S</td>
<td>ControlLogix Safety Processor</td>
</tr>
<tr>
<td>PowerFlex 700S 2</td>
<td>DriveLogix5370</td>
</tr>
<tr>
<td>1789-L60</td>
<td>SoftLogix5800</td>
</tr>
<tr>
<td>EMULATE</td>
<td>RSLogix Emulate 5000</td>
</tr>
</tbody>
</table>

Compatible firmware

The controller firmware versions listed in the following table, are compatible with FactoryTalk Alarms and Events services:

<table>
<thead>
<tr>
<th>Controller</th>
<th>Firmware version</th>
</tr>
</thead>
<tbody>
<tr>
<td>ControlLogix</td>
<td></td>
</tr>
<tr>
<td>CompactLogix L3x and L4x</td>
<td>16.20 or higher</td>
</tr>
<tr>
<td>DriveLogix</td>
<td></td>
</tr>
<tr>
<td>ControlLogix Redundant Systems</td>
<td>16.60 or higher</td>
</tr>
<tr>
<td>SoftLogix</td>
<td>16.03 or higher</td>
</tr>
</tbody>
</table>
Older controllers

These controllers also support FactoryTalk Alarms and Events services:

- Logix5000 controllers that communicate with RSLinx Enterprise, using Tag Alarm and Event Servers
- PLC-5 and SLC 500 controllers that communicate with RSLinx Enterprise (or RSLinx Classic to bridge from Ethernet to DH+ or DH-485 networks), using Tag Alarm and Event Servers
- Third-party PLCs that communicate with OPC Data Servers such as KEPWare, using Tag Alarm and Event Servers

How to get the information you need

For more information about the products and components discussed in this guide, the following manuals and Help files are available:

- FactoryTalk Help (Start > All Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk Help)
- RSLinx 5000 Online Help (for help with developing a controller project)
- RSLinx 5000 Quick Start
- RSLinx 5000 Online Books
- RSLinx Classic Online Help (for help with configuring drivers and creating topics)
- RSLinx Classic Quick Start Guide
- RSLinx Enterprise Getting Results Guide
- RSLinx Enterprise Online Help

Special considerations for using this release of FactoryTalk Alarms and Events

When designing your alarms and events system, take note of the following special considerations for this release of FactoryTalk Alarms and Events:

- All servers must be installed on the same computer, as shown in “Tested topology” on page 177.
- Redundancy is not supported for Alarms and Events in this release. See “Tested topology” on page 177.
- For information about performance limits, see Appendix B, “System performance and limits”.

Overview of FactoryTalk Alarms and Events services

FactoryTalk View Site Edition now supports two systems that monitor and log alarms. HMI tag alarm monitoring is still supported to maintain compatibility with existing applications.

FactoryTalk Services Platform and FactoryTalk View Site Edition introduced a new system of monitoring alarm and event information. You can now use FactoryTalk® Alarms and Events, with multiple FactoryTalk products to provide a common, consistent view of alarms and events throughout a FactoryTalk system.

FactoryTalk Alarms and Events supports two types of alarm monitoring:

- **Device-based alarm monitoring.** Built-in alarm instructions, that are available in RSLogix 5000 v. 16 or later, are programmed in a logic project and then downloaded to a Logix5000 controller. The controller detects alarm conditions and publishes event information, which can be displayed and logged.

- **Tag-based alarm monitoring.** If you are not using Logix5000 controllers, or if you do not want to use the built-in alarm instructions that are available with RSLogix 5000, tag-based alarm monitoring offers the equivalent of HMI tag alarm monitoring, but with an expanded feature set. Software-based Tag Alarm and Event servers monitor controllers for alarm conditions through data servers and publish event information that can be displayed and logged. Tag-based alarm monitoring is supported for Logix5000 controllers, PLC-5, and SLC 500 devices communicating through Rockwell Automation device servers (RSLinx Enterprise), or for third-party controllers communicating through OPC Data Servers.

FactoryTalk Alarms and Events:

- **Provides a single, integrated set of alarm information.** All participating FactoryTalk products work together to provide a consistent way to define, manage, log, and view alarm and event information across a FactoryTalk application.

- **Streamlines alarm programming and eliminates polling with device-based alarm monitoring.** If your automation system includes Logix5000 controllers, you can use pre-built alarm instructions, available in RSLogix 5000 v. 16 or later, to simplify coding, and then download them to the controller. Device-based alarm monitoring eliminates the need for duplicating alarm tags in an HMI server and requires fewer controller communication resources by eliminating polling.

- **Supports other controllers in the integrated system with tag-based alarm monitoring.** If your automation system includes other Rockwell Automation controllers, such as PLC-5s or SLC 500s, or if you prefer not to use the new alarm instructions with Logix5000 controllers, software-based tag servers monitor controllers for alarm conditions and publish event information.
- Monitors alarms and events from third-party controllers. Tag-based alarm monitoring also makes it possible to monitor alarm conditions from third-party controllers, which communicate through OPC Data Servers.

- Provides accurate time stamps on alarm conditions that are generated from Logix5000 controllers using device-based alarm monitoring. When you use device-based alarm monitoring, timestamps are applied immediately in the controller and are not delayed until alarms reach an HMI server. To make sure that the timestamps on device-based alarms are accurate, synchronize the clocks of all controllers that produce alarms. The event time is propagated throughout the FactoryTalk Alarms and Events system, so inaccurate timestamps can affect where alarms are displayed in the Alarm and Event Summary or the Alarm and Event Banner as well as reports about the alarm and event history. For more information about synchronizing controller clocks, see Appendix G, “Time synchronization”.

- Sends process data with events and messages. You can associate up to four tags with each alarm to include process data with event information and alarm messages.

- Secures access to alarm and event operations through integration with FactoryTalk Security.

- Generates messages for logging, including audit messages that track operator actions, system-related diagnostic messages, and historical alarm and event messages.

- Displays alarm messages and status information at run time, from FactoryTalk View graphic displays.

Choosing between HMI Tag Alarm Monitoring and FactoryTalk Alarms and Events

HMI tag alarm monitoring and FactoryTalk Alarms and Events are two separate alarm monitoring systems and do not share alarm information with each other. FactoryTalk tag-based and device-based alarm information can only be displayed in the FactoryTalk alarm and event objects. FactoryTalk View HMI tag alarm information cannot be displayed in FactoryTalk alarm and event objects.

If you are already using HMI tag alarm monitoring in existing applications, or you if you require server redundancy, you can continue using it. However, to take advantage of the new features of FactoryTalk Alarms and Events you will need to migrate your existing alarm monitoring system to FactoryTalk Alarms and Events.
Migrate to FactoryTalk Alarms and Events if you want to:

- use device-based alarm monitoring. You can use a Logix5000 controller not only to detect alarms, but also to monitor alarms. This keeps all alarm and event processing in the controller. To use device-based alarm monitoring, add the built-in alarm instructions, available in RSLogix 5000 v. 16 or later, to a logic project and then download the project to a Logix5000 controller. The controller detects alarm conditions and publishes event information, which can be displayed and logged.


- take advantage of the richer feature set offered by FactoryTalk Alarms and Events, including:
  - a more configurable Alarm and Event Summary that includes the ability to suppress alarms directly from the summary, without the use of separate commands
  - Alarm and Event Banner, Alarm and Event Log Viewer, and Alarm Status Explorer objects that can also be hosted in graphic displays. You can use the Alarm Status Explorer to enable or disable alarms, suppress or unsuppress alarms, and view operator comments.
  - the Alarm and Event Banner can provide a view of all alarms—system wide—rather than just the alarms in a single HMI server exposed by the system\AlarmBanner system tag
Where to start

Chapter 1
Overview

Chapter 2
Plan your system

Set up device-based alarm monitoring

Chapter 3
Define alarms in Logix5000 controllers

Chapter 4
Add a device server for Logix5000 controllers

Set up tag-based alarm monitoring

Chapter 5
Add a data server for PLC, SLC or 3rd-party controllers

Chapter 6
Add a tag-based alarm server for PLC, SLC or 3rd-party controllers

Chapter 7
Set up graphic displays

Chapter 8
Monitor and interact with alarms during runtime

Chapter 9
Set up historical alarm and event logging
FactoryTalk Alarms and Events components

The following diagram shows a high-level view of the components of the FactoryTalk Alarms and Events system. For more detailed information, see FactoryTalk Alarms and Events Help (click Start, point to All Programs > Rockwell Software > FactoryTalk Tools and then click FactoryTalk Help).

1. Device-based alarm monitoring

To do device-based alarm monitoring, you program alarm instructions, that are available with RSLogix 5000 v. 16 or later, and then download them to Logix5000 controllers. The controller detects alarm conditions and notifies RSLinx Enterprise of alarm states. A Rockwell Automation device server (RSLinx Enterprise) extracts the alarm information and publishes it to FactoryTalk Alarms and Events services.
Use device-based alarm monitoring with:

- Logix5000 controllers, that you have programmed with RSLogix 5000 v. 16 or later software, and Rockwell Automation device servers (RSLinx Enterprise).

2. Tag-based alarm monitoring

The Tag Alarm and Event Server uses tags to monitor programmable controllers for alarm conditions. When an alarm condition is detected, the server publishes the information to FactoryTalk Alarms and Events services.

Use tag-based alarm monitoring with:

- PLC-5 or SLC 500 devices, and Rockwell Automation device servers (RSLinx Enterprise).
- RSLinx Classic or RSLinx Gateway.
- Third-party controllers and OPC Data Servers.
- Logix5000 controllers.

3. FactoryTalk Alarms and Events services

Both device-based and tag-based alarms and events are published to FactoryTalk Alarms and Events services, which then routes the information to FactoryTalk Alarms and Events objects hosted in FactoryTalk View, the alarm and event history log, and to diagnostic logs and audit logs.

4. Alarm and Event Historian and Log

The Alarm and Event Historian is a logging component that installs silently as part of the alarms and events software. It manages connections between alarm servers and databases and logs data from each alarm server to an alarm history database. You can use the Alarm and Event Log Viewer to view and print data from alarm history databases. Third-party database tools can also retrieve, view, analyze, and print alarm history information.

To use alarm and event logging, install Microsoft SQL Server 2005 Express SP2 separately, or use an existing Microsoft SQL Server 2000 SP4 or Microsoft SQL Server 2005 database.

5. Diagnostic and audit logs

FactoryTalk Diagnostics routes messages generated by FactoryTalk Alarms and Events to local logs on the computers hosting FactoryTalk components, and optionally to a centralized database log. Audit messages are also routed to the local log and to the FactoryTalk Audit Log if FactoryTalk AssetCentre is installed.

6. Alarm and event setup and monitoring

FactoryTalk Alarms and Events includes a number of software components that allow engineers and operators to define alarm conditions, set up alarm servers, view and interact with alarm conditions, and view and run reports on historical alarm information.
**Alarm and Event Summary**

Use the Alarm and Event Summary object, embedded in a FactoryTalk View graphic display, to acknowledge, disable, suppress, filter, and sort alarms at run time.

**Alarm and Event Banner**

Use the Alarm and Event Banner object, embedded in a FactoryTalk View graphic display, to monitor and respond to the most serious alarms that require immediate attention.

**Alarm Status Explorer**

Use the Alarm Status Explorer object, embedded in a FactoryTalk View graphic display, to enable or disable alarms, suppress or unsuppress alarms, and view operator comments.

**Database definitions**

Use database definitions to define logging options from an alarm server to a Microsoft SQL Server database.

**Alarm and Event Log Viewer**

Use the Alarm and Event Log Viewer object, embedded in a FactoryTalk View graphic display, to view and filter historical alarm information stored in Microsoft SQL Server databases.

**Diagnostics Viewer**

Use the Diagnostics Viewer to view, filter, and export system-generated diagnostic messages. Run the Diagnostics Viewer from either FactoryTalk View Studio or FactoryTalk Administration Console.

**FactoryTalk Audit Log**

Use the FactoryTalk Audit Log to view and manage audit messages routed by FactoryTalk Diagnostics. To access the Audit Log, use RSMACC or FactoryTalk AssetCentre software.

### About monitoring for alarm conditions

You can monitor for alarm conditions in two ways—using software-based alarm monitoring, or device-based alarm monitoring.

### About software-based alarm monitoring

HMI tag alarm monitoring, offered by FactoryTalk View Site Edition, and tag-based alarm monitoring, offered by FactoryTalk Alarms and Events, are both examples of software-based alarm monitoring.

Software-based alarm monitoring is a generic way of monitoring alarms from legacy or third-party controllers.

With software-based alarm monitoring, alarm detection occurs in the controller, but alarm monitoring is performed by software-based servers.
Tag-based alarm monitoring works like this (similar to HMI Tag Alarm Monitoring):

This approach has several disadvantages:

- Programming is required in both the controller and the HMI software or Tag Alarm and Event Server.
- Tags must be duplicated in the HMI server and mapped to the controller. For Tag Alarm and Event Servers, controller tags must be mapped to alarms—in either case, a tedious, error-prone process.
- Alarms are detected and processed twice, first in the controller logic and then again in the HMI software or Tag Alarm and Event Server.
- Polling between the HMI server or Tag Alarm and Event Server and controller tags increases network overhead.
- Alarm time stamps are delayed because they are applied by the HMI server or Tag Alarm and Event Server after polling and processing, rather than immediately when they occur. Time stamps are not synchronized among multiple alarm servers.
- Alarm acknowledge and enable states are held in the computer, and not in the controller. If the computer goes down, alarm state information is lost.

About device-based alarm monitoring

With device-based alarm monitoring, alarm detection also occurs in the controller, but unlike software-based alarm monitoring, monitoring for alarm conditions is done in the controller as well.
Device-based alarm monitoring works like this:

This approach has several advantages over software-based alarm detection:

- Alarm instructions are programmed only once, and then downloaded to the controller, which reduces programming effort and errors.
- Alarm conditions are detected more quickly.
- Alarms are detected at the same time the logic is being executed.
- HMI tags or alarms in a Tag Alarm and Event Server are not required, which reduces overhead and potential tag mapping errors.
- Alarm state is managed, processed, and preserved by controllers, even if a computer is stopped.
- Data polling is eliminated and Alarm status is communicated only when state changes, which reduces network overhead, controller processing, and improves overall system performance.
- Time stamps on alarm conditions are precise, because they are applied in the controller, and not delayed until they reach the HMI software or Tag Alarm and Event Server. However, all controllers that produce alarms must have their clocks synchronized because device-based alarms are stamped with the controller’s time. The event time is published throughout the FactoryTalk Alarms and Events system, so inaccurate time stamps can affect where alarms are displayed in the Alarm and Event Summary or the Alarm and Event Banner, as well as in reports based on the alarm and event history. For more information about synchronizing controller clocks, see Appendix G, “Time synchronization”.

Alarm instructions are programmed only once, and then downloaded to the controller, which reduces programming effort and errors.
- Alarm conditions are detected more quickly.
- Alarms are detected at the same time the logic is being executed.
- HMI tags or alarms in a Tag Alarm and Event Server are not required, which reduces overhead and potential tag mapping errors.
- Alarm state is managed, processed, and preserved by controllers, even if a computer is stopped.
- Data polling is eliminated and Alarm status is communicated only when state changes, which reduces network overhead, controller processing, and improves overall system performance.
- Time stamps on alarm conditions are precise, because they are applied in the controller, and not delayed until they reach the HMI software or Tag Alarm and Event Server. However, all controllers that produce alarms must have their clocks synchronized because device-based alarms are stamped with the controller’s time. The event time is published throughout the FactoryTalk Alarms and Events system, so inaccurate time stamps can affect where alarms are displayed in the Alarm and Event Summary or the Alarm and Event Banner, as well as in reports based on the alarm and event history. For more information about synchronizing controller clocks, see Appendix G, “Time synchronization”.

13 • Overview of FactoryTalk Alarms and Events services
Choosing between tag-based and device-based alarm monitoring

Use tag-based alarm monitoring with:

- Logix5000 controllers
- PLC-5, SLC 500 devices
- Third-party controllers that communicate through OPC Data Servers

Use device-based alarm monitoring with:

- Logix5000 controllers, using downloaded alarm instructions programmed with RSLinx 5000 v. 16 or later.

Graphic objects in FactoryTalk Alarms and Events

FactoryTalk Alarms and Events graphic objects are on the Objects menu in the Graphics editor in FactoryTalk View Site Edition. The HMI tag alarm monitoring objects remain available for compatibility with existing applications.

<table>
<thead>
<tr>
<th>To do this</th>
<th>In HMI tag alarm monitoring, you do it this way</th>
<th>With FactoryTalk Alarms and Events, you do it this way</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge, disable, suppress, filter, and sort alarms at run time</td>
<td>HMI Tag Alarm Summary</td>
<td>Alarm and Event Summary</td>
</tr>
<tr>
<td>Enable or disable alarms, suppress or unsuppress alarms, and view operator comments</td>
<td>HMI Tag Alarm Summary (suppress only, using the Execute feature) SuppressOn and SuppressOff commands Suppressed list</td>
<td>Alarm and Event Summary (suppress only; to unsuppress alarms, use the Alarm Status Explorer) Alarm Status Explorer</td>
</tr>
<tr>
<td>Monitor and respond to the most serious alarms that require immediate attention</td>
<td>Alarm system tags</td>
<td>Alarm and Event Banner</td>
</tr>
<tr>
<td>View, filter, and print historical alarm information</td>
<td>HMI Tag Alarm Log Viewer</td>
<td>Alarm and Event Log Viewer</td>
</tr>
<tr>
<td></td>
<td>Alarms are logged to a proprietary format, and can be exported to an ODBC-compliant database.</td>
<td>Historical alarm information is stored in Microsoft SQL Server databases.</td>
</tr>
</tbody>
</table>
Plan your system

Before you build and deploy FactoryTalk Alarms and Events as part of a local or network application, consider which computer hardware and operating systems you plan to use, as well as where to install the various hardware and software components. The information in this chapter offers some guidelines as you begin planning. See also “Required software” on page 1 and “Recommended hardware and supported operating systems” on page 2.

Decide what type of application you are building

You must decide whether you are building a local application on a stand-alone computer, or a network application distributed across multiple computers. This system configuration guide discusses how to install, configure and use software on a stand-alone system.

FactoryTalk Alarms and Events is not supported for use with FactoryTalk View Machine Edition.

- **Network applications** (sometimes called distributed applications) are held in a FactoryTalk Network Directory, and organize project information from multiple FactoryTalk products and services that are distributed across multiple computers on a network. The applications you create in the Network Directory can be divided into any number of areas and are available to all FactoryTalk products and computers on a network. See “Typical distributed system on a network” on page 215 for more information.

- **Local applications** are suitable for self-contained, stand-alone processes that do not interact with other processes or systems. Local applications are held in a FactoryTalk Local Directory, and are accessible only from the local computer where they reside. Even if the computer is connected to a network, and even if a network application resides on the same computer, the applications you create in the FactoryTalk Local Directory remain self-contained and do not share data or project elements.

  Local applications do not support areas, and all application components and participating software products are located on a single computer. See “Typical stand-alone system” on page 18 for more information.

To use Alarms and Events with a local application, install all software on the same computer.
Decide what type of alarm monitoring you need

FactoryTalk Alarms and Events supports two types of alarm monitoring:

- **Device-based alarm monitoring.** Built-in alarm instructions, that are available in RSLinx 5000 v. 16 or later, are programmed in a logic project and then downloaded to a Logix5000 controller. The controller detects alarm conditions and publishes event information, which can be displayed and logged.

- **Tag-based alarm monitoring.** Software-based tag alarm and event servers monitor controllers for alarm conditions through data servers and publish event information, which can be displayed and logged. Tag-based alarm monitoring is supported for Logix5000, PLC-5, and SLC 500 devices communicating through Rockwell Automation device servers (RSLinx Enterprise), or for third-party controllers that communicate through OPC Data Servers.

You can use a mix of both types of alarm monitoring. Choose tag-based alarm monitoring if you do not want to change the logic in your programmable controllers. Choose tag-based alarm monitoring, if you do not want to update the firmware in Logix5000 controllers.

What you need

- Decide what type of application you are building.

- Decide what type of alarm monitoring you need.

- Install and activate FactoryTalk software.

- Update Logix5000 firmware to version 16 if you plan to use device-based alarm monitoring and alarm instructions that are built into Logix5000 controllers. If you do not plan to use device-based alarm instructions, you can skip this step and use tag-based alarm monitoring with a Tag Alarm and Event Server instead.
Follow these steps

- Determine network configuration
- Install and activate FactoryTalk View software *
- Install and activate RSLinx Enterprise software
- Install RSLinx Classic software
- Install and activate RSLogix software
- Update Logix5000 firmware to v. 16 (optional if using Tag Alarm and Event Servers)
- (Optional) Install Microsoft SQL Server 2005 Express

* FactoryTalk Services Platform and FactoryTalk Alarms and Events software are installed along with FactoryTalk View and RSLinx Enterprise software.
Install and activate FactoryTalk software

Follow these procedures to install and activate the software products required for FactoryTalk Alarms and Events.

This guide describes how to set up a local application. The procedure to set up a network application is similar. This guide provides additional information about Network applications where it is necessary. See also Appendix H, “Reference for building a distributed system”.

For more information about each software product, see that product’s Help.

Typical stand-alone system

To use FactoryTalk Alarms and Events with a local application as part of a stand-alone FactoryTalk system, install all software on the same computer. Use this diagram only as a starting point; your own system will vary.
Install FactoryTalk software

For specific installation instructions, refer to the installation guide for each product.

If you plan to build local applications, install everything on one computer.

If you plan to build network applications distributed across multiple computers, see FactoryTalk Help (Start > All Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk Help) for instructions.

To set up a FactoryTalk system, install this software:

- FactoryTalk Services Platform
- FactoryTalk Activation
- FactoryTalk View Site Edition
- RSLinx Enterprise
- RSLinx Classic
- RSLogix 5000

- Update Logix5000 firmware to version 16 (if you plan to use device-based alarm monitoring—see “Decide what type of alarm monitoring you need” on page 16)

Install Microsoft SQL Server 2005 Express

If you plan to log historical alarm and event messages to a database, you must install Microsoft SQL Server software on the computer you want to use for logging. We recommend that to install Microsoft SQL Server 2005 Express (SP2) you use the batch file that is available on both the FactoryTalk View and RSLinx Enterprise installation CDs, in the Redist folder. For installation instructions, see “Install Microsoft SQL Server 2005 Express” on page 183.

If you already have Microsoft SQL Server 2000 (SP4) or 2005 installed, you may need to change the configuration options to log alarm and event messages. For configuration instructions, see “Use an existing Microsoft SQL Server database” on page 191.
Define device-based alarms in Logix5000 controllers

To set up device-based alarm monitoring, you program alarm instructions, that are available with RSLogix 5000 v. 16 or later, and download them to a Logix5000 controller. The controller detects alarm conditions and notifies alarms and events services of alarm states. Software components publish this information to a device server, where it can be logged to a database, and viewed, acknowledged, suppressed, enabled, or disabled from FactoryTalk View graphic displays.

FactoryTalk Alarms and Events can handle many different types of alarms. The controller limits the alarms to digital and analog. An analog alarm instruction monitors two types of alarm conditions: Level and Rate of Change. A tag-based alarm server supports three alarm types: Digital, Level and Deviation.

A digital alarm instruction is based on the input rung state (in ladder logic) or on the alarm input (for function block). The trigger condition compares the value of the tag to either zero or one.

An analog alarm defines a condition that evaluates a single analog tag against up to four limit values (high-high to low-low) and up to two rate of change limits (positive and negative).

If your FactoryTalk application does not include Logix5000 controllers, or if your controllers are not programmed with the new alarm instructions included in RSLogix 5000 v. 16 or later, see Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

Alarm buffering during loss of connection to the controller

To receive device-based alarms, the alarm server (RSLinx Enterprise) establishes a subscription to the alarms in the Logix controller. The controller maintains a connection to each subscriber and monitors the status of that connection.

As alarm state changes occur, the controller caches information such as timestamps, alarm state and associated tag values, and transmits the information to all of the subscribers.

If any subscriber fails to confirm the receipt of the alarm information, or if the connection to a subscriber is not good, the controller stores the undelivered alarm information in a 100 KB buffer. Each subscriber has its own buffer and communication problems with one subscriber do not interfere with alarm delivery to other subscribers. When the buffer is full, newer alarm information is discarded and a FactoryTalk Diagnostics message is logged. The buffer is created when the subscriber establishes its initial connection, and is maintained for a length of time after a subscriber loses its connection. The length of time is specified in the Buffer Timeout setting on each RSLinx Enterprise device shortcut. See Chapter 4, “Create a new shortcut to the controller”.

TIP

If your FactoryTalk application does not include Logix5000 controllers, or if your controllers are not programmed with the new alarm instructions included in RSLogix 5000 v. 16 or later, see Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

Alarm buffering during loss of connection to the controller

To receive device-based alarms, the alarm server (RSLinx Enterprise) establishes a subscription to the alarms in the Logix controller. The controller maintains a connection to each subscriber and monitors the status of that connection.

As alarm state changes occur, the controller caches information such as timestamps, alarm state and associated tag values, and transmits the information to all of the subscribers.

If any subscriber fails to confirm the receipt of the alarm information, or if the connection to a subscriber is not good, the controller stores the undelivered alarm information in a 100 KB buffer. Each subscriber has its own buffer and communication problems with one subscriber do not interfere with alarm delivery to other subscribers. When the buffer is full, newer alarm information is discarded and a FactoryTalk Diagnostics message is logged. The buffer is created when the subscriber establishes its initial connection, and is maintained for a length of time after a subscriber loses its connection. The length of time is specified in the Buffer Timeout setting on each RSLinx Enterprise device shortcut. See Chapter 4, “Create a new shortcut to the controller”.

TIP

If your FactoryTalk application does not include Logix5000 controllers, or if your controllers are not programmed with the new alarm instructions included in RSLogix 5000 v. 16 or later, see Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

Alarm buffering during loss of connection to the controller

To receive device-based alarms, the alarm server (RSLinx Enterprise) establishes a subscription to the alarms in the Logix controller. The controller maintains a connection to each subscriber and monitors the status of that connection.

As alarm state changes occur, the controller caches information such as timestamps, alarm state and associated tag values, and transmits the information to all of the subscribers.

If any subscriber fails to confirm the receipt of the alarm information, or if the connection to a subscriber is not good, the controller stores the undelivered alarm information in a 100 KB buffer. Each subscriber has its own buffer and communication problems with one subscriber do not interfere with alarm delivery to other subscribers. When the buffer is full, newer alarm information is discarded and a FactoryTalk Diagnostics message is logged. The buffer is created when the subscriber establishes its initial connection, and is maintained for a length of time after a subscriber loses its connection. The length of time is specified in the Buffer Timeout setting on each RSLinx Enterprise device shortcut. See Chapter 4, “Create a new shortcut to the controller”.
Before you begin

- Review Chapter 2, “Plan your system”.
- Verify that you have installed and activated the software listed next under “What you need”.
- Verify that the Logix5000 firmware has been updated to version 16.

What you need

- RSLogix 5000
- ControlFLASH
- RSLinx Classic
3 - Define device-based alarms in Logix5000 controllers

Follow these steps

**Define a digital alarm**
1. Run RSLinx 5000 software
2. Create a project
3. Define a boolean tag or a rung state on which to alarm
4. Add a digital alarm instruction
5. Configure the digital alarm properties
6. Download the project to the controller
7. Test the alarm instruction

**Define an analog alarm**
1. Run RSLinx 5000 software
2. Create a project
3. Define an analog tag on which to alarm
4. Add an analog alarm instruction
5. Configure the analog alarm properties
6. Download the project to the controller
7. Test the alarm instruction

**Chapter 2**
Plan your system

**Chapter 4**
Add a device server

**Chapter 5**
Add a data server
Define a digital alarm

Digital tags are either on or off. They have states instead of limits. The alarm trigger condition compares the value of the tag to the configured alarm state. An alarm can be triggered if the digital alarm is in one of these two states:

- the rung evaluation or input tag is equal to zero
- the rung evaluation or input tag is not equal to zero

If your FactoryTalk application does not include Logix5000 controllers, or if your controllers are not programmed with the new alarm instructions included in RSLogix 5000 v. 16 or later, see Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

Configure the alarm and download to the controller

This example uses the ladder logic editor that comes with RSLogix 5000 to define a digital alarm. You can also configure digital alarms in function blocks or structured text.

Step 1: Start RSLogix 5000 and then create a new project

1. To run RSLogix 5000 v. 16 or later software, click Start, point to All Programs > Rockwell Software > RSLogix 5000 Enterprise Series and then click RSLogix 5000.

2. On the File menu, click New to create a new project.

3. In the New Controller dialog box, enter information for the type of controller you are using. Keep the default location in the Create-In field. For help with filling in the dialog box, click Help.

4. In the Name field, type a name for the new controller. In the example above, we used West_Plant_Controller.
5. Click **OK** to save the configuration and open it in RSLogix 5000, as shown here.

![Image of RSLogix 5000 interface](image1.png)

**Step 2: Create a rung of logic that will trigger the alarm**

1. In the left pane, expand the folders **Tasks > MainTask > MainProgram**, and then double-click **MainRoutine**.

![Image of RSLogix 5000 interface](image2.png)
2. On the **Language Element** toolbar, click the **Examine-on** instruction button (shown at left) to add it to a rung on the ladder project.

3. At the top of the Examine-on instruction, click the question mark to select it. On the **File** menu, click **New Component**, and then click **Tag**.
4. In the **New Tag** dialog box, type a name for the tag, choose **BOOL** as the data type, and then click **OK**.

In our example, we named the tag **alarm_active**.

![New Tag dialog box](image)

**Step 3: Add a digital alarm instruction to the rung**

1. On the **Language Element** toolbar, click the **Alarms** tab, and then click the **ALMD** button (shown at left). The instruction block is placed in the ladder logic.

![Ladder logic with ALMD instruction](image)

2. Inside the alarm instruction, beside ALMD, select the question mark.

3. On the **File** menu, click **New Component**, and then click **Tag**.
4. In the **New Tag** dialog box, type a name for the digital alarm tag, and then click **OK**.

   In our example, we named the tag `DigitalAlarm1`.

   ![New Tag dialog box](image)

   **Step 4: Specify a tag for each of the digital alarm’s operands, or just enter 0**

1. Inside the alarm instruction, select the ProgAck operand.
2. On the **File** menu, click **New Component**, and then click **Tag**.
3. In the **New Tag** dialog box, type a name for the tag, select **BOOL** as the data type, and then click **OK**.

   In our example, we named the tag `DigitalAlarm1_Ack`. For details about using the **New Tag** dialog box, click **Help**.

   ![MainProgram - MainRoutine](image)
4. Create tags for the ProgReset, ProgDisable, and ProgEnable operands. When you are finished, the alarm instruction should resemble the one shown here:

Step 5: Configure the properties of the new digital alarm tag:

1. Inside the alarm instruction, click the Browse button (shown at left).

2. In the **ALMD Properties** dialog box, specify configuration settings, and then click **OK**. For help with specifying configuration settings, click **Help**.

To create a text message with embedded variables for each alarm, click the Browse button beside the Message box. At run time, these messages appear in Alarm and Event graphic objects, such as the Alarm and Event Summary. The maximum length of an alarm message is 255 characters. When importing alarm messages, RSLogix 5000 will verify the message length and display a warning if the alarm message exceeds the character limit.
Step 6: Download the program containing the ladder logic to the controller

1. If it is not already running, start RSLinx Classic to establish communications between RSLogix 5000 v. 16, or later, and the controller.

2. On the RSLogix 5000 menu, click Communications > Who Active.

3. If it is not already highlighted, select the controller to which you want to download the project.

   In this example, use the same controller you configured for the West_Plant_Controller project in “Start RSLogix 5000 and then create a new project” on page 24.
4. Click **Download**. At the prompt, click **Download** again. The controller is placed in Program mode.

Step 7: Test the alarm instruction by switching to run mode and triggering the alarm

1. On the **RSLogix 5000** menu, click **Communications > Run Mode**. Click Yes to switch the controller to run mode.
2. To trigger the alarm, right-click the contact on the rung (the one we named “alarm_active”). On the context menu, click **Toggle Bit**. The contact should change from a blue highlight to a green highlight.

![Image of FactoryTalk Alarms and Events System Configuration Guide](image)

**Step 8: Finish creating alarms, and next steps**

1. Define additional digital alarms or analog alarms, using either ladder logic, function blocks, or structured text, and download the logic to the controller.

2. When you finish defining alarms, create a device-based alarm server, and then configure it to subscribe to events detected by the Logix5000 controller. See Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” for instructions.

**Define an analog alarm**

An analog alarm defines a condition that evaluates a single analog tag against up to four limit values (high-high to low-low) and up to two rate of change limits (positive and negative).

**IMPORTANT**

If your FactoryTalk application does not include Logix5000 controllers, or if your controllers are not programmed with the new alarm instructions included in RSLogix 5000 v. 16 or later, see Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.
Configure the alarm and download it to the controller

This example uses the Function Block editor that comes with RSLogix 5000. You can also configure analog alarms in ladder logic or structured text.

**Step 1: Start RSLogix 5000 and then create a new project**

1. Run RSLogix 5000 v. 16 or later software.
2. On the **File** menu, click **New**.
3. In the **New Controller** dialog box, select the required controller type from the **Type** list and then type a name for the new controller in the **Name** field.

In this example, we used **East_Plant_Controller**.
4. Click **OK** to save the configuration and open it in RSLogix 5000, as shown here.

![Image of RSLogix 5000 interface showing a new routine being defined.](image)

**Step 2: Define a new routine**

1. In the left pane, expand the **Tasks** folder, right-click **MainProgram**, and then click **New Routine** on the context menu.

![Image of RSLogix 5000 interface with a new routine being defined.](image)
2. In the **New Routine** dialog box, type a name for the routine. We used `alarm_active`.

![New Routine dialog box](image)

3. In the **Type** list, click **Function Block Diagram**.

4. Select the **Open Routine** check box, and then click **OK**.

The new routine appears in the Tasks folder under MainRoutine and the routine opens on the right side of the RSLogix 5000 window:
Step 3: Build the function block logic

1. To add an alarm block, go to the tabs in the center right area (Favorites, Add-On, and so on) as shown in the following illustration. Scroll to the right, and then click the Alarms tab.

2. On the toolbar, click the ALMA button (shown at left) to add an Analog Alarm block, as shown in the following illustration.
3. Using the same Alarm objects on the Language Element toolbar, click the Input Reference icon (shown at left). An Input Reference tag appears in the Function Block editor:

4. Right-click the single question mark inside the symbol and then click **New Tag**.
5. In the **New Tag** dialog box, type a name for the tag and then click **OK**. In this example, we used **AnalogAlarm1**.

The screen should resemble the one shown in the following illustration:
6. Connect the input reference block to the Input of the ALMA block, as shown in the following illustration, by dragging the block’s contact point to the contact point on the ALMA block.
Step 4: Configure the properties of the alarm block

1. Click the Browse button on the alarm block.

2. In the **ALMA Properties** dialog box, set the **Input Levels** as shown in the following illustration and then click **OK**. To require that an operator acknowledge the alarm at run time, make sure the **Acknowledgement Required** check box is selected.

   ![ALMA Properties dialog box]

To enter alarm messages and add variables for analog alarms, select the **Messages** tab. To create a text message with embedded variables, click the Browse button beside the Level field, or beside the Rate of Change field. At run time, alarm messages are displayed in Alarm and Event graphic objects such as the Alarm and Event Summary.
Step 5: Add a JSR instruction to the MainRoutine to run the function block:

1. Double-click **MainRoutine** to open it.
2. Right-click the first rung and then click **Add Ladder Element** on the context menu.
3. In the **Add Ladder Element** dialog box, scroll down to the **Program Control** folder and then double-click the folder to expand the list of controls.
4. Select **JSR** and then click **OK**.
5. In the JSR instruction, double-click Routine Name and then click alarm_active in the list.
6. On the toolbar, click the **Save** button to save the configuration.
Step 6: Download the program to the controller

1. If it is not already running, start RSLinx Classic to establish communications between RSLogix 5000 v. 16, or later, and the controller.

2. On the RSLogix 5000 menu, click Communications > Who Active.

3. Select the controller to which you want to download the project.

4. Click Download. At the prompt, click Download again.

5. To switch the controller to run mode, on the RSLogix 5000 menu, click Communications > Run Mode.

Step 7: Finish creating alarms, and next steps

- Define additional digital alarms or analog alarms using either ladder logic, function block, or structured text, and download the logic to the controller.

- When you finish defining alarms, create a device-based alarm server, and then configure it to subscribe to events detected by the Logix5000 controller. See Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”.

Add a device server for Logix5000, PLC-5, or SLC 500 controllers

To use device-based alarms in Logix5000 controllers, or tag-based alarms in PLC-5, SLC 500, or Logix5000 controllers you must add a device server to your application.

FactoryTalk Alarms and Events supports two types of alarm monitoring:

- **Device-based alarm monitoring.** Built-in alarm instructions, that are available in RSLogix 5000 v. 16 or later, are programmed in a logic project and then downloaded to a Logix5000 controller. The controller detects alarm conditions and publishes event information, which can be displayed and logged.

- **Tag-based alarm monitoring.** Software-based tag alarm and event servers monitor controllers for alarm conditions through data servers and publish event information, which can be displayed and logged. Tag-based alarm monitoring is supported for Logix5000, PLC-5, and SLC 500 devices communicating through Rockwell Automation device servers (RSLinx Enterprise), or for third-party controllers that communicate through OPC Data Servers.

You can use a mix of both types of alarm monitoring. Choose tag-based alarm monitoring if you do not want to change the logic in your programmable controllers. Choose tag-based alarm monitoring, if you do not want to update the firmware in Logix5000 controllers.

**Before you begin**

- If you are using device-based alarms, define your alarms, as shown in Chapter 3, “Define device-based alarms in Logix5000 controllers”.

- If you are using tag-based alarms, you can create a controller program to detect alarm conditions and then communicate them through tags that are monitored by the FactoryTalk Tag Alarm and Event Server.

**What you need**

- RSLinx Enterprise

- FactoryTalk View Studio or FactoryTalk Administration Console

**TIP**

This guide uses FactoryTalk View Studio to define a device server. You can also use FactoryTalk Administration Console. For more information, select Help > Contents from the FactoryTalk Administration Console window.
Follow these steps

1. Start FactoryTalk View Studio and open a Site Edition Local application.
2. Add a new device server.
3. Configure the device server properties.
4. Open the Communication Setup editor.
5. Create a new shortcut to the Logix5000 controller and configure settings.

Chapter 3: Define alarms
Chapter 7: Set up graphic displays
Chapter 9: Set up historical alarm and event logging
4. Add a device server for Logix5000, PLC-5, or SLC 500 controllers

Add a device server

In this section, you will create a Rockwell Automation device server (RSLinx Enterprise) and then configure it to subscribe to alarms that will be detected by a Logix5000 controller.

If you are using third-party controllers, you do not need a device-based alarm server. Instead, go to Chapter 5, “Add an OPC Data Server for third-party controllers”.

Step 1: Create an application in FactoryTalk View Studio

This example shows how to create a local application.

1. To start FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

FactoryTalk View Machine Edition does not support FactoryTalk Alarms and Events.
3. In the **New/Open Site Edition (Local) Application** dialog box click the **New** tab.

4. In the **Application name** field, type a name for the new Local application. In this example, we named the application **My Local Site**.

5. Leave the **Description** field blank, or type a description for the application. For example, you can use this field to record revisions to the application, or contact information for technical support.

6. If it is not already selected, select the default language for the application. This is the language in which you are creating the application.

7. Click **Create**.

8. In the **Add Process Faceplates** dialog box, click **Clear All** and then click **OK**.

   ![Add Process Faceplates dialog box](image)

   If you have cleared the “Display this dialog when creating a new application” check box, the **Add Process Faceplates** dialog box does not open automatically. To open it manually, in the Explorer window right-click the HMI server and then select **Add Process Faceplates** from the context menu.
Step 2: Configure the device server

1. In the Explorer window, right-click the new application (My Local Site). On the context menu, point to Add New Server, and then click Rockwell Automation Device Server (RSLinx Enterprise).

2. In the RSLinx Enterprise Server Properties dialog box, click the General tab, type a name for the new server, and then click Apply.

In this example, we named the server FTAE Server.
3. If you plan to use tag-based alarms, skip the rest of the steps in this section, and go on to “Create a new shortcut to the controller” on page 49. If you are using built-in alarm instructions in Logix5000 controllers, on the **Alarms and Events** tab, select the **Enable alarm and event support** check box.

![Image of RSLinx Enterprise Server Properties]

4. Clear the **Enable history** check box and then click **OK**. For information about historical logging, see Chapter 9, “Set up historical alarm and event logging”.

The new server is added to the **My Local Site** application:
Step 3: Create a new shortcut to the controller

1. In the Explorer window, double-click the new RSLinx Enterprise server (in our example we named it FTAE Server), and then double-click Communication Setup.

2. In the Communication Setup dialog box, click the Add button, and then type a name for the new shortcut. We used FTAE_Controller.

Some options in this dialog box might be different if you are using PLC-5 or SLC 500 controllers.

The warning icon beside the OK button indicates that changing values in this dialog box at run time can cause unexpected results. For details, see Help.
3. Skip this step if you do not plan to use Logix5000 controllers with built-in alarm instructions. In the **Enable** list, click **Yes** to enable Alarms and Events:

4. On the **Primary** tab, expand the list of networks and devices until the controller you plan to use is visible, and then click the controller.

5. To set the path to the primary controller, click the **Apply** button.

6. To save the shortcut configuration and close the Communication Setup dialog box, click **OK**.
Step 4: Finish creating data servers, and next steps

1. If your FactoryTalk application includes third-party OPC-DA controllers, add an OPC Data Server, create a tag-based alarm server, and then define alarms. See Chapter 5, “Add an OPC Data Server for third-party controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

2. If your FactoryTalk application is communicating with PLC-5 or SLC 500 controllers, or Logix5000 controllers that are not using built-in alarm instructions, you must add a device server (RSLinx Enterprise) to your application and then create a tag-based alarm server and define alarms. See Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

3. After you create data servers and alarms, add FactoryTalk Alarm and Event objects to graphic displays. See Chapter 7, “Set up graphic displays”.

4 • Add a device server for Logix5000, PLC-5, or SLC 500 controllers
Add an OPC Data Server for third-party controllers

To monitor alarms in a third-party controller, create a controller program to detect alarm conditions and communicate them to tags. Use an OPC Data Server (for example, KEPWare server) to obtain tag values from the controller, and use a Tag FactoryTalk Alarm and Event Server to monitor those tags for alarm conditions.

This chapter describes how to use RSLinx Classic as an OPC Data Server. In most situations you will use RSLinx Enterprise to communicate with a PLC-5 or SLC 500 controller. However, you might need to use RSLinx Classic to communicate with a controller that is bridged over Ethernet to a DH+ or DH-485 network.

Before you begin

- Review Chapter 2, “Plan your system”
- Verify that you have installed and activated the software listed next under “What you need”

What you need

- PLC-5, SLC 500 or third-party OPC-DA programmable controller
- RSLogix 5 or RSLogix 500 software
- RSLinx Classic software
- RSLinx Enterprise software
- FactoryTalk View Studio or FactoryTalk Administration Console
Follow these steps

Add an OPC Data Server to an application

When you add a data server to an application or area, tags published by the data server can be accessed by any client—in this case, the Tag Alarm and Event Server.

This guide uses FactoryTalk View Studio to add a data server. You can also use FactoryTalk Administration Console. For more information, select Help > Contents from the FactoryTalk Administration Console window.
Step 1: Open an existing application in FactoryTalk View Studio

1. To run FactoryTalk View Studio on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

3. In the New/Open Site Edition (Local) Application dialog box, click the Existing tab, and select the application you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” (we used My Local Site).

Step 2: Add a data server

1. In the Explorer window, right-click the application, point to Add New Server, and then click OPC Data Server.

2. In the OPC Data Server Properties dialog box, type a name for the server. This example uses My OPC Server.

3. Beside the OPC Server name (ProgID) field, click the Browse button.
4. In the **Available OPC Data Servers** dialog box, select **RSLinx OPC Server**, and then click **OK**.

![Available OPC data servers](image)

**TIP** When creating a Network application, select **RSLinx Remote OPC Server**.

5. Click **OK** again to close the **OPC Data Server Properties** dialog box.

6. Next, add a Tag Alarm and Event Server and define alarm conditions. See Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.
Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers

FactoryTalk Tag Alarm and Event Servers provide software-based alarms and events. Use tag alarm and event servers to monitor alarm conditions in Logix5000 controllers, PLC-5, SLC 500, or third-party OPC-DA programmable controllers.

FactoryTalk Tag Alarm and Event Servers also provide an alternative to device-based alarms, for example, alarms provided by devices such as sensors or Logix5000 controllers using built-in alarm instructions.

A FactoryTalk Tag Alarm and Event Server can also detect alarm conditions in third-party controllers. All that is required is a data server (such as KEPWare) to communicate with the controller.

A FactoryTalk Tag Alarm and Event Server provides a link between a hardware device that contains data and the FactoryTalk Directory.

If your FactoryTalk system does not include PLC, SLC, or third-party controllers, you can skip this chapter.

You can create and edit:

- digital alarms
- level alarms
- deviation alarms

For each alarm, you can also create and edit a text message and embed variables within the message. For details, click the Help button on the dialog box.

Before you begin

- If you are using third-party controllers, you do not need a device-based alarm server. Instead, go to Chapter 5, “Add an OPC Data Server for third-party controllers”.

What you need

- Logix5000 controllers, PLC-5, or SLC 500 devices communicating through Rockwell Automation device servers (RSLinx Enterprise)
- RSLLogix 5 or RSLogix 500 software
- RSLinx Enterprise, RSLinx Classic (or RSLinx Classic for bridging from Ethernet to DH+ or DH-485 networks)
- FactoryTalk View Studio or FactoryTalk Administration Console
Follow these steps

Chapter 5
Add a data server for PLC, SLC, 3rd-party, or Logix5000* controllers

Run FactoryTalk View Studio

Add a new device server (RSLinx Enterprise)

Add a new tag alarm and event server

Configure the server properties

Set up conditions for triggering alarms in your FactoryTalk system

Add Alarm and Event objects to graphic displays

Chapter 7
Set up graphic displays

* To use tag-based alarms in PLC-5, SLC 500, or Logix5000 controllers you must add a device server (RSLinx Enterprise) to your application.
Create an application

In this section, you will create a Rockwell Automation device server (RSLinx Enterprise) and then configure it to subscribe to alarms that will be detected by a Logix5000 controller. In this example, the Rockwell Automation device server (RSLinx Enterprise) is used as a data server for tag values, not as an alarm server.

Step 1: Create an application in FactoryTalk View Studio

If you created a local application previously, you can skip this step. Instead, open FactoryTalk View Studio, in the Application Type Selection window, select Site Edition (Local) and then click Continue. In the New/Open Site Edition (Local) Application dialog box, click the Existing tab, and select the application you created.

This example shows how to create a local application.

1. To start FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

FactoryTalk View Machine Edition does not support FactoryTalk Alarms and Events.
3. In the **New/Open Site Edition (Local) Application** dialog box click the **New** tab.

![New/Open Site Edition (Local) Application dialog box]

4. In the **Application name** field, type a name for the new Local application. In this example, we named the application **My Local Site**.

5. Leave the **Description** field blank, or type a description for the application. For example, you can use this field to record revisions to the application, or contact information for technical support.

6. If it is not already selected, select the default language for the application. This is the language in which you are creating the application.

7. Click **Create**.

8. In the **Add Process Faceplates** dialog box, click **Clear All** and then click **OK**.

![Add Process Faceplates dialog box]

**TIP** If you have cleared the “Display this dialog when creating a new application” check box, the **Add Process Faceplates** dialog box does not open automatically. To open it manually, in the Explorer window right-click the HMI server and then select **Add Process Faceplates** from the context menu.
Add a data server

Step 1: Configure the device server (RSLinx Enterprise)

When you add a data server to an application or area, tags published by the data server can be accessed by any client—in this case, the Tag Alarm and Event Server.

Important

This guide uses FactoryTalk View Studio to add a data server. You can also use FactoryTalk Administration Console. For more information, select Help > Contents from the FactoryTalk Administration Console window.

In this example a device server (RSLinx Enterprise) is added to the application to act as a data server.

1. In the Explorer window, right-click the application (My Local Site). On the context menu, point to Add New Server, and then click Rockwell Automation Device Server (RSLinx Enterprise).

2. In the RSLinx Enterprise Server Properties dialog box, click the General tab, type a name for the server, and then click Apply. In this example, we named the server FTAE Server.

The new server is added to the My Local Site application:
Step 2: Create a new shortcut to the controller

TIP

If you already created a shortcut to the controller in a previous chapter, you can skip this step.

1. In the Explorer window, double-click the new RSLinx Enterprise server (in our example we named it FTAE Server), and then double-click Communication Setup.
6. Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers

2. In the **Communication Setup** dialog box, click the **Add** button, and then type a name for the new shortcut. We used FTAE_Controller.

![Communication Setup dialog box]

Some options in this dialog box might be different if you are using PLC-5 or SLC 500 controllers.

The warning icon beside the OK button indicates that changing values in this dialog box at run time can cause unexpected results. For details, see Help.

3. On the **Primary** tab, expand the list of networks and devices until the controller is visible, and then click the controller. To set the path to the primary controller, click the **Apply** button.

4. To save the shortcut configuration and close the **Communication Setup** dialog box, click **OK**.
Add a Tag Alarm and Event Server

To create a server and define alarm conditions that monitor tags for PLC-5 or SLC 500 controllers, and Logix5000 controllers, complete the following steps.

These instructions apply to FactoryTalk View Studio. For help with FactoryTalk Administration Console, see FactoryTalk Help. On the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk Tools, and then click FactoryTalk Help.

**Step 1: Add a Tag Alarm and Event Server**

1. In the Explorer window, right-click the application. On the context menu, point to Add New Server, and then click Tag Alarm and Event Server.

2. In the Tag Alarm and Event Server Properties dialog box, click the General tab.

3. Type a name for the server, and then click OK. In this example, we used TagAE.

4. On the Priorities and History tab, clear the Enable history check box.

The Priorities and History tab is used to configure alarm and event logging. Chapter 9, “Set up historical alarm and event logging” describes how to set up alarm logging for an Tag Alarm and Event Server.

5. To create the Tag Alarm and Event Server and close the dialog box, click OK.
Define alarm conditions

After you create a Tag Alarm and Event Server, you define the conditions that will trigger alarms at run time.

This example shows how to create a digital alarm in a Tag Alarm and Event Server.

1. In the Explorer window, expand the TagAE server, and then double-click Alarm and Event Setup.

2. In the Alarm and Event Setup dialog box, click the New button on the toolbar, and then click Digital.

3. In the Digital Alarm Properties dialog box, type a name for the alarm. In this example we used Valve1FTO.

4. To select an Input Tag for the alarm, click the browse button, and then expand the folder folder tree until you can select the online tag you plan to monitor.
5. Select the tag you plan to monitor and then click **OK**. In this example we used **Valve1FTO alm**.

![Select Tag dialog box]

6. In the **Digital Alarm Properties** dialog box, type a message. In this example we typed ‘The valve failed to open.’ in the **Message** field.

You can also embed variables within the message. For details, click the **Help** button on any tab in the **Alarm Setup** dialog box.

![Digital Alarm Properties dialog box]
6. Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers.

7. To close the Digital Alarm Properties dialog box, click **OK**.

8. To save the alarm and start monitoring for the alarm condition, click the **Save** button.

**Next steps**

1. Define additional alarms.

2. After you define alarms, you can add FactoryTalk Alarm and Event objects to graphic displays. See Chapter 7, “Set up graphic displays”.
Set up graphic displays

Create graphic displays in FactoryTalk View Studio. They are containers for graphic objects, like the FactoryTalk Alarm and Event Summary object. Add FactoryTalk Alarm and Event objects to displays so that an operator can monitor and interact with both device-based and tag-based alarms at run time.

Other graphic objects (for example, objects representing equipment) can also be animated (to change color for example) using FactoryTalk View Site Edition expression functions that monitor the state of alarms. See “Use color animation to indicate alarm state changes” on page 84. Also see Help in the FactoryTalk View Site Edition.

This section describes how to create graphic displays, create and configure the FactoryTalk Alarm and Event graphic objects, and macros that determine how the displays open in the FactoryTalk View Site Edition Client. This section is an example of one way you might create your graphic displays.

Before you begin

- Define the alarms you plan to use, as described in Chapter 3, “Define device-based alarms in Logix5000 controllers”.

- Add the required device server, as described in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” or Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

What you need

- RSLinx Enterprise software

- FactoryTalk View Studio software
Follow these steps

Chapter 4
Add a device server

AND/OR

Chapter 6
Add a tag-based alarm server

Set up graphic displays

Run FactoryTalk View Studio and open an application

Create a graphic display

Add an Alarm and Event Summary object

Configure the object’s properties

Create a graphic display

Chapter 8
Monitor and interact with alarms during runtime

Chapter 9
Set up historical alarm and event logging
Create a graphic display

Create a graphic display to host FactoryTalk Alarm and Event objects, such as the Alarm and Event Summary.

Step 1: Open an existing application in FactoryTalk View Studio

1. To run FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

3. In the New/Open Site Edition (Local) Application dialog box, click the Existing tab, and select the application you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” (we used My Local Site).
Step 2: Create a graphic display to host FactoryTalk Alarms and Events objects

1. In the Explorer window, expand the Graphics folder, right-click Displays, and then click New.

A blank display appears in the workspace. Next, add Factory Talk Alarm and Event objects to the graphic display.
Create an Alarm and Event Summary

Use the Alarm and Event Summary object to view and interact with a summary of all the current alarms and events in an application. You can acknowledge, suppress, and disable alarms.

You cannot use the Alarm and Event Summary to enable or turn alarm suppression off. To enable or turn alarm suppression off, use the Alarm Status Explorer. See “Monitor alarms and events” on page 103. To silence an alarm, use the Alarm and Event Banner.

You can use FactoryTalk Security to control which users can acknowledge, enable, disable, reset, or suppress alarms at run time in an application (or, in a Network application, in an area). To do this, right-click the application (or area) and then click Security on the context menu. For details, see the FactoryTalk Security System Configuration Guide.

Step 1: Add an Alarm Summary to a graphic display

1. On the Objects menu, point to Alarm and Event, click Summary (or on the toolbar, click the Summary button, as shown at left), and then place the cursor approximately where the object is to be on the display.

2. Hold the left mouse button down and drag it to create a rectangle the size that the Alarm and Event Summary object should be.

3. When the object is the correct size, release the left mouse button. The Alarm and Event Summary object is drawn on the display.
Step 2: Change the settings of the Alarm and Event Summary display

1. Right-click anywhere in the display and then, click **Display Settings** on the context menu.

   ![Display Settings dialog box]

   In any application, do not include more than two graphic displays that have Cache After Displaying and Always Updating set because these options can consume large numbers of processor cycles.

2. In the **Display Settings** dialog box, on the **Properties** tab, make the following changes and then click **OK**.

   - Under Cache After Displaying, click **Yes** and then select the **Always Updating** check box.

     When you set Cache After Displaying to Yes, the display stays in memory cache when you close it. This shortens the time required to open the graphic display the next time you do it.

     When you select the Always Updating check box, the display continues to be updated with changes in alarm states when it is cached. This shortens the time necessary to update the Alarm and Event Summary with current alarms when you open it again.

     If Cache After Displaying is set to No, and the Always Updating check box is cleared, every time you close the graphic display, all alarms are removed from the Alarm and Event Summary. When you re-open the graphic display, the Alarm and Event Summary is blank, and then begins to receive the most recent alarms when they occur.

   - Clear the **Title Bar** check box.

   - Select the **Size to Main Window at Runtime** check box.

   - Select the **Allow Display to be Resized** check box.

   - Under **When Resized**, select the **Scale** check box if it is not already selected.
Step 3: Save the display

1. On the File menu, click Save.

2. In the Save dialog box, type a name for the new display and then click OK.
   We used Alarm and Event Summary in the example shown.

3. Close the display.

Create an Alarm and Event Banner display

This section describes how to add an Alarm and Event Banner object to a graphic display, and then create a startup macro that docks the Banner to the bottom of the FactoryTalk View Site Edition Client window.

Step 1: Create a new graphic display

1. In the Explorer window, expand the Graphics folder.

2. Right-click Displays, and then click New on the context menu.
Step 2: Add an Alarm and Event Banner object to the display

1. On the Objects menu, point to Alarm and Event, and then click Banner (or, on the toolbar, click the Banner button, as shown at left).
2. Hold the left mouse button down and drag it to create a rectangle the size that the Alarm and Event Banner should be.

3. When the object the correct size, release the left mouse button. The Alarm and Event Banner object is drawn on the display.
4. Resize the graphic display so that the Banner fills the graphic display (do not leave white space). We do this because the Banner displays no more than five alarms at a time.

Step 3: Configure the properties of the Alarm and Event Banner

1. To open the **Alarm and Event Banner Properties** dialog box, double-click the Alarm and Event Banner object. For details about all of the properties in the dialog box, click **Help** in the dialog box.

2. On the **General** tab, click the browse button under **Alarm and Event Summary command**.

This opens the **Command Wizard** where you will create a command to start the Alarm and Event Summary graphic display from the Alarm and Event Banner.
3. Scroll down the list of commands on the right side of the wizard, select Display, and then click Next.

4. In the File list, click Alarm and Event Summary.

5. Select the Window Position check box. Scroll down the list on the right and then click Centered on the screen.
6. Click **Finish** to save the Display command and add it to the **Alarm and Event Banner Properties** dialog box.

7. Click **OK** to close the dialog box.
Step 4: Change the display settings for the Alarm and Event Banner display

1. On the Edit menu, click Display Settings.

2. In the Display Settings dialog box, on the Properties tab, make the following changes, and then click OK:

- Clear the Title Bar check box.
- Select Size to Main Window at Runtime.
- Select Allow Display to be Resized.
- Under When Resized, select Scale if it is not already selected.

The Alarm and Event Banner graphic display is always visible because it is docked. You do not need to turn on Cache After Displaying, like you did for the Alarm and Event Summary object. See “Change the settings of the Alarm and Event Summary display” on page 74.
**Step 5: Save the graphic display**

1. On the **File** menu, click **Save**.

2. In the **Save** dialog box, type a name for the graphic display and then click **OK**.
   
   In this example, we used **Alarm and Event Banner**.

   ![Save dialog box](image)

3. Close the graphic display.

**Create a startup macro for the Banner display**

This section describes how to create a startup macro. You will use the macro when you configure the FactoryTalk View Site Edition Client. See Chapter 8, “Monitor and interact with alarms at run time”.

**Step 1: Configure a startup macro**

This startup macro docks the Banner display to the bottom of the FactoryTalk View SE Client window.

1. In FactoryTalk View Studio, in the Explorer window, double-click **Macros** to open the editor.
2. To open the **Command Wizard**, double-click anywhere in the body of the macro editor.

3. In the Command Wizard, scroll down the list of commands on the right side of the wizard, click **Display**, and then click **Next**.
4. In the File list, click **Alarm and Event Banner**.

5. Select the **Window Position** check box. Scroll down the list on the right and then select **Docked to the bottom**.

6. To save the Display command and add it to the macro, click **OK**.

**Step 2: Save the macro**

1. On the **File** menu, click **Save**.

2. In the **Save** dialog box, type a name for the new macro and then click **OK**. In this example, we used **Start Alarm and Event Banner**.

**Use color animation to indicate alarm state changes**

In this section, you’ll use alarm expressions in FactoryTalk View to animate a rectangle on a graphic display so that it changes color when the alarm state changes. At run time if:

- there are active unacknowledged alarms, the rectangle flashes red.
- all active alarms have been acknowledged, the rectangle is a steady red.
- there are no active alarms but there are normal unacknowledged alarms, the rectangle is yellow.
- there are no active or unacknowledged alarms the rectangle is green.
Step 1: Create a new graphic display

1. In the Explorer window, expand the Graphics folder.
2. Right-click Displays, and then click New on the context menu.

Step 2: Add an Alarm and Event Summary to the graphic display

1. On the Objects menu, point to Alarm and Event, and then click Summary (or on the toolbar, click the Summary button, as shown at left).
2. Hold the left mouse button down and drag it to create a rectangle the size that the Alarm and Event Summary object should be.
3. When the object is the desired size, release the left mouse button. The Alarm and Event Summary object is drawn on the display.
4. If necessary, resize either the Alarm and Event Summary object or the graphic display to expose enough white space at the top, bottom, or on one side to add a rectangle object that will be the alarm status indicator.

5. On the Objects menu, point to Drawing and then click Rectangle.

6. In the graphic display, hold down the left mouse button and then drag the mouse to draw a box for the alarm status indicator.
Step 3: Add an expression to animate the rectangle

1. Right-click the rectangle, point to Animation and then click Color on the context menu.

   To create an expression for the color animation, you can compose the expression step by step, as explained in the following steps, or you can type the following expression in the Expression box.

   \[
   \begin{align*}
   \text{If } & \text{AE_InAlmUnackedCount}( \text{"*"} ) > 0 \text{ Then } 0 \text{ Else} \\
   \text{If } & \text{AE_InAlmAckedCount}( \text{"*"} ) > 0 \text{ Then } 1 \text{ Else} \\
   \text{If } & \text{AE_NormalUnackedCount}( \text{"*"} ) > 0 \text{ Then } 2 \text{ Else } 3
   \end{align*}
   \]

   In the preceding expression, "*" means include all alarms that are in the same location (area) as the HMI server. If the preceding expression is used in a Network application with areas, the expression would include all alarms from the alarm servers that are located in the same area as the HMI server.

   If you want to include alarms from other areas, use the absolute path syntax. For example, ("/AreaName::*").

   If you type the expression instead of composing it, skip to Step 4: “Set up colors for the alarm states” on page 91 to apply colors to each state.

2. In the Animation dialog box, click Expression.
3. In the **Expression Editor**, click the **If** button and then click **If** to add the IF condition.

4. In the **Expression Editor**, click **Functions**.

5. In the **Functions** dialog box, in the list of **Function Categories**, click Alarm and Event.

   The HMI Tag Alarming category contains functions that apply only to HMI tags located in an HMI server. Because our alarm data is coming from a controller or a FactoryTalk Tag Alarm and Event Server, we use the **Alarm and Event** expressions.

6. In the list of functions on the right, click **AE_InAlmUnackedCount(AlarmName)**, and then click **OK**.
7. In the **Expression Editor**, the **AE_InAlmUnackedCount()** function appears in the **Expression** box, with the cursor between the parentheses. Next, type “**” to return a count of all alarms that are in the same location (area) as the HMI server and are in the In Alarm and Unacknowledged state. Next, move the cursor to the right of the closing parenthesis.

To count the number of instances of a specific alarm, you can type a tag name instead of the asterisk.

To include alarms from other areas, use the absolute path syntax. For example, (“/AreaName:::*”).

8. Click **Relational** and then click **> GT** for greater than.

9. In the **Expression** box, type **0**, click **If** and then click **Then** to add a **THEN** condition.

This completes the **IF** condition: “If the number of In Alarm, Unacknowledged alarms is greater than 0 . . .”
10. In the Expression box, type 0, click If and then click Else to add an ELSE condition.

This completes the THEN condition: “If the number of In Alarm, Unacknowledged alarms is greater than 0, then animate the rectangle to show the colors for state 0.”

![Expression Editor](image)

11. Follow the same process, substituting the necessary selections to add the remaining two expressions, and then click OK.

If AE_InAlmAckedCount( "*" ) > 0 Then 1 Else (animates the rectangle to show the colors for state 1)

If AE_NormalUnackedCount( "*" ) > 0 Then 2 Else 3 (animates the rectangle to show the colors for state 2. If none of the conditions are true, the expression animates the rectangle to show the colors for state 3.)
Step 4: Set up colors for the alarm states

This step describes how to set up colors for the rectangle, for each solution to the expression.

1. In the Animation dialog box, under Expression, click state A.

   ![Animation dialog box]

2. In the Value box, type 0.

3. Beside Background, click Blink.

4. Beside Background, make sure the colored boxes are set to red (for the foreground color) and black (for the background color).

5. Set up the colors for the remaining states:
   - State B – Value = 1, Foreground = Black, Background = Red
   - State C – Value = 2, Foreground = Black, Background = Yellow
   - State D – Value = 3, Foreground = Black, Background = Green

6. When you are finished setting up the colors, click Apply and then click Close.

Step 5: Save the graphic display

1. On the File menu, click Save.

2. In the Save dialog box, type a name for the graphic display and then click OK.

   ![Save dialog box]

   In this example, we used Alarm Status Indicator.
Step 6: Test run the display

1. On the View menu, click Test Display, or click the Test Display button (shown at left) on the toolbar.

   If there are unacknowledged alarms whose alarm condition is In Alarm, the rectangle flashes red.

   ![Image of the Display with flashing red rectangle]

2. Right-click one of the alarms, and then click Ack All on the context menu. Because all active alarms have been acknowledged, the rectangle changes to a steady red.

   ![Image of the Display with steady red rectangle]
3. Continue experimenting to observe the effects of acknowledging alarms:

- If there are no active alarms, but there are normal unacknowledged alarms, the rectangle is yellow.

- If there are no active or unacknowledged alarms, the rectangle is green.

4. When you are finished, on the View menu, click Edit Display, or click the Edit Display button (shown at left) on the toolbar.

Next steps

Do one of the following:

- Use the displays you just created to monitor and interact with alarms and events. See Chapter 8, “Monitor and interact with alarms at run time”.

- Set up historical alarm and event logging. See Chapter 9, “Set up historical alarm and event logging”. 
Monitor and interact with alarms at run time

To interact with alarms and events at run time, set up a FactoryTalk View Site Edition Client. Next, run the FactoryTalk View Site Edition Client and then monitor the graphic displays that host the Alarm and Event graphic objects.

Before you begin

- Be sure you have defined alarms as described in Chapter 3, “Define device-based alarms in Logix5000 controllers”.
- Add the appropriate device server as described in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” or Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.
- Set up and configure any graphic display objects as described in Chapter 7, “Set up graphic displays”.

What you need

- RSLinx Enterprise software
- FactoryTalk View SE software
- FactoryTalk View SE Client software
Follow these steps
Create and then run a FactoryTalk View Client configuration

To run an application and monitor graphic displays for alarm messages, start the FactoryTalk View Site Edition Client.

For this example, be sure that the controller is running the West_Plant_Controller program that we created in Chapter 3, and that you have tripped the alarm (right-click the rung contact and then click Toggle Bit).

Step 1: Create a FactoryTalk View Site Edition Client configuration file

1. On the Windows Start menu, click Start point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Site Edition Client to open the FactoryTalk View SE Client Wizard.

2. In the FactoryTalk View SE Client Wizard, click New.
3. In the FactoryTalk View SE Client Configuration Name dialog box, type a name for the configuration file. In this example, we used **Alarms and Events Demo**. Keep the default path for the configuration file and click **Next**.

![Configuration Name Dialog Box](image1.png)

For details about using the FactoryTalk View Site Edition Client Wizard, click the **Help** button in the wizard.

4. In the **FactoryTalk View SE Client Application Type** dialog box, select **Local** and then click **Next**.

![Application Type Dialog Box](image2.png)
5. In the **FactoryTalk View SE Client Application Name** dialog box, select the name of the application you plan to connect to, and then click **Next**.

In this example, we used the **My Local Site** application that we created in Chapter 7, “Set up graphic displays”.

![FactoryTalk View SE Client Application Name dialog box](image)

6. In the **FactoryTalk View SE Client Components** dialog box, you select the FactoryTalk View components that run when the FactoryTalk View Site Edition Client starts. In the **Startup macro** list, select **Start Alarm and Event Banner**, and then click **Next**.

![FactoryTalk View SE Client Components dialog box](image)
7. In the **FactoryTalk View SE Client Window Properties** dialog box, you configure how the FactoryTalk View SE Client window will look at run time. In this example, we entered *Show Me Alarms* in the **Title bar text** field. At run time, this text is displayed at the top of the Client window. Do not change any of the other settings in this dialog box. Click **Next**.

8. In the **FactoryTalk View SE Client Auto Logout** dialog box, you can configure the Client to log out automatically after a period of inactivity. In this example, we accepted the default setting. Click **Next**.
9. In the **FactoryTalk View SE Client Completion Options** dialog box, select *Save configuration and open FactoryTalk View SE Client now*, and then click *Finish*.

![FactoryTalk View SE Client Completion Options dialog box](image)

The Client window opens with the Alarm and Event Banner docked at the bottom.
Step 2: Open the Alarm and Event Summary from the Alarm and Event Banner

1. In the Alarm and Event Banner, click the **Alarm and Event Summary** button (shown at left). The Alarm and Event Summary opens, and is similar to the following graphic display.

![Alarm and Event Summary](image)

Step 3: Next steps

Do one of the following:

- Monitor and interact with alarms and events as shown in the next section.
- Set up historical logging for alarms and events using the displays and startup macros created in this chapter and in Chapter 7, “Set up graphic displays”. See Chapter 9, “Set up historical alarm and event logging”.

Monitor alarms and events

The data fields in the Alarm and Event Banner window are organized in columns, and represent various alarm and event data. At run time, only the columns that were configured at design time to be visible are displayed in the Alarm and Event Banner.

In our example, the status bar shows (from left to right):

- the connection status of the Tag Alarm and Event Server — whether connected or disconnected from the Alarm and Event Banner. The green icon shows that the Tag Alarm and Event Server is connected. When disconnected, the icon flashes red.
- the number of alarms that are In Alarm and Unacknowledged
- the number of alarms that are In Alarm and Acknowledged
- the number of alarms that are Normal and Unacknowledged
- the number of alarm faults

The icons in the body of the Banner list:

<table>
<thead>
<tr>
<th>Priority</th>
<th>Alarm State</th>
<th>Time and date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium</td>
<td>In Alarm and Unacknowledged</td>
<td>The time the alarm event occurred.</td>
</tr>
</tbody>
</table>

To see all of the possible priorities and alarms states for the Alarm and Event objects, see FactoryTalk Help. On the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk Tools and then click FactoryTalk Help.

Security for alarms and events

You can use FactoryTalk Security to control which users can acknowledge, enable, disable, reset, or suppress alarms at run time in an application (or, in a Network application, in an area).

To do this, in FactoryTalk View Studio or FactoryTalk Administration Console, right-click the application (or area) where the alarms are located and then click Security on the context menu. For details, see the FactoryTalk Security System Configuration Guide.
**Acknowledge an alarm**

When you acknowledge an alarm it does not correct the condition causing the alarm, but indicates that an operator is aware of the alarm.

A single tag might have several alarm conditions In Alarm. Each alarm condition must be acknowledged separately. For example, a tag that monitors a temperature might trigger HI and HIHI alarm conditions by the time it is acknowledged. The alarm could also go into and out of alarm several times before it is acknowledged.

Previous occurrences of an alarm that have gone Out of Alarm and then back In Alarm cannot be acknowledged. These old occurrences are called “out of scope” and are displayed in the alarm list with a different icon. When the most recent occurrence of an alarm is acknowledged, previous occurrences are removed from the alarm list.

**To acknowledge the selected alarm:**

In the **Alarm and Event Summary** event list, do one of the following:

- Select the alarms you want to acknowledge, and then click the **Acknowledge selected alarm** button, shown at left.

- Select the alarms you want to acknowledge, right-click the selected alarms, and then click **Ack** on the context menu.
To acknowledge the selected alarm and enter a comment:

1. In the Alarm and Event Summary event list, do one of the following:
   - Select the alarms you want to acknowledge, and then click **Acknowledge selected alarm with comment**.
   - Select the alarms you want to acknowledge, right-click the selected alarms, and then click **Ack Comment** on the context menu.

2. In the **Acknowledge Alarm with Comment** dialog box, type a comment, and then click **Acknowledge**. If historical logging is set up, the comment is displayed in the Alarm and Event Log as part of the Tracking event that is generated from the Acknowledge command.

---

**TIP**

You can view the last comment that was entered for an operation (for example, ack, disable, suppress) in the Alarm Details dialog box. To view a comment associated with an alarm state, select an alarm and then click the **Show details for the selected alarm** button on the toolbar. In the Alarm Details dialog box, expand an alarm state (Disabled, Suppressed, Acknowledged, and so on) to view the comment associated with that state.
To acknowledge all of the alarms displayed on the page:

In the Alarm and Event Summary toolbar, do one of the following:

- Click Ack page of alarms. All alarms currently visible in the event list are acknowledged.
- Right-click one of the alarms and then click Ack Page on the context menu.

To acknowledge all of the alarms in the event list:

In the Alarm and Event Summary toolbar, do one of the following:

- Click Acknowledge all alarms contained in list. All alarms in the event list are acknowledged, even if they are not all visible. However, if the list is filtered, alarms that are filtered out are not acknowledged.
- Right-click one of the alarms, and then click Ack All on the context menu.
Disable or enable an alarm

Disabled alarms

When an alarm is disabled the operator is not notified when the alarm condition occurs and the alarm is removed from the Alarm and Event Summary. An alarm that is disabled is effectively turned off in the controller. The alarm condition is no longer monitored and notifications are not generated by the controller. Disabled alarms do not sound the alarm bell in the Alarm and Event Banner, and are not displayed as new events in the Alarm and Event Summary.

Because a disabled alarm does not appear in the Alarm and Event Summary, you cannot enable it in the Alarm and Event Summary. To enable alarms, use the Alarm Status Explorer. See “To enable an alarm:” on page 109.

Unlike a silenced alarm, a disabled alarm does not trigger the alarm bell in the Alarm and Event Banner if the alarm condition occurs again after the alarm was disabled.

Disable alarms that are related to equipment that is being shut down or serviced.

Enabled alarms

When an alarm is enabled, the operator is notified when the alarm condition occurs. Enabled alarms sound the alarm bell, and continue appearing as new events in the Alarm and Event Summary, unless they are suppressed.

You can use FactoryTalk Security to control who can disable or suppress alarms. If a user attempts to perform an operation for which they do not have the required security rights, the operation will fail and a message will be displayed stating that the user has insufficient rights to perform the operation. To add another level of security, the Alarm and Event Summary can be configured not to show the toolbar buttons, which also hides those operations on the context menu.
To disable selected alarms:

1. In the **Alarm and Event Summary** event list, do one of the following:
   - Select the alarms you want to disable, and then on the toolbar, click the **Disable selected alarm** button.
   - Select the alarms you want to disable, right-click the selected alarms, and then click **Disable Alarm** on the context menu.

2. In the **Disable Alarm** dialog box, type a comment (for example, to explain why the alarm is disabled), and then click **Disable**.

   ![Disable Alarm dialog box]

This comment is stored with the alarm and is logged to the Comment field in the Alarm and Event Log, which you can view using the Alarm and Event Log Viewer.

Any alarms you disable stay in that state until you enable them again. You must use the Alarm Status Explorer to enable alarms because disabled alarms are not displayed in the Alarm and Event Summary.
To enable an alarm:

1. In the **Alarm and Event Summary** window, do one of the following:
   - If it is visible on the toolbar, click the **Display the Alarm Status Explorer** button.
   - If the toolbar button is not visible, right-click an alarm in the Alarm and Event Summary event list, and then click **Alarm Status** on the context menu.

2. In the **Alarm Status Explorer** window, select the alarms you want to enable, and then click the **Enable selected alarm** button.

Any alarms you enable stay in that state until you disable them again.

For details about the other features of the Alarm Status Explorer, click **Help** in the dialog box.
Suppress or unsuppress an alarm

You can suppress an alarm that is not needed temporarily; for example, because the alarm is caused by another alarm that you are already addressing. You can suppress or unsuppress up to 2000 alarms at one time.

A suppressed alarm does not appear in the Alarm and Event Banner, or Alarm and Event Summary. However, a suppressed alarm continues to be logged in the Alarm and Event Log, which you can view using the Alarm and Event Log Viewer. A suppressed alarm also continues to set the appropriate InAlarm parameters of an alarm instruction in the controller.

Disable an alarm instead of suppressing it if you want to completely turn off the alarm detection logic for the alarm source, and prevent the alarm from being detected. See “Disable or enable an alarm” on page 107.

To suppress an alarm:

1. In the Alarm and Event Summary event list, do one of the following:
   - Select the alarms you want to suppress and then click the Suppress selected alarm button.
   - Select the alarms you want to suppress, right-click the selected alarms, and then click Suppress on the context menu.
2. In the **Suppress Alarm** window, type a comment, to explain why you suppressed the alarm, and then click **Suppress**.

![Suppress Alarm window]

This comment is stored with the alarm and is logged to the Comment field in the Alarm and Event Log, which you can view using the Alarm and Event Log Viewer.

**Unsuppress an alarm**

After you acknowledge a suppressed alarm, the suppressed alarm will not appear in the Alarm and Event Banner, or Alarm and Event Summary. You can use the Alarm Status Explorer to unsuppress alarms.

Suppressed alarms continue to be logged in the Alarm and Event Log. If historical logging is set up, you can view suppressed alarm and event data in the Alarm and Event Log Viewer. See Chapter 9, “Set up historical alarm and event logging” for more information.

**To unsuppress an alarm:**

1. In the **Alarm and Event Summary** window, right-click an alarm and then click **Alarm Status** on the context menu.
2. In the **Alarm Status Explorer** window, select the alarm or alarms you want to unsuppress, and then click the **Unsuppress selected alarm** button on the toolbar.

![Alarm Status Explorer](image)

**TIP**
You can filter alarm sources to make it easier to find the alarm you want. In the **Name** box, type all or part of an alarm name, or select an alarm status from the list. You can use the * and ? wildcard characters in the filter. For details about filtering alarm sources, see FactoryTalk Help. On the Windows Start menu, click **Start**, point to **All Programs > Rockwell Software > FactoryTalk Tools** and then click **FactoryTalk Help**.

3. In the **Unsuppress Alarm** dialog box, type a comment to explain why the alarm is unsuppressed, and then click **Unsuppress**.

![Unsuppress Alarm](image)

This comment is stored with the alarm and is logged to the Comment field in the Alarm and Event Log, which you can view using the Alarm and Event Log Viewer if historical logging has been configured.

For details about the other features of the Alarm Status Explorer, click the **Help** button in the dialog box.
Set up historical alarm and event logging

Use the FactoryTalk Alarm and Event Log Viewer to view alarms and events that have been logged to a Microsoft SQL Server database that is configured to store historical alarm and event data.

If you do not have a Microsoft SQL Server database installed, we recommend that you install Microsoft SQL Server 2005 Express (SP2) using the batch file available on both the FactoryTalk View and RSLinx Enterprise installation CDs in the Redist folder. For installation instructions, see “Install Microsoft SQL Server 2005 Express” on page 183.

If you already have Microsoft SQL Server 2000 (SP4) or 2005 installed, you may need to change the configuration options to log alarm and event messages. For configuration instructions, see “Use an existing Microsoft SQL Server database” on page 191.

Use the Alarm and Event Log Viewer to display entries corresponding to all event types or to filter the events you want to view. Alarms and events generated during run time can be logged to a Microsoft SQL Server database.

Simple Events are not supported in this release. A simple event describes a simple occurrence in the system, such as failure to access a computer or device. Condition-related events—those that relate to changes in alarm state—and tracking-related events—those that monitor audited changes to the system—are supported in this release.

To set up historical alarm and event logging, follow these steps. Each step is explained in detail in this chapter.

- Confirm that the Microsoft SQL Server 2005 Express (SP2) software is installed (or that you have an existing, compatible version of SQL Server installed—see the previous Tip).
- Add a database definition to your FactoryTalk system.
- Associate a database definition with an alarm and event server.
- Add an Alarm and Event Log Viewer object to a graphic display.
- Run the FactoryTalk View Site Edition Client software and then monitor the graphic display.
Before you begin

- If you do not already have Microsoft SQL Server software installed, you can install Microsoft SQL Server 2005 Express (SP2), which is available from the \Redist folder on both the FactoryTalk View and RSLinx Enterprise installation CDs.

- Define alarms as described in Chapter 3, “Define device-based alarms in Logix5000 controllers” and Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers” (optional).

- Add the appropriate device server as described in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”.

- Set up graphic display objects as described in Chapter 7, “Set up graphic displays”.

What you need

- RSLinx Enterprise software
- FactoryTalk View Studio software
- FactoryTalk View SE Client software
- SQL Server 2005 Express (SP2), 2000 (SP4) or 2005 software
Follow these steps

Chapter 2
Plan your system

Set up historical logging

- Confirm that the Microsoft SQL Server software is installed
- Run FactoryTalk View Studio
- Add a database definition to your FactoryTalk system
- Associate the database definition with an alarm server
- Add an Alarm and Event Log Viewer object to a graphic display
- Run FactoryTalk View SE Client software and then monitor the graphic display

Chapter 8
Monitor and interact with alarms during run time

* Microsoft SQL Server 2005 Express is available from both the FactoryTalk View and RSLogix Enterprise installation CDs.
Confirm that the Microsoft SQL Server software is installed

To log historical alarms and events, you can either install Microsoft SQL Server 2005 Express (SP2), or you can use an existing Microsoft SQL Server database already installed on your network. If you are using an existing Microsoft SQL Server database you will need to set up your database for alarm and event logging. See “Summary of steps” on page 184.

FactoryTalk Alarms and Events can log historical data to any of the following SQL Server databases:

- Microsoft SQL Server 2005 Express (SP2)
- Microsoft SQL Server 2005
- Microsoft SQL Server 2000 (SP4)

Microsoft SQL Server 2005 Express (SP2) software is available from the /Redist/SQLServer2005 folder on both the FactoryTalk View and RSLinx Enterprise installation CDs. To install Microsoft SQL Server 2005 Express (SP2), follow the instructions provided in Appendix D, “Install Microsoft SQL Server 2005 Express”.

If you are using an existing Microsoft SQL Server database, see “Use an existing Microsoft SQL Server database” on page 191.

Add a database definition to your FactoryTalk system

Create a database definition that specifies the connection information for the database and creates the required database objects.

Step 1: Open an existing application in FactoryTalk View Studio

1. To run FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.
3. In the **New/Open Site Edition (Local) Application** dialog box, click the **Existing** tab, and then select the **My Local Site** application that you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”.

Step 2: Create a new database connection

1. In the Explorer window, expand the folders **System > Connections**, and then right-click the **Databases** folder. On the context menu, click **New Database**.
2. In the **Alarm and Event Historian Database Properties** dialog box, configure properties for the new database definition.

   In this example, we used **FTAE_History** for the definition name and database name, **FTAE_Historian** for the database user name, as well as **password** for the password. Select the version of SQL Server you are using. For details, click **Help** on the dialog box.

   ![Alarm and Event Historian Database Properties Dialog Box](image)

   To improve efficiency when writing to the database, information is sent to a cache file located on the computer hosting the alarm server before writing to the database.

3. Click the Advanced tab. The system will attempt to create the database, the user account, and the tables that are necessary to store the alarm and event information.
If the database or user does not already exist in SQL Server, you are prompted to create them. Click Yes.

4. Configure the settings for the Alarm and Event Historian Database.

If the connection to the database is lost, alarm and event information will continue to be cached to files. After the connection is restored, the cached information will be sent to the database.

5. When you finish, click OK. If you are prompted to create the database, click Yes. The database definition is added to the Databases folder and is ready for use.

**Associate a database definition with an alarm server**

To set up an RSLinx Enterprise device server (device-based server) or a FactoryTalk Tag Alarm and Event Server (tag-based server) to log historical alarm and event data to a database, you must associate a database definition with the alarm server.

If no alarm history database is associated with an alarm server, the alarm server does not log any historical data. You can associate different alarm servers with different alarm history databases, or you can have all alarm servers log their data to the same database.

For details about setting up alarm servers, see Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” or Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.

**Step 1: Open an existing application in FactoryTalk View Studio**

1. To run FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.
3. In the **New/Open Site Edition (Local) Application** dialog box, click the **Existing** tab, and then select the **My Local Site** application that you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”.

**Step 2: Configure the alarm server**

1. In the Explorer window, expand the application tree until each alarm server is visible.

2. Right-click the alarm server named **FTAE Server** that you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”. On the context menu, click **Properties**.
3. For an RSLinx Enterprise Device Server, do the following and then click **OK**:

- In the **RSLinx Enterprise Server Properties** dialog box, click the **Alarms and Events** tab.
- Under **Alarm and Event History**, select the **Enable history** check box.
- In the **Database definition** list, select a definition (for this example, we used **FTAE_History**).
4. For a Tag Alarm and Event Server, do the following and then click OK:

- In the Tag Alarm and Event Server Properties dialog box, click the Priorities and History tab.
- Under Alarm History, select the Enable history check box.
- In the Database Definition list, select a definition.

Create an Alarm and Event Log Viewer display

Use the Alarm and Event Log Viewer to view alarm and event information previously logged in a Microsoft SQL database configured to store historical data.

Step 1: Open an existing application in FactoryTalk View Studio

1. To run FactoryTalk View Studio, on the Windows Start menu, click Start, point to All Programs > Rockwell Software > FactoryTalk View and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

3. In the New/Open Site Edition (Local) Application dialog box, click the Existing tab, and select the My Local Site application that you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers”.

[Image: Screenshot of Tag Alarm and Event Server Properties dialog box]
Step 2: Create a new graphic display

1. In the Explorer window, expand the Graphics folder, right-click Displays, and then click New.

A blank display appears in the workspace.

2. If necessary, resize the graphic display to about the same size as the one you created for the Alarm and Event Summary.

Step 3: Add an Alarm and Event Log Viewer object to the display

1. On the Objects menu, point to Alarm and Event, and then click Log Viewer (or click the Log Viewer toolbar button, as shown at left).

2. Hold the left mouse button down and drag the mouse to create a rectangle that is the size required for the Alarm and Event Log Viewer object.
3. When the object is the correct size, release the left mouse button. The Alarm and Event Log Viewer object is drawn on the graphic display.

Step 4: Configure the properties of the Alarm and Event Log Viewer

1. To open the Alarm and Event Log Viewer Properties dialog box, double-click the Alarm and Event Log Viewer object.

2. On the General tab, select the alarm log whose entries you want to view. In the previous example, we selected FTAE_History. This is the SQL database we created in “Associate a database definition with an alarm server” on page 119.

3. Click the Columns tab, and then clear the Area check box.

4. On the other tabs, set properties to customize the Log Viewer display, as desired. For details, click Help in the dialog box.

5. When you are finished, click OK to close the dialog box.
Step 5: Save the graphic display

1. On the File menu, click Save.

2. In the Save dialog box, type a name for the new display and then click OK.
   In this example, we used Alarm and Event Log Viewer for the name of the graphic display.

3. Close the graphic display.

Create a button to open the Alarm and Event Log Viewer display

We will add a button to open the Alarm and Event Log Viewer display in the same FactoryTalk View Client window as the Alarm and Event Banner display.

Step 1: Create a new graphic display

1. In the Explorer window, expand the Graphics folder, right-click Displays, and then click New.

2. If necessary, resize the graphic display to about the same size as the one you created for the Alarm and Event Summary.
Step 2: Add a button to the graphic display

1. On the Objects menu, point to Push Button, and then click Button (or click the Add Button button on the toolbar).

2. Hold the left mouse button down and drag the mouse to create a rectangle the correct size for the button and then release the mouse button.

3. In the Button Properties dialog box, click the Action tab.
Step 3: Configure the button commands

1. Click the browse button to the right of the Press action field, to open the Command Wizard.

2. In the Command Categories pane on the left, expand Graphics > Graphic Displays > Navigation.

3. In the list of commands on the right, click Display, and then click Next.

4. In the File list, select the name of the graphic display that is to open when the button is clicked.

In this example, we want the button to start the Alarm and Event Log Viewer, so we select Alarm and Event Log Viewer.
5. To close the Command Wizard, click **Finish**. In the **Button Properties** dialog box, the command **Display “Alarm and Event Viewer /CC”** appears in the Press action box.

6. Click the **Up Appearance** tab.

7. In the Caption box, type **Run the Alarm and Event Log Viewer**. Press the **Enter** key after “Alarm” so that the text wraps to the next line. This is the text that will appear on the button.

8. Click **OK** to save the button configuration. The finished button is drawn on the graphic display.
Step 4: Configure the properties of the graphic display

1. On the Edit menu, click Display Settings.

![Display Settings dialog box](image)

2. In the Display Settings dialog box, make the following changes on the Properties tab, and then click OK:
   - Clear the Title Bar check box.
   - Select the Size to Main Window at Runtime check box.
   - Select the Allow Display to be Resized check box.
   - Under When Resized, select Scale option if it is not already selected.

Step 5: Save the graphic display

1. On the File menu, click Save.

2. In the Save dialog box, type a name for the new graphic display, and then click OK.

   In this example, we used Menu Bar for the name of the graphic display.

Create a startup macro for the Menu Bar display

This section shows you how to modify the startup macro you created in Chapter 7, “Set up graphic displays”. This example shows you how to add commands to the startup macro that will open the button display you just created and dock it to the top of the client window.
Step 1: Edit the startup macro

1. In FactoryTalk View Studio, in the Explorer window, double-click the Start Alarm and Event Banner macro.

   The macro editor opens, showing the Banner display command (Display “Alarm and Event Banner” /DB).

2. To open the Command Wizard, double-click anywhere in the body of the macro editor.

3. In the list of commands on the right, select Display, and then click Next.

4. In the File list, click Menu Bar.

5. Select the Window Position check box. In the list of window positions, click Docked to the Top.
6. To save the configuration and display it in the macro editor, click **Finish**.

![Image of macro editor]

**Step 2: Save the startup macro**

1. On the **File** menu, click **Save**.
2. Close the macro editor.

**View historical alarm data in a FactoryTalk View SE Client**

Use the Alarm and Event Log Viewer—embedded in a FactoryTalk View graphic display—to view, sort, filter, and export historical alarm information stored in Alarm and Event Logs.

With the Alarm and Event Log Viewer, you can:

- display alarm and event information that has been logged by the FactoryTalk Alarm and Event Historian
- define filters to determine which logged alarms and events will be displayed
- sort the alarms and events that will be displayed

**Run the application**

You can open the FactoryTalk View Site Edition Client in various ways.

- from the Windows Start menu in Chapter 8, “Monitor and interact with alarms at run time”
- from within FactoryTalk View Studio, which is covered in this section
- by double-clicking a FactoryTalk View SE Client configuration file (*.cli)
To start the FactoryTalk View SE Client from within FactoryTalk View Studio:

1. If FactoryTalk View Studio is not still open, on the Windows Start menu, point to Programs > Rockwell Software > FactoryTalk View Enterprise, and then click FactoryTalk View Studio.

2. In the Application Type Selection window, select Site Edition (Local) and then click Continue.

3. In the New/Open Site Edition (Local) Application dialog box, click Cancel.

4. In FactoryTalk View Studio, on the toolbar, click the Launch SE Client button.

5. In the Launch FactoryTalk View SE Client dialog box, select Alarms and Events Demo.cli, and then click OK.
The FactoryTalk View SE Client opens after a few moments. The button appears at the top of the window and the Alarm and Event Banner appears at the bottom.
6. Click the **Run Alarm and Event Log Viewer** button to make the Log Viewer appear in the middle of the Client window:
7. Click the **Run Alarm and Event Summary** button on the Banner display at the bottom of the window. The Summary display replaces the Log Viewer.

For details about enabling, disabling, suppressing, unsuppressing, and acknowledging alarms, see Chapter 8, “Monitor and interact with alarms at run time”, or see FactoryTalk Help: on the Windows Start menu, click Start > All Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk Help.
Getting started with language switching

You can use language switching to display text strings that you define when you create an application, in up to 40 different languages. At run time, a FactoryTalk View SE Client can switch between any of the languages the application supports. In a network application, multiple clients can run in different languages at the same time.

For information, see “Language identifiers for language switching” on page 217.

**IMPORTANT**

Time and date formats in FactoryTalk Alarms and Events objects do not switch. These objects always display the date and time format of the operating system. The rest of a FactoryTalk View application shows the format for the language FactoryTalk View is displaying.

Dialog boxes that are part of the graphical user interface of FactoryTalk Alarms and Events—for example, the Acknowledge with Comment dialog box—do not switch languages. They are displayed in the language of the operating system.

Historical alarm and event messages do not switch languages. They are displayed in the language in which they were logged.

**TIP**

For more detailed information, see the FactoryTalk View Site Edition Help in FactoryTalk View Studio.

**Before you begin**

To implement language switching, the steps depend on whether you are using device-based alarm monitoring or tag-based alarm monitoring. If you are not sure what type of alarm monitoring you are using, see Chapter 2, “Plan your system”.

**If you are using device-based alarm monitoring**

- Review Chapter 3, “Define device-based alarms in Logix5000 controllers”.
- Verify that you have installed and activated the software listed under “What you need”.
- Verify that the Logix5000 firmware has been updated to version 16 or later.

**If you are using tag-based alarm monitoring**

- Review Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.
- Configure a data server, as discussed in Chapter 5, “Add an OPC Data Server for third-party controllers”.
What you need

If you are using device-based alarms

- RSLogix 5000 v. 16 or later
- ControlFLASH
- RSLinx Classic
- RSLinx Enterprise
- FactoryTalk View Studio
- FactoryTalk View SE Client

If you are using tag-based alarms

- PLC-5, SLC 500, third-party, or Logix5000 controllers that have not been programmed with alarm instructions included in RSLogix 5000 v. 16 or later
- RSLogix 5 or RSLogix 500 software
- RSLinx Enterprise, RSLinx Classic (for bridging from Ethernet to DH+ or DH-485 networks), or a third-party OPC Data Server (for example, KEPWare server) for communicating with third-party controllers
- FactoryTalk View Studio or FactoryTalk Administration Console
- Microsoft® Excel (for editing exported alarm messages in multiple languages)
Follow these steps

Create device-based alarm messages

To create device-based alarm messages in multiple languages you can use the import and export features in RSLogix 5000. At run time, alarm messages located in Logix5000 controllers can be displayed in the language of the FactoryTalk View application in which they are displayed.

When RSLinx Enterprise connects to the controller, all alarm messages and their languages are uploaded from the controller. When a FactoryTalk View SE Client runs, the FactoryTalk Alarms and Events objects (Alarm and Event Summary, for example) connect to the FactoryTalk Alarms and Events system and request alarm messages in the current language. When you switch languages on the client computer, the alarm monitoring system and all of the client screens switch to the appropriate language on that specific client.

Historical alarm messages are logged in the language currently associated with the Alarm and Event Log. The Alarm and Event Log displays messages in the language in which they were logged. For example, a message logged in English will be displayed in English, even if the language is switched to Italian.
Translate alarm messages using import and export

A system may have thousands of alarm messages that need to be translated. To simplify this process, you can export alarm messages from RSLogix 5000 to a file, add translated messages in multiple languages to the file, and then import the file back into your project. Any of the languages you translate the strings into must be supported by FactoryTalk View.

You can enter text strings in multiple languages in two ways.

1. In RSLogix 5000 v. 16 or earlier, create alarm messages in one language, and use the RSLogix 5000 Export tool, to export the project’s tags, logic comments, descriptions and alarm messages from RSLogix 5000 to a comma-separated value (*.csv) file or a text (*.txt) file. The text strings can be translated into other languages and added to the file. Then use the RSLogix 5000 Import tool, to import the strings back into the project.

2. In RSLogix 5000 v. 17 or later, you select a language for the project and then in the Project Documentation Language Configuration dialog box you export a localization file that contains documentation from the project. The documentation included in the text (*.txt) file includes user defined logic comments, component names, and alarm messages. The text strings can be translated into other languages and added to the file. Then use the Project Documentation Language Configuration dialog box to import strings back into the project. See “Translating alarm messages using RSLogix 5000 v. 17 or later” on page 144.

Translate alarm messages in RSLogix 5000 v.16 or earlier

To translate alarm messages using RSLogix 5000 v. 16, complete the following steps. To translate alarm messages in RSLogix 5000 v. 17 or later, using the project documentation language feature see, “Translating alarm messages using RSLogix 5000 v. 17 or later” on page 144.

**Step 1: Export alarm messages from RSLogix 5000**

1. Start RSLogix 5000 and open the West_Plant_Controller project you created in Chapter 3, “Define device-based alarms in Logix5000 controllers”. If you haven’t yet created the project, do so before continuing.

2. In the RSLogix 5000 window, on the Tools menu, click Export.
3. In the Export dialog box, click Export.

If your RSLogix 5000 project includes a large number of programs, and you want to translate alarm messages from only one of them, you can make selections in the Export dialog box to limit the data that is exported. For details, click Help in the dialog box.

When translating to or from Unicode character sets (for example, Asian languages), you must export and then import the RSLogix 5000 tag database as a .txt file. The .csv format does not support Unicode character sets. This limitation does not apply to Tag Alarm and Event Servers.

**Step 2: Translate the exported alarm messages**

1. In Windows Explorer, locate the file you exported and then double-click it to open it in Notepad. You can also edit the file using Microsoft Excel.

   The last line of text in the file is the alarm definition. The first element from the left is the instruction type (ALMMSG:) and the language string for the alarm message (en-us for English in the United States).

   The alarm message text appears as the fourth element from the left (“Tank Temperature is High”).

2. Copy the ALMMSG line and paste it at the end of the file.

3. Change en-us to it-it (for Italian in Italy), and then change the alarm message text to read, “La temperatura del serbatoio è alta”.

4. Paste another copy of the ALMMSG line at the end of the file.
5. Change **en-us** to **de-de** (for German in Germany), and change the alarm message text to read, “**Hohe Tanktemperatur!**”.

6. On the **File** menu, click **Save** to save the file.

**TIP**
When you import alarm messages, RSLogix 5000 v. 16 verifies the message length and displays a warning if the alarm message exceeds the character limit.
Step 3: Import the translated alarm messages

1. In the RSLogix 5000 window, on the Tools menu, click Import.

2. In the Import window, select the file you modified and then click Import.

The import process produces warnings because it overwrote existing tags.
Step 4: Download the project to the controller

To update the controller with additional alarm messages in the new languages, download the project to the controller.

Next, either continue setting up tag-based alarm messages, or set up a graphic display for language switching. See “Add buttons to a graphic display to switch languages at run time” on page 153.

Translating alarm messages using RSLogix 5000 v. 17 or later

To translate alarm strings in RSLogix 5000 v. 17 and later, use the project documentation import and export feature. Only the information that is necessary for localization is included in the exported file.

Step 1: Export alarm messages from RSLogix 5000

1. Start RSLogix 5000 v. 17 and open the West Plant Controller project you created in Chapter 3, “Define device-based alarms in Logix5000 controllers”. If you have not created the project, do so before continuing.

2. Open the Project Documentation Language dialog box, click the Documentation Language Configuration icon or click Documentation Languages on the Tools menu.

3. To associate the existing product documentation with a language, select a language from the Select a language list or click Custom and then add a custom language. For example, select English (United States) from the list and then click OK.
4. After you select a language for the project, the **Project Documentation Language Configuration** dialog box opens. To export a localization file, click **Export**. If the dialog box does not open, click **Documentation Languages** on the **Tools** menu.

5. Select the languages to include in the localization file and then click **Next**. For example, select German (Germany) and Italian (Italy) if the project documentation will be translated into German and Italian.

6. To add the configuration information to the localization file, click **Next**.

7. Specify the name and location of the exported localization file and then click **Export**.

8. Click **OK**.
Step 2: Translate the exported alarm messages

1. In Windows Explorer, locate the file you exported. Right-click the file, point to Open With and then click Microsoft Excel.

   ![Excel screen capture]

   The first column contains the instruction type ALMMSG. Column C is labeled KEY:en-US [English (United States)] and the alarm message is displayed in English.

   Column D is labeled de-DE [Deutsch (Deutschland)], and Column E is labeled it-IT [italiano (Italia)]. These are the languages you selected for the export.

2. Type, “Hohe Tanktemperatur!” in column D in the same row that displays “Tank Temperature is High”.

3. Type “La temperatura del serbatoio è alta” in column E in the same row that displays “Tank Temperature is High”.

4. To save the file, click Save on the File menu.

Step 3: Import the translated alarm messages

1. In the RSLogix 5000 window, on the Tools menu, click Documentation Languages.

2. In the Project Documentation Language Configuration dialog box, click Import.

3. In the Select File dialog box, select the file you modified and then click Import.
4. Verify the languages you want to import in the **Import Project Documentation** dialog box and then click **Import**.

5. Click **OK**.

**TIP**

When you import alarm messages, RSLogix 5000 v. 17 will verify the message length and display a warning if the alarm message exceeds the 255 character limit.

---

### Step 4: Download the project to the controller

To update the controller with additional alarm messages in the new languages, download the project to the controller.

Next, either continue with setting up tag-based alarm messages, or set up a graphic display for language switching. See “Add buttons to a graphic display to switch languages at run time” on page 153.

---

### Create tag-based alarm messages

The alarm messages in a tag-based alarm server also support language switching. As with RSLogix 5000 alarms, in FactoryTalk View you can also enter text strings in multiple languages in two ways.

1. The messages in the **Alarm and Event Setup** editor are saved in the language you select when opening an application in FactoryTalk View.

2. After creating alarm messages in one language, you can export them from FactoryTalk View to a Microsoft Excel (*.xls) or XML file (*.xml), add translated versions of the strings to the exported file, and then import them into FactoryTalk View again.

   The maximum length for alarm messages is 255 characters. When you import alarm messages, anything over 255 characters is truncated.

---

### Entering text strings in FactoryTalk View Studio

**Step 1:** In FactoryTalk View Studio, choose a language in which to open an application

1. To start **FactoryTalk View Studio**, click **Start**, point to **All Programs > Rockwell Software > FactoryTalk View** and then click **FactoryTalk View Studio**.

---

147
2. In the **Application Type Selection** window, select **Site Edition (Local)** and then click **Continue**.

---

3. In the **New/Open Site Edition (Local) Application** dialog box, click the **Existing** tab, select the application you created in Chapter 4, “Add a device server for Logix5000, PLC-5, or SLC 500 controllers” (we used My Local Site).

---

4. In the **Language** list, select the language in which you are creating your application (in this example, **English (United States), en-US**), and then click **Open**.
Step 2: Create a digital alarm

This section uses the FactoryTalk Tag Alarm and Event Server you created in Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”. If you haven’t yet created the server, do so before continuing.

1. In the Explorer window, expand the new Tag Server, and then double-click Alarm and Event Setup.

2. In the Alarm Setup dialog box, click the Digital tab.

3. On the toolbar, click the New button (shown at left).
4. In the **Digital Alarm Properties** dialog box, in the **Name** box, type **TankTempThreshold**.
5. In the **Input Tag** field, type `system\Second`. This tag uses the second count from the computer’s internal clock to trigger the alarm. You can also click the Browse button beside the **Input Tag** field to select the `system\Second` tag and then click **OK**.

![Select Tag dialog box](image1)

6. In the **Digital Alarm Properties** dialog box, in the **Condition** list, select **Input = 0**. This triggers the alarm every time the value of the `system\Second` tag is 0 — which happens every minute.

7. In the **Message** field, type **Tank Temperature is High**, and then click **OK**.

8. Close the **Alarm and Event Setup** editor and save your changes.
Add languages to the application

1. In FactoryTalk View Studio, on the **Tools** menu, click **Languages**.

2. In the **Language Configuration** dialog box, select the **Display undefined strings using the default language** check box, and then click **Add**.

   ![Language Configuration dialog box](image)

   When the **Display undefined strings using the default language** check box is selected, any strings that are not defined in the current language are displayed in the default language at run time.

   When this check box is not selected, any strings that are not defined in the current language are displayed as question marks at run time.

3. In the **Add Language** dialog box, click **German (Germany)** and then click **OK**.

   ![Add Language dialog box](image)

4. In the **Language Configuration** dialog box, click **Add** to add the next language.
5. In the **Add Language** dialog box, click **Italian (Italy)** and then click **OK**.

6. In the **Language Configuration** dialog box, click **OK**.

---

**Add buttons to a graphic display to switch languages at run time**

In this section, we’ll add a button to a graphic display, to switch among available languages at run time.

**Step 1: Create a new graphic display**

1. In FactoryTalk View Studio, in the Explorer window, expand the **Graphics** folder.
2. Right-click **Displays**, and then click **New** on the context menu.
Step 2: Add buttons to the graphic display

1. On the Objects menu, click Button and then click Push Button.

2. In the graphic display, hold down the left mouse button and then drag the mouse to draw a box for the button.

3. On the Edit menu, click Copy.

4. On the keyboard, press Ctrl-V twice, to paste two more copies of the button in the graphic display.

5. Drag the copies of the button apart on the display.

6. On the keyboard, press Ctrl-A to select all of the buttons.

7. On the Arrange menu, click Align Top to align the tops of the buttons.

8. On the Arrange menu, click Space Horizontal to space the buttons equally apart.
Step 3: Add captions to the buttons

1. Double-click the first button to edit it.

2. In the **Button Properties** dialog box, click the **Action** tab.

3. Click the browse button to the right of the **Release action** field. The **Command Wizard** opens.

4. In the Command Categories pane on the left, expand **All Commands and Macros**.

5. In the list of commands on the right, click **Language**, and then click **Next**.

6. In the **Language ID** list, select the name of the language and then click **Finish**.

   In this example, we are using **English (United States), en-US**.

7. In the **Button Properties** dialog box, click the **Up Appearance** tab.

8. In the **Caption** field, type **English** and then click **OK**.
9. Repeat the steps above to add captions to the other two buttons:

- For the second button, the press action is **Language it-IT** (Italian for Italy).
- For the second button, the caption is **Italiano**.
- For the third button, the press action is **Language de-DE** (German for Germany).
- For the third button, the caption is **Deutsch**.

![Image of three language buttons: English, Italiano, Deutsch]

**Step 4: Add an Alarm and Event Summary to the graphic display**

1. On the **Objects** menu, point to **Alarm and Event**, and then click **Summary** (or on the toolbar, click the Summary button, as shown at left).

2. In the graphic display, hold the left mouse button down and drag the mouse to create a box for the Alarm and Event Summary object.

3. When you have the object the required size, release the left mouse button. The Alarm and Event Summary object is drawn on the display.

![Image of Alarm and Event Summary design view]
Step 5: Save and then close the graphic display

1. On the File menu, click Save.

2. In the Save dialog box, type a name for the graphic display and then click OK.
   In this example, we used Alarm Summary Multilingual.

3. On the File menu, click Close to close the graphic display.

Enter alarm messages in other languages

In this section, we’ll edit our application twice. The first time, we’ll open the application in Italian, and then we’ll enter the Italian alarm message in the Alarm Properties dialog box.

Next, we’ll export the alarms and events to an Excel spreadsheet, enter the German text in Excel, and then import the alarm messages again into our application.

When you enter alarm messages in multiple languages in Excel, you can add the text strings for all languages to one Excel file, and then import the translated text for all languages into the application in one operation.

When you import alarm messages, the maximum length that is allowed is 255 characters. Alarm messages longer than 255 characters are truncated.

Step 1: Open the application in a new language

1. On the File menu, click Close Application.

2. In the New/Open Application dialog box, click the Existing tab.

3. In the list of applications, click the name of your application (in this example, My Local Site).
4. In the **Language** list, select **Italian (Italy), it-IT** and then click **Open**.

Step 2: Enter the alarm message for the digital alarm

1. In the Explorer window, expand the **Tag Server**, and then double-click **Alarm and Event Setup**.
2. In the **Alarm and Event Setup** editor, click the **Digital** tab and then double-click the TankTempThreshold alarm to edit it.

3. In the **Digital Alarm Properties** dialog box, in the **Message** field, type *La temperatura del serbatoio è alta* and then click **OK**.
Step 3: Export alarm messages to an Excel spreadsheet

1. Right-click the Tag Alarm and Event Server where the alarms are defined, and then click Import and Export on the context menu.

   In this example, right-click the Tag Alarm and Event Server called Tag Server.

2. In the Alarm Import Export Wizard, in the Operation Type window, leave Export alarm configuration to Excel file selected and then click Next.
3. In the **Alarms to Export** window, leave the TankTempThreshold alarm in the list of alarms to export and then click **Next**.

   ![Alarm Import Export Wizard - Alarms to Export](image1)

If you have many alarms and you want to export only some of them, you can filter the list of alarms to find the ones you want, and then you can include only those alarms you need in the exported file. For details, click **Help**.

4. In the **Messages to Export** window, leave **Export messages for all alarms** selected, leave all of the languages selected, and then click **Next**.

   ![Alarm Import Export Wizard - Messages to Export](image2)

In this window you can choose whether to export all alarm messages, the messages for only the alarms you selected in the previous step, or no alarm messages, which then exports only the alarm data. If you are exporting alarm messages, you can also select which languages you want to export.
5. In the **Specify Output File** window, leave the file name as it is. You can specify a location where you want the file to be save or use the default location that is displayed, and then click **Finish**.

To browse for a location, click the Browse button (shown at left).

6. After the export is complete, click **OK**.

**Step 4: Enter alarm messages in Excel**

1. Locate the exported alarm file and then double-click it to open it in Microsoft Excel. The default location is in your **My Documents** folder. In this example, the file is called **My Local Site_Tag Server_AlarmsExport.xls**.

Each alarm is located in a new row in the spreadsheet. The column names correspond to the settings for each alarm. At the bottom of the Excel window there are tabs that organize the alarms by type (Digital, Level, Deviation).
Two additional tabs contain the alarm messages and the tag update rates. These items are located on their own tabs because they can apply to multiple alarms.

For example, if you had 50 alarms, you could use the same alarm message for 10 of them, but have different messages for the rest. Instead of editing the same alarm message 10 times, you only need to edit it once. Each alarm message has its own numeric identifier (in the Message column located in column H in our example), which links a message to each alarm (level alarms can have a different message for each level).

The maximum length for an alarm message is 255 characters. Messages that are longer than 255 characters are truncated when they are imported.

2. At the bottom of the Excel window, click the Messages tab.

3. To add a new language for messages, add a new column and then type the associated language identifier as the column heading. For example, click cell D1 and then type de-DE. This is the language identifier for German.

For example, the column heading, en-US is the language identifier for English (United States). For more information, see “Language identifiers for language switching” on page 217.
4. To add messages, type the new message in a row under the column specified for that language. For example, click cell D2 and then type Hohe Tanktemperatur!

5. At the bottom of the Excel window, click the Tag Update Rates tab. The columns are labeled with the update rates. For example cell A-1, is labeled 0.10 Seconds and cell E-1 is labeled 2 Seconds.

6. To update an input tag every 2 seconds, enter the name of the input tag in the column labeled 2 Seconds.

7. To save your changes, click Save on the File menu.


**Step 5: Import the alarm messages**

1. In FactoryTalk View Studio, right-click the Tag Alarm and Event Server where the alarms are defined, and then click Import and Export on the context menu.

   In this example, right-click the Tag Alarm and Event Server called Tag Server.
2. In the Alarm Import Export Wizard, in the **Operation Type** window, select **Import alarm configuration from Excel file** and then click **Next**.

![Alarm Import Export Wizard - Operation Type](image)

3. In the **File to Import** window, select the Excel spreadsheet to which you added the German alarm message and then click **Next**.

   To browse for the file, click the Browse button (shown at left).

![Alarm Import Export Wizard - File to Import](image)

4. In the **Alarms to Import** window, select **Import only alarm messages**, and then click **Next**.

   ![Alarm Import Export Wizard - Alarms to Import](image)

   In this window you can choose to overwrite any existing alarms, add only the new alarms, leaving all existing alarms unchanged, or delete all existing alarms and then import only those that are in the import file.
5. In the Messages to Import window, select **Update existing messages and create new messages from the import file**, and then click **Finish**.

![Alarm Import Export Wizard - Messages to Import](image)

Do not select either of the other two options in this window. In our Excel spreadsheet, we added a language to an existing alarm message; we did not create a new alarm message. If you do not choose to update existing messages, the translated text will not appear in your alarm messages.

6. After the import is complete, click **OK**.

**Create a Display Client configuration file to test alarm messages**

Because the Language command is ignored when you test-run an application, you’ll need to run the application from the FactoryTalk View Site Edition Client.

**Step 1: Run FactoryTalk View Site Edition Client**

1. On the Windows Start menu, click **Start**, point to **All Programs > Rockwell Software > FactoryTalk View** and then click **FactoryTalk View Site Edition Client**. The FactoryTalk View SE Client Wizard opens.
Step 2: Create a FactoryTalk View Site Edition Client configuration file

1. In the FactoryTalk View Client Wizard, click **New**.

2. In the FactoryTalk View SE Client Configuration Name window, type a name for the configuration file. In this example, we used **Multilingual Alarms**. Keep the default path for the configuration file and then click **Next**.

For details about using the FactoryTalk View Site Edition Client Wizard, click **Help** in the wizard.

3. In the **FactoryTalk View SE Client Application Type** window, click **Local** and then click **Next**.
4. In the **FactoryTalk View SE Client Application Name** window, select the name of the application you want to connect to, and then click **Next**.

   In this example, we used the **My Local Site** application that we created in Chapter 7, “Set up graphic displays”.

   ![FactoryTalk View SE Client Application Name Window](image)

5. In the **FactoryTalk View SE Client Components** window, select the FactoryTalk View components that run when the FactoryTalk View Site Edition Client starts. In the Initial display list, click **Alarm Summary Multilingual**, and then click **Next**.

   ![FactoryTalk View SE Client Components Window](image)
6. In the **FactoryTalk View SE Client Window Properties** window, you configure how the FactoryTalk View SE Client window will look at run time. In this example, we entered **Show Me Alarms** in the **Title bar text** field. At run time, this text is displayed at the top of the Client window, and does not switch languages. Don’t change any of the other settings in this window. Click **Next**.

![FactoryTalk View SE Client Window Properties](image1)

7. In the **FactoryTalk View SE Client Auto Logout** window, you can configure the Client to log out automatically after a period of inactivity. In this example, we accepted the default setting. Click **Next**.

![FactoryTalk View SE Client Auto Logout](image2)
8. In the **FactoryTalk View SE Client Completion Options** window, click *Save configuration and open FactoryTalk View SE Client now*, and then click *Finish*.

---

**Test alarm messages at run time**

For details about triggering an alarm in RSLogix 5000, see “Test the alarm instruction by switching to run mode and triggering the alarm” on page 31.

In a Tag Alarm and Event Server, the TankTempThreshold alarm we created triggers automatically once every minute.

When an alarm conditions occurs, the alarm appears in the Alarm and Event Summary in the default run-time language (in this case, English for the United States).
When you click the **Italiano** button, the alarm message appears in Italian. Notice that the other parts of the Alarm and Event Summary (for example, the Details pane) currently appear in the language version of the FactoryTalk View software you have installed on your computer. However, you can make these items switch languages by editing the properties of the Alarm and Event Summary to modify the column heading text. You can also export the graphic display’s language strings in FactoryTalk View, and then translate them before importing them again.

The behavior of the display is the same when you click the **Deutsch** button to display the alarm message in German.

The labels on the buttons do not change when we switch languages. This is intentional—because we did not provide translated strings for the buttons, and because we selected the **Display undefined strings using the default language**
check box. If you do not select this check box, undefined strings are displayed as question marks (?) at run time.

Summary and tips for setting up language switching

To set up language switching for an application:

1. Develop the application in a base language.

2. Export the application’s user-defined text strings.

   When translating to or from Unicode character sets (for example, Asian languages), you must export and then import the RSLogix 5000 tag database as a .txt file. The .csv format does not support Unicode character sets. This limitation does not apply to FactoryTalk Tag Alarm and Event Servers.

3. Translate the strings. You can use Notepad or Microsoft Excel. Excel is useful for large numbers of strings.

4. Import the translated strings back into the application.

   For more detailed information about setting up language switching, see the FactoryTalk View Site Edition Help in FactoryTalk View Studio, and see the FactoryTalk View User’s Guide—in FactoryTalk View, click Help > Online Books.
Text that supports language switching

In general, the user-defined strings that support language switching are those that an operator sees in an application at run time. Specifically, these are:

- text you specify for graphic objects and global objects including captions, tool tip text, time and date embedded variables, and numeric embedded variables.
- graphic and global object display titles specified in the Display Settings dialog box.
- text objects created in graphic displays and global object displays.

Text that does not support language switching

Among the text strings that do not support language switching are:

- text that is part of the language version of the FactoryTalk View Studio Site Edition or Client software, such as information from system tags, which is displayed in the same language as the operating system. These are translated when FactoryTalk View is localized.
- text that can be displayed at run time but is used to operate the application, such as the names of graphic displays, and command strings.
- tag descriptions and string constants in expressions.
- text in the title bar of the FactoryTalk View Site Edition Client window, which is part of the setup of the client, not part of the application.

Alarm and Event Summary and Alarm and Event Banner

If the Alarm and Event Summary or the Alarm and Event Banner is notified of a language switch, the contents are reloaded in the new language.

Any Alarm Fault List messages that you created in RSLogix 5000 (in the Alarm Properties dialog box) do not currently switch languages.

You can use the Alarm and Event Banner Properties dialog box to configure tooltips and panel captions in multiple languages. Define strings in one language at a time. FactoryTalk View controls which language is displayed. You cannot switch the text labels for the alarm states and priorities.

TIP

When configuring language switching for the Alarm and Event Banner, see the FactoryTalk View Site Edition Help in FactoryTalk View Studio.
Alarm and Event Log Viewer

You can use the Alarm and Event Log Viewer to configure column headings, button captions, and button tooltips in multiple languages. Define strings in one language at a time. FactoryTalk View controls which language is displayed.

When the Alarm and Event Log Viewer is notified of a language switch, the contents of the viewer, which consists of report data, are not translated. This data continue to be displayed in the language that was used when the alarm or event was logged.

If text for a language is not available, the text for the default language is used.

TIP When configuring language switching for the Alarm and Event Log Viewer, see the FactoryTalk View Site Edition Help in FactoryTalk View Studio.
System performance and limits

FactoryTalk Alarms and Events has been tested to conform to the following performance limits.

Controller specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of subscribers (RSLinx Enterprise servers) per controller</td>
<td>16</td>
</tr>
<tr>
<td>Controller memory used for buffering by each subscriber (RSLinx Enterprise)</td>
<td>100KB</td>
</tr>
<tr>
<td>Typical number of alarm state transitions per subscriber</td>
<td>1000</td>
</tr>
<tr>
<td>Recommended maximum number of alarms per controller</td>
<td>2000</td>
</tr>
<tr>
<td>Approximate controller memory used for each alarm</td>
<td>Digital 1 KB; Analog 2.2 KB; Using associated tags, string tags consume 750-1600 bytes per string tag depending on the alarm type.</td>
</tr>
<tr>
<td>Supported languages for alarm messages</td>
<td>All languages supported by FactoryTalk View.</td>
</tr>
</tbody>
</table>

Execution times for alarms

<table>
<thead>
<tr>
<th>Rung State</th>
<th>Execution times</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ALMD instruction</td>
</tr>
<tr>
<td>False with no alarm state change</td>
<td>8 µs</td>
</tr>
<tr>
<td>False with alarm state change</td>
<td>35 µs</td>
</tr>
<tr>
<td>True with no alarm state change</td>
<td>8 µs</td>
</tr>
<tr>
<td>True with alarm state change</td>
<td>35 µs</td>
</tr>
</tbody>
</table>

Scan times increase more during a scan when many alarms change state at the same time.

An alarm state change is any event that changes the condition of the alarm. To minimize the potential for large alarm bursts, create dependencies on related alarms. Large alarm bursts can have a significant impact on the scan time of application code.
## Tested system limits

<table>
<thead>
<tr>
<th>Tested limit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of alarms per FactoryTalk application</td>
<td>20,000</td>
</tr>
<tr>
<td>Number of Rockwell Automation Device Servers per application</td>
<td>2</td>
</tr>
<tr>
<td>Number of alarms per Rockwell Automation Device Server (RSLinx Enterprise)</td>
<td>10,000</td>
</tr>
<tr>
<td>Number of Tag Alarm and Event Servers per application</td>
<td>2</td>
</tr>
<tr>
<td>Number of alarms per Tag Alarm and Event Server</td>
<td>10,000</td>
</tr>
<tr>
<td>Alarm burst (number of alarms occurring at once)</td>
<td>2000</td>
</tr>
<tr>
<td>Simultaneous alarm operations (for example, enabling, disabling, acknowledging, or suppressing alarms)</td>
<td>2000</td>
</tr>
<tr>
<td>Number of alarms the alarm summary can display at once</td>
<td>2000</td>
</tr>
<tr>
<td>Number of clients simultaneously connected to the application</td>
<td>20</td>
</tr>
</tbody>
</table>

For historical alarm logging, you must be able to log on to a Microsoft SQL Server 2005 Express (SP2), SQL Server 2000 (SP4), or SQL Server 2005 database.

When a controller becomes disconnected from alarm servers on the network, it might take several minutes to reconnect, depending on the number of controllers and alarms in the system.
Tested topology

Non-redundant topology:

All testing was performed on the recommended hardware. See the FactoryTalk View Site Edition Installation Guide. In FactoryTalk View Studio, click the Help menu, point to Online Books, and then click Installation Guide.
• FactoryTalk Alarms and Events System Configuration Guide
Install FactoryTalk Alarms and Events manually

FactoryTalk Alarms and Events software is installed when you install FactoryTalk View Site Edition and RSLinx Enterprise software; it is not installed as part of the FactoryTalk Services Platform. If you installed the platform on a computer where FactoryTalk View Site Edition and RSLinx Enterprise are not installed, you will not have the FactoryTalk Alarms and Events software, and must install it manually.

If you have a dedicated FactoryTalk Network Directory Server that does not have FactoryTalk View Site Edition or RSLinx Enterprise installed, you must install FactoryTalk Alarms and Events on the server manually.

The following illustration shows a sample FactoryTalk system with Alarms and Events software installed on various computers. The FactoryTalk Alarms and Events software on the Network Directory Server required a manual installation.
Summary of steps

- Step 1: Confirm that the FactoryTalk Services Platform is installed on the computer where you’re going to install FactoryTalk Alarms and Events.
- Step 2: Install FactoryTalk Alarms and Events software.

**Step 1: Confirm that the FactoryTalk Services Platform is installed**

The FactoryTalk Services Platform must be installed before installing FactoryTalk Alarms and Events.

To check if you have the FactoryTalk Services Platform:

1. On the Start menu, click Control Panel, and then double-click Add or Remove Programs.
2. In the list, look for FactoryTalk Services Platform 2.10 (CPR 9) or later. If it is not in the list, install it.

For detailed instructions, see the FactoryTalk View Site Edition or RSLinx Enterprise installation instructions.

**Step 2: Install FactoryTalk Alarms and Events**

Log in as a user with administrative rights before you begin the installation. As part of the installation process, FactoryTalk Alarms and Events creates program folders and modifies registry entries. To make these modifications, the user that is currently logged in must have administrative rights on the computer on which FactoryTalk Alarms and Events is installed.

1. Close any programs that are open.
2. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the FTAE folder, and then double-click Setup.exe.
3. If .Net 2.0 is not already installed on your computer, it is installed automatically. Follow the instructions on the screen.
4. In the Welcome dialog box, click Next.
5. Click the option to accept the End User License Agreement, and then click Next.
6. Select the **Complete Installation** option, and then click **Next**.
   
   The Client-only option is **not applicable** for this release.

7. To install Microsoft SQL Server 2005 Express (SP2) after installing FactoryTalk Alarms and Events, leave the check box selected, and then click **Next**.

   **TIP**
   
   If you already have a Microsoft SQL Server database that you want to use for logging alarm and event information, clear the check box, and then click **Next**.

8. Click **Install** to begin the installation.

9. When the installation is finished, click **Finish** to close the window.
FactoryTalk Alarms and Events System Configuration Guide
Install Microsoft SQL Server 2005 Express

FactoryTalk Alarms and Events uses Microsoft SQL Server as the database engine for logging alarm and event information. You can connect to an existing SQL Server database, or you can install Microsoft SQL Server 2005 Express, Service Pack 2, which is included in the Redist folder on the FactoryTalk View Site Edition and RSLinx Enterprise CDs.

If you do not have an existing Microsoft SQL Server database, or do not plan to use it, follow the instructions outlined in this chapter to make sure that Microsoft SQL Server 2005 Express is installed with the correct features enabled. See “Summary of steps” for more information.

The database can be installed on the same computer used to host other FactoryTalk servers or it can be on a separate computer. Depending on the size of your system, you might choose to use a separate computer as a dedicated logging computer to balance processing power.

For more information on using an existing Microsoft SQL Server database, see Appendix E, “Use an existing Microsoft SQL Server database”.

Operating systems

Microsoft SQL Server works with the following operating systems:

- Windows Server 2003, Service Pack 1 or later
- Windows XP, Service Pack 2 or later
- Windows 2000, Service Pack 4 or later

For more information about operating system requirements, see the Microsoft website.
Summary of steps

Following is a summary of the steps required to install Microsoft SQL Server 2005 Express. Each step is described in more detail on the following pages.

- **Step 1:** Open the *Redist* folder, which is at the root of the FactoryTalk View Site Edition or RSLinx Enterprise CD. This folder contains the software for Microsoft SQL Server 2005 Express (SP2) and its prerequisite software.

- **Step 2:** Install the .NET Framework and other prerequisite software. The SQL Server 2005 Express installation will fail without these components.

- **Step 3:** Run the SQL Server Install batch file to install and configure SQL Server 2005 Express.

- **Step 4:** Install the Microsoft SQL Server Express Management Studio (optional).

- **Step 5:** Configure the Windows firewall if you want to allow for remote connections.

**Step 1: Open the Redist folder**

The *Redist* folder is located at the root of the FactoryTalk View Site Edition and RSLinx Enterprise CDs and contains the following folders:

<table>
<thead>
<tr>
<th>Folder name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DotNet20*</td>
<td>Installation for Microsoft .NET Framework version 2.050727. You might already have the .NET software on your computer, but verify the correct version is installed or the SQL Server install will fail.</td>
</tr>
<tr>
<td>MDAC28*</td>
<td>Installation for Microsoft Data Access Components (MDAC) version 2.8. If you are using Windows 2000, install this component if it's not already on your computer. If you are not using Windows 2000, you do not need to install this component.</td>
</tr>
<tr>
<td>MSXML6*</td>
<td>Installation for Microsoft Core XML Services (MSXML) version 6.0.</td>
</tr>
</tbody>
</table>

*These software components are prerequisites for Microsoft SQL Server 2005 Express. You must install them before installing Microsoft SQL Server 2005 Express. There are other prerequisites but these are the ones most commonly needed so they are included for your convenience. If the installation program identifies other missing components, download them from the Microsoft website.*
Step 2: Install the .NET Framework and other prerequisite software

Install the software components described in the following sections.

.NET Framework

Microsoft .NET Framework version 2.0.50727 is installed with FactoryTalk View SE and RSLinx Enterprise. If you’ve installed those products on the computer where you are installing Microsoft SQL Server 2005 Express, you will already have the correct version of the .NET Framework and don’t need to install it again. However, you will still need to confirm that you have the other prerequisite software.

If you have not installed those products, check to ensure you have .NET Framework version 2.0.50727. If you have .NET Framework 1.2 or any version before 2.0.50727, you must uninstall it (versions 1.0 and 1.1 do not have to be uninstalled) before installing the correct version.

To check which .NET Framework versions are on your computer:
1. Go to C:\Windows\Microsoft.NET\Framework.
2. Check the versions of the .NET folders. There might be one or more folders.

To install .NET Framework 2.0.50727:
1. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the DotNet20 folder, and then double-click dotnetfx.exe.
2. Follow the on-screen instructions.

MDAC 2.8

There is no easy way to check for this software component, so if you’re not sure if you have it, install it now.

To install MDAC 2.8:
1. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the MDAC28 folder, and then double-click MDAC_TYP.EXE.
2. Follow the instructions on the screen.
MSXML6

To check if you have MSXML6:

1. From the Start menu, select Control Panel, and then double-click Add or Remove Programs.

2. Check to see if MSXML6 is included in the list. If it is not, install it.

To install MSXML6:

1. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the MSXML6 folder, and then double-click msxml6.msi.

2. Follow the on-screen instructions.

Windows Installer 3.1

To check if you have Windows Installer 3.1:

1. From the Start menu, select Control Panel, and then double-click Add or Remove Programs.

2. Check to see if Windows Installer 3.1 is included in the list. If it is not, install it.

To install Windows Installer 3.1:

1. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the WindowsInstaller31 folder, and then double-click WindowsInstaller--KB893803-v2-x86.exe.

2. Follow the on-screen instructions.

Step 3: Run the SQL Server Install batch file (not the .exe)

The batch file installs Microsoft SQL Server 2005 Express, Service Pack 2 on your computer with the correct settings for logging alarms and events. The batch file will configure the following settings for SQL Server:

- Mixed-Mode authentication
  
  Microsoft documentation recommends using the Windows Authentication Mode. However, this requires a domain controller to provide centralized authentication for remote database access. To allow remote access without a domain, Mixed Mode must be used because it supports both Windows Authentication and SQL Server Authentication. You’ll need to provide a password for the system administration (sa) account.

- allow remote connections to the database using the TCP/IP protocol

- enable SQL Server Browser
To install Microsoft SQL Server 2005 Express:

1. Close any programs that are open.

2. At the root of the FactoryTalk View SE or RSLinx Enterprise CD, open the Redist folder, open the SQLServer2005 folder, and then double-click SQL Server Install.bat.

3. Review the End User License Agreement, select the check box to accept it, and then click Next.

4. In the Installing Prerequisites window, click Install, and then click Next on subsequent windows.

   If the system configuration check identifies any missing software components, installation will fail, and the missing components will be listed in the System Configuration window. For your convenience, the installation packages for Windows Installer 3.1, MDAC 2.8, and MSXML 6.0 are included in the Redist folder at the root of the FactoryTalk View SE and RSLinx Enterprise CDs. If other missing components are listed, download them from the Microsoft web site.

5. In the Registration Information window, enter the required information, and then click Next. Leave the Hide advanced configuration options check box selected.

6. In the Feature Selection window, don’t change anything, just click Next.
7. In the **Authentication Mode** window, leave the authentication mode set to **Mixed Mode**, type a strong password for the system administrator account, and then click **Next**.

![Authentication Mode window](image)

**IMPORTANT** Be sure to remember the password, because you'll need it to create the database objects for the FactoryTalk Alarm and Event Historian. You will also need it to log on to Microsoft SQL Server 2005 Express Edition if you need to perform any administrative functions (for example, create accounts, add other non-FactoryTalk Alarm and Event Historian databases).

8. In the Configuration Options window, leave the check boxes as is, and then click **Next**.

9. In the **Error and Usage Report Settings** window, leave the check boxes unselected, and then click **Next**.

10. In the **Ready to Install** window, click **Install**.

11. Wait several moments for the components to finish installing, and then click **Next**.

12. In the **Completing Microsoft SQL Server 2005 Express Setup** window, click **Finish**.
Step 4: Install Microsoft SQL Server Management Studio Express

Use Microsoft SQL Server Management Studio Express to perform management operations on the alarms and events database, such as adding or removing users.

To install Microsoft SQL Server Management Studio Express:

1. Close any programs that are open.
2. At the root of the FactoryTalk View Site Edition or RSLinx Enterprise CD, open the Redist folder, open the SQLServer2005 folder, and then double-click SQLServer2005_SSMSEE.msi.
3. In the Welcome window, click Next.
4. Review the End User License Agreement, select the option to accept it, and then click Next.
5. In the Registration Information window, enter the required information, and then click Next.
6. In the Feature Selection window, click Next.
7. Click Install to begin the installation.
8. When the installation is finished, click Finish to close the window.

Error message

During the installation of Microsoft SQL Server Management Studio Express or while the program is running, the following error message might appear:

The file C:\WINDOWS\Microsoft.NET\Framework\mscorlib.tlb could not be loaded. An attempt to repair this condition failed because the file could not be found.

If you see this error message, there is a problem with a registry key. To correct the problem, follow the instructions at the Microsoft web site:

http://support.microsoft.com/?kbid=918685.
Step 5: Configure the Windows firewall

If you want to allow remote connections to the SQL Server 2005 Express database, the database engine service and the SQL Server Browser service must be added to the Windows Firewall Exception List. Set this up if you:

- have remote clients (for example, a log viewer) that needs access to the database
- want to configure the database remotely

To configure the Windows firewall:

1. Click **Start**, click **Control Panel**, and then double-click **Windows Firewall**.
2. On the **Exceptions** tab, SQL Server (sqlservr.exe) might be listed in the Programs and Services box, but not selected as an exception. If you select the check box, Windows will open port 1433 to allow TCP requests. Alternatively, if you do not see SQL Server listed:
   - Click the **Add Program** button.
   - Click the **Browse** button.
   - Open the folder at `drive:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\BINN`.
   - Select **sqlservr.exe**, and then click **Open**.
   - In the **Add Program** dialog box, click **OK**.  
     **Sqlservr.exe** is displayed in the list with a check mark beside it.
3. To add the SQL Server Browser service to the exception list:
   - Click the **Add Program** button.
   - Click the **Browse** button.
   - Open the folder at `drive:\Program Files\Microsoft SQL Server\90\Shared`.
   - Select **sqlbrowser.exe**, and then click **Open**.
   - In the **Add Program** dialog box, click **OK**.  
     **Sqlbrowser.exe** is displayed in the list with a check mark beside it.
4. To accept the changes and close the **Windows Firewall** dialog box, click **OK**.
Use an existing Microsoft SQL Server database

FactoryTalk Alarms and Events uses Microsoft SQL Server as the database engine for logging alarm and event information. You can connect to an existing SQL Server database, or you can install Microsoft SQL Server 2005 Express, Service Pack 2, which is included in the Redist folder on the FactoryTalk View Site Edition and RSLinx Enterprise CDs. For more information, see Appendix D, “Install Microsoft SQL Server 2005 Express”.

You must set up the correct settings for logging alarm and event data if you are using an existing Microsoft SQL Server database. For more information on the settings, see “Summary of steps”.

Supported SQL Server databases

FactoryTalk Alarms and Events can use any of the following SQL Server databases:

- Microsoft SQL Server 2005 Express, Service Pack 2
- Microsoft SQL Server 2005
- Microsoft SQL Server 2000, Service Pack 4

Remote connections to the SQL Server database

To allow remote connections to the database you must configure the TCP/IP protocol, the SQL Server Browser, and the Windows Firewall. Set this up if you:

- have remote clients (for example, a log viewer) that needs access to the database
- want to configure the database remotely

Summary of steps

- Step 1: Install Microsoft SQL Server Management Tools
- Step 2: Specify Mixed Mode authentication for the SQL Server database
- Step 3: Configure TCP/IP protocol for the database
- Step 4: Enable the SQL Server Browser service
- Step 5: Configure the Windows Firewall
Step 1: Install Microsoft SQL Server Management Tools

To add the SQL Server 2005 Management Tools to an existing instance of SQL Server 2005, follow these steps:

1. Close any open programs.
2. In Control Panel, open Add or Remove Programs.
3. Under Currently installed programs, select Microsoft SQL Server 2005, and then click Change.
4. On the Component Selection page, click To install a new component, click here.
5. Type the location of the Setup.exe file on the SQL Server 2005 installation media, and then click OK to open the Microsoft SQL Server Installation Wizard.
6. On the Welcome page, click Next, wait for the System Configuration Check to complete, and then click Next.
7. Review the End User License Agreement, select the option to accept it, and then click Next.
8. On the Registration Information page, click Next.
9. On the Components to Install page, click Workstation components, Books Online and development tools.
   - To install all the Client Component features, click Next.
   - To select specific features (Management Tools are required), click Advanced, and then click Next.
10. Click **Install** to begin the installation.

11. When the installation is finished, click **Finish** to close the window.

12. If you are prompted to restart your computer, click **Yes**.

**Step 2: Specify Mixed Mode authentication for the SQL Server database**

To change the authentication mode and configure the “sa” login, perform the following steps:

1. Click **Start**, point to **All Programs > Microsoft SQL Server 2005** and then click **SQL Server Management Studio**.

2. In Object Explorer, right-click the server node, and then click **Properties**.

3. On the Security page, under Server authentication, select **SQL Server and Windows Authentication mode**, and then click **OK**.

4. To acknowledge the need to restart SQL Server, click **OK** in the **SQL Server Management Studio** dialog box.

5. In Object Explorer, expand Security, expand Logins, right-click **sa**, and then click **Properties**.

6. On the General page, you may have to create and confirm a password for the “sa” login.

7. On the Status page, under **Login**, click **Enabled**, and then click **OK**.

8. Restart the server if you changed the authentication mode. In Object Explorer, right-click the server node, and then click **Restart**.
Step 3: Configure TCP/IP protocol for the database

To configure TCP/IP protocol, complete the following steps:

1. Click Start, point to All Programs > Microsoft SQL Server 2005 > Configuration Tools and then click SQL Server Surface Area Configuration.

2. On the SQL Server 2005 Surface Area Configuration page, click Surface Area Configuration for Services and Connections.

3. On the Surface Area Configuration for Services and Connections page, expand Database Engine, click Remote Connections, click Local and remote connections, click Using TCP/IP protocol only, and then click Apply.

4. To close the message regarding restarting the database engine, click OK.

5. To restart the database engine, click Service, and then click Stop. Wait until the service stops, and then click Start.

Step 4: Enable the SQL Server Browser service

To enable the SQL Server Browser, service complete the following steps:

1. Click Start, point to All Programs > Microsoft SQL Server 2005 > Configuration Tools and then click SQL Server Surface Area Configuration.

2. Click Surface Area Configuration for Services and Connections.

3. Click SQL Server Browser, click Automatic for Startup type, and then click Apply.

4. Click Start, and then click OK.
Step 5: Configure the Windows Firewall

To configure the Windows Firewall, perform the following steps:

1. Click Start, point to Control Panel, and then double-click Windows Firewall.

2. On the Exceptions tab, SQL Server (sqlservr.exe) might be listed in the Programs and Services box, but not selected as an exception. If you select the check box, Windows will open port 1433 to allow TCP requests. Alternatively, if you do not see SQL Server listed:
   - Click the Add Program button.
   - Click the Browse button.
   - Open the folder at drive:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\BINN.
   - Select sqlservr.exe, and then click Open.
   - In the Add Program dialog box, click OK.
     Sqlservr.exe is displayed in the list with a check mark beside it.

3. To add the SQL Server Browser service to the exception list:
   - Click the Add Program button.
   - Click the Browse button.
   - Open the folder at drive:\Program Files\Microsoft SQL Server\90\Shared.
   - Select sqlbrowser.exe, and then click Open.
   - In the Add Program dialog box, click OK.
     Sqlbrowser.exe is displayed in the list with a check mark beside it.

4. To accept the changes and close the Windows Firewall dialog box, click OK.
Alarm time stamping

FactoryTalk Alarms and Events provides significantly improved time-stamp accuracy over traditional alarm monitoring systems, you can obtain better time-stamp resolution in some cases by using time stamps directly retrieved from peripheral devices like I/O cards or other time-stamping hardware.

When an analog (ALMA) or digital (ALMD) alarm instruction executes when an alarm event occurs, the current Universal Coordinated Time (UTC) value of the controller’s wall clock is captured and delivered to the FactoryTalk Alarms and Events system with the alarm.

This appendix shows how to replace the controller’s wall clock time in an alarm event with a time stamp from an external source.

You can take events from an I/O card like a 1756-IB16ISOE and use the 50 microsecond accuracy from the card’s time stamp when delivering an alarm to the rest of the alarm monitoring system.

Some of the things you must resolve when you replace the normal time stamp provided with the alarm instructions are:

- Alarm time stamps must be in UTC with no time zone or daylight savings time offset included (these offsets are automatically added to the time stamp when it is displayed).

- The alarm time stamp is usually represented as a long integer (LINT) data type, occupying one 64-bit word. Most I/O cards stamp time using two double integers (DINT), occupying two 32-bit words.

Overview of Logix clocks

In the Logix environment, time is represented in three different ways—Local Time, Coordinated System Time, and Universal Coordinated Time.

Coordinated System Time (CST)

Coordinated System Time is provided by a free-running backplane clock that starts counting the first time the system is powered up. CST is used for time stamping, event tracking between processors and I/O cards, as well as for motion planning among multiple motion modules. CST has no relevance to real-world time, but can be converted to Coordinated Universal Time (UTC) using an offset. CST time stamps must be converted to UTC before passing them to the alarm monitoring system.
Coordinated Universal Time (UTC)

Coordinated Universal Time is a real-world time relative to a time constant, but with no time zone information and no daylight savings time offsets. It is the raw value used to represent time and also the value required for time stamps in the FactoryTalk Alarms and Events system. UTC is equivalent to Greenwich Mean Time, with no daylight savings time offsets.

Advantage of using UTC for time stamps is that distributed events can be compared, regardless of their geographical location or where they are, relative to Daylight Savings Time (DST). The software reading the time stamp can then convert UTC time stamps to local time. Logix 5000 and FactoryTalk Alarms and Events graphic objects convert UTC time stamps to the local time of the workstation running the software application.

Time stamps from different sources may or may not be returned in UTC format, depending on the device generating the time stamp and how it is configured. For example, a 1756-IB16ISOE module can return time in UTC if configured to do so.

In the Logix system, time is often returned as two 32-bit DINT data types instead of one 64-bit LINT data type. The FactoryTalk Alarms and Events system requires the time stamps to use the LINT data type. If a module (for example, the 1756-IB16ISOE module) returns the time stamp in two DINTs instead of a LINT, you will have to convert the time format into a LINT. To perform this conversion, an Add-On Instruction is available for download from the Logix sample code website in the Rockwell Automation Sample Code Library at [http://samplecode.rockwellautomation.com/](http://samplecode.rockwellautomation.com/). On the search page, in the Family list, select Programmable Controllers, and then in the Technologies & Functionalities list, select Add On Instruction. Download the item called Math and Compare operations with 64-bit Long Integer Tags LINT Data Type in RSLogix5000 ver 16.

Local Time (Wall Clock Time)

Local time (often referred to as Wall Clock Time) is the time in the real world where the controller is located. This means that Wall Clock time is UTC, but with time zone and Daylight Savings Time (DST) offsets added.

Local Time is typically used to trigger local events (like turning on a pump at 1:00AM during shift change). Local time values must be converted to UTC before passing them to an alarm monitoring system.
You can see the calculated result in RSLogix 5000, in the **Controller Properties** dialog box, on the **Date/Time** tab, as shown in the following illustration.

![Controller Properties](image)

We recommend using local time only to drive events from the controller, and not to time-stamp alarms.
FactoryTalk Alarms and Events: features for alarm monitoring

**ALMD and ALMA alarm blocks**

When the controller detects a condition that causes an In Alarm event, the controller stores the current UTC value in the backing tag for the alarm.

1. The alarm is provided by ladder logic that includes the ALMD or ALMA instructions:

   ![ALMD and ALMA alarm blocks diagram](image)

   **Valve 1**

   **Steam Pressure Sensor 1**

2. When you click the Browse button to edit the alarm instruction, on the **Configuration** tab, you can specify the alarm message.

   ![ALMD Properties - Valve1 Open (Run 10)](image)

   **Message:** Valve 1 has Opened
3. On the **Status** tab, time stamps appear when the alarm is triggered, acknowledged, returns to normal, or when the alarm count is reset.

4. On the **Parameters** tab, these UTC time stamps are automatically transferred to tags that you can then use in logic of your own.

For details about adding an Alarm and Event Summary object to a graphic display in FactoryTalk View, see Chapter 7, “Set up graphic displays” or see the FactoryTalk View Site Edition Help.
Inserting time stamps manually

To insert a time stamp manually, you must enter the new time under the .ProgTime element and set the boolean .UseProgTime in the backing tag for the alarm **before** the actual alarm instruction is triggered.

Example
Time synchronization

FactoryTalk Alarms and Events provides excellent resolution and accuracy for alarms and events time stamps. You can build a very accurate time sequence for events that led to a failure, or simply to diagnose the exact order of their occurrence. Because the alarms are generated by the controller, the time-stamp accuracy is a function of the rate of the controller’s ability to scan the alarm instruction, plus the accuracy of the controller’s wall clock.

When an alarm instruction is evaluated in code and an alarm transition event occurs (goes into alarm, or is acknowledged, suppressed, and so on), the instruction immediately records the current value of the controller’s wall clock. This 64-bit, microsecond-resolution number reflects the time of the event relative to the controller’s wall clock in UTC time (no time zone or daylight savings information is included). When you view this time stamp, either in RSLogix 5000 or in FactoryTalk View Site Edition, the time zone of the computer running the software is used to visualize the time value. You can use a distributed system that covers multiple time zones to display a valid sequence of events at an operator or maintenance station independently of the time zone the time stamps are captured in.

Coordinating multiple controllers’ wall clocks

Because alarm events can originate in multiple controllers distributed over an enterprise, it is important to provide a common time reference to set these clocks. A controller with a wall clock that is out of synchronization with the rest of the enterprise, will potentially log events out of the time sequence in which they actually occurred, relative to the other controllers.

Setting the controllers’ wall clocks individually by hand is inefficient. Additionally, clock drift naturally causes these clocks to record time further and further apart from each other. There are several automated methods to manage the wall clocks on multiple controllers, the easiest and most cost-effective of which is the Logix5000 Clock Update Tool.

The Logix5000 Clock Update Tool lets you view and synchronize the system time of the controllers and devices on a network, using any computer running Microsoft Windows and RSLinx Classic. You can also schedule automatic synchronization of all devices. See “Create a synchronization schedule” on page 206.

The accuracy of time synchronization varies based on many factors, including the network path and what the controller is doing when the time synchronization takes place. Typical systems using the Logix5000 Clock Update Tool coordinate clocks to around 300ms. If you need greater accuracy for clock synchronization than the Logix5000 Clock Update Tool can provide, there are several other hardware-based options to improve the accuracy of time stamps in the control system. These include IRIGB, NTP, GPS, and IEEE 1588 Ethernet.
Install the Logix5000 Clock Update Tool

This stand-alone tool is included on the RSLogix 5000 v. 16 CD. Using RSLinx to browse to multiple controllers, this tool synchronizes multiple wall clocks at a user-defined rate in a variety of controllers, including PLC-5, SLC 500s, MicroLogix, and all Logix5000 controllers (except the SoftLogix controller which typically obtains the time from the clock in the computer where the controller is installed).

1. On the RSLogix 5000 v. 16 CD, open the Tools folder and then double-click Setup.exe. You can also install this tool when installing RSLogix 5000.

2. Follow the instructions on the screen to install the Logix5000 Clock Update Tool.

Start the Logix5000 Clock Update Tool

- Click Start, point to All Programs > Rockwell Software > RSLogix 5000 Tools > Logix5000 Clock Update Tool and then click Logix5000 Clock Update Tool.

Starting the Update Tool automatically

You can start the Logix5000 Clock Update Tool automatically when you start Windows.

- In the Logix5000 Clock Update Tool, on the File menu, click Start the application when Windows starts.

The next time you restart Windows, the Clock Update Tool opens automatically.
Using the Logix5000 Clock Update Tool

The Logix5000 Clock Update Tool lets you view and synchronize the system time of the controllers and devices on a network, using any computer running Microsoft Windows and RSLinx Classic. You can also schedule automatic synchronization of all devices.

The left pane of the Clock Update Tool window contains a tree view, with these items:

- **Scheduled Synchronizations** lists synchronization schedules that have been configured. Right-click an individual schedule for more options.
- **Devices** lists devices that have been configured. Right-click an individual device for more options.
- **Log** contains a log of the most recent events. The path indicated under the list of events contains the location of the complete log file for the day.

Summary of steps

To synchronize devices on a schedule, complete these steps:

1. Create a synchronization schedule. This schedule determines when synchronization takes place.

2. Create a list of devices you want to synchronize and then add them to synchronization schedules. Devices that are not included in this list are not synchronized.

3. Optionally, match existing devices with existing synchronization schedules. Skip this step if you specified a synchronization schedule when you added the device. Devices that are not matched to any synchronization schedule are not synchronized.

This chapter includes information about each of these steps.
Create a synchronization schedule

A synchronization schedule determines when devices are synchronized. For example, you can schedule devices to be synchronized on a fixed time interval. You can also configure a synchronization schedule to expire on a particular date.

To create a synchronization schedule:

1. In the Logix5000 Clock Update Tool, in the left pane, click **Scheduled Synchronizations**.
2. Right-click the right pane and then click **Add Event**.
3. In the **Update Date and Time Interval** dialog box, set up a schedule for synchronizing the date and time, and then click **OK**.

![Update Date and Time Interval dialog box](image1)

The new schedule information appears, as shown in the following example:

![Scheduled Synchronization](image2)
Remove a synchronization schedule

To remove a synchronization schedule from the list, right-click the synchronization schedule you want to remove and then click **Remove Event**.

Any devices that are associated with this synchronization schedule now belong to no schedule.

Modify a synchronization schedule

1. To modify an existing synchronization schedule, right-click the synchronization schedule and then click **Modify Event**.

2. In the **Update Date and Time Interval** dialog box, modify the schedule information, and then click **OK**.

Enable or disable a synchronization schedule

Occasionally, you might want to temporarily disable a synchronization schedule, rather than permanently delete it.

**To disable a synchronization schedule:**

Right-click the synchronization schedule you want to disable and then click **Disable Event** on the context menu.

**To enable a disabled synchronization schedule:**

Right-click the disabled synchronization schedule you want to enable and then click **Enable Event** on the context menu.
Add devices

After creating one or more synchronization schedules, add the devices you want to include in the schedules.

When you add a device, you can also match it to a synchronization schedule, or you can add all of the devices first and then match them to synchronization schedules later. If you add the devices later, you can add all of the devices to a single synchronization schedule in one step.

You can add a device to only one synchronization schedule.

To add a device:

1. In the Logix5000 Clock Update Tool, in the left pane, click Devices.

2. Right-click the right pane and then click Add New Device or click the Add Device button, shown at left.

3. In the RSLinx dialog box, browse to the device you want to add, select it, and then click OK.

   **TIP**

   You cannot click OK unless you have selected a device that is capable of being synchronized and has not already been configured.
4. In the Add Device to Schedule list, select the synchronization schedule to which you want to add the device, and then click OK.

The device is added to the list. Because this device has not yet been synchronized, question marks (?????) appear in the Last Update column:

Remove a device

- To remove a device from the list, right-click the device you want to remove, and then click Remove Device, or click the Remove Device button, shown at left. If the device is associated with a particular synchronization schedule, it is removed from that schedule.

- If you want to remove all devices from the list, right-click in the Device pane and then click Remove All Devices. All devices are removed from the list, as well as from their respective synchronization schedules.

View details about a device

To view the details of a particular device, right-click the device and then click Device Properties. This shows major and minor firmware revision information, the
computer’s time, the device’s time, the device’s response time, and the time difference between the computer and the device.

**Assign devices to synchronization schedules**

When a synchronization schedule is selected in the left pane, the Device pane lists all of the devices that are configured.

When you add a new device, you can assign it to a specific schedule at that time. See “Add devices” on page 208.

- To add a device to this selected synchronization schedule, select the check box to the left of the device. To remove the device from the synchronization schedule, clear the check box beside the device.
- To add all devices to the specified schedule, select the **Select All** check box at the bottom of the list.
Synchronize devices manually

In addition to scheduling automatic synchronization, you can synchronize devices manually.

Right-click a device and then click Synchronize Device or right-click anywhere in the Device pane and then click Synchronize All Devices (or click the Synchronize All Devices button on the toolbar).

Any errors in synchronization are saved to the log file. In addition, an icon appears in the device list and in the main tree view to indicate the error. The log file indicates a specific cause for the error, where one is known.

View the log file

To view a log of the most recent events, click Log in the left pane. The path shown under the list of events contains the location of the complete log file for the day. The log file is saved in .txt and .xml format.

Change the location of the log file

The default location for the synchronization log file is C:\Program Files\Rockwell Software\RSLogix 5000 Tools\Logix5000 Clock Update Tool.

To change the location of the log file:

1. On the Log menu, click Change Log File Location (or click the Browse button—shown at left—to the right of the Path box at the bottom of the Update Tool window).
2. In the **Browse for Folder** dialog box, select the new folder for the log files, and then click **OK**. To create a new folder for the log file, click **Make New Folder**.

![Browse for Folder dialog box](image.png)

**Time stamps with tag-based alarms**

If your FactoryTalk Alarms and Events system includes tag-based alarm servers, the time stamps for those alarms come from the computer that is hosting the server that is providing tags to the alarm server (for example, RSLinx Enterprise or a third-party Data Server). To ensure that alarms are ordered properly by time, you must synchronize the computer’s clock with the controllers’ clocks.

The simplest way to solve this synchronization problem is to run the Logix5000 Clock Update Tool on the same computer as the RSLinx Enterprise alarm server. This ensures that the controller clocks all synchronize with the computer’s tag-based alarm server. Typical systems using this method commonly achieve 300ms synchronization.

If it is not possible to install the Logix5000 Clock Update Tool on the same computer that is hosting the data server that is providing tags for the tag-based alarm server, try to synchronize the computer’s clock with the same NTP server that is used to synchronize the control network, with similar network latencies.

For details about tag-based alarms, see Chapter 6, “Add a tag-based alarm server for Logix5000, PLC-5, SLC 500, or third-party controllers”.
Supported devices

The Logix5000 Clock Update Tool supports the following controller families:

- ControlLogix
- CompactLogix
  - All CompactLogix processors can be used with ENI. CompactLogix L32E and CompactLogix L35E can be directly connected via Ethernet or with ENI.
  - Make sure that the CompactLogix port is set up for DF1 Full-duplex.
  - Make sure the routing is enabled on NET-ENI (check box). Net-ENI works with Ethernet devices drivers and not with EtherNet/IP drivers.
- DriveLogix
- FlexLogix
- PLC-5
- SLC
- MicroLogix
- PowerMonitor
Reference for building a distributed system

This book focuses on building an alarms and events system on a single computer.

When building a distributed system on multiple computers on the network, bear the following guidelines in mind.

Installing FactoryTalk Alarms & Events software

FactoryTalk Alarms and Events software is installed with FactoryTalk View and RSLinx Enterprise software. There is no need to install FactoryTalk Alarms and Events software separately unless you have installed FactoryTalk Services Platform on a computer where you have not installed FactoryTalk View or RSLinx Enterprise.

For details, see “Install FactoryTalk Alarms and Events manually” on page 179.

Typical distributed system on a network

In the sample distributed automation system shown on the next page, FactoryTalk Services Platform software is installed on every computer in the network.

The diagram on the next page shows just one example of a possible network layout for a group of computers and software products participating in FactoryTalk Alarms and Events using a FactoryTalk Network Directory. Use this diagram only as a starting point; your own distributed system will vary.
Typical distributed system on a network

**Development station**
- FactoryTalk Services Platform
- FactoryTalk Administration Console
- FactoryTalk Activation Client
- FactoryTalk Alarms and Events
- FactoryTalk View Studio
- FactoryTalk View SE Client
- RSLinx Classic
- RSLinx Enterprise
- RSLogix 5
- RSLogix 5000

**Operator stations**
- FactoryTalk Services Platform
- FactoryTalk Activation Client
- FactoryTalk Alarms and Events
- FactoryTalk View SE Client

**Network Directory Server**
- FactoryTalk Services Platform
- FactoryTalk Activation Server
- FactoryTalk Alarms and Events

**Databases and historical logs**
- Microsoft SQL Server 2005 Express

**Data, alarm and event, and HMI servers**
- FactoryTalk Services Platform
- FactoryTalk Activation Server
- FactoryTalk Alarms and Events
- FactoryTalk View SE Server
- RSLinx Enterprise

**PLC-5 controllers**

**Logix5000 controllers**
Language identifiers for language switching

With the FactoryTalk View language switching feature, run-time operators can view the text strings defined in an application in up to 40 different languages. FactoryTalk View SE Clients can run in any of the languages an application supports. In a network application, multiple clients can run in different languages at the same time.

The languages in the following table are supported for language switching by the application at run time. Be sure that these Windows languages are installed on the development and client computers before trying to switch languages.

To find out which languages are installed on a computer, check the Regional Options (Windows 2000) or Regional and Language Options (Windows XP and Windows 2003 Server). The language in the list that has a check mark beside it is the default language.

The column heading in an Excel spreadsheet identifies the language for the text strings in that column. For example, the language identifier for English (United States) is en-US. To add alarm messages in multiple languages to an Excel spreadsheet for a FactoryTalk Tag Alarm and Event Server, use the language identifiers in the ID column. For more information, see “Enter alarm messages in Excel”.

Language identifiers

The following table lists the language identifiers:

<table>
<thead>
<tr>
<th>Language</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans (South Africa)</td>
<td>af-ZA</td>
</tr>
<tr>
<td>Albanian (Albania)</td>
<td>sq-AL</td>
</tr>
<tr>
<td>Arabic (Algeria)</td>
<td>ar-DZ</td>
</tr>
<tr>
<td>Arabic (Bahrain)</td>
<td>ar-BH</td>
</tr>
<tr>
<td>Arabic (Egypt)</td>
<td>ar-EG</td>
</tr>
<tr>
<td>Arabic (Iraq)</td>
<td>ar-IQ</td>
</tr>
<tr>
<td>Arabic (Jordan)</td>
<td>ar-JO</td>
</tr>
<tr>
<td>Arabic (Kuwait)</td>
<td>ar-KW</td>
</tr>
<tr>
<td>Arabic (Lebanon)</td>
<td>ar-LB</td>
</tr>
<tr>
<td>Arabic (Libya)</td>
<td>ar-LY</td>
</tr>
<tr>
<td>Arabic (Morocco)</td>
<td>ar-MA</td>
</tr>
<tr>
<td>Arabic (Oman)</td>
<td>ar-OM</td>
</tr>
<tr>
<td>Language</td>
<td>ID</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Arabic (Qatar)</td>
<td>ar-QA</td>
</tr>
<tr>
<td>Arabic (Saudi Arabia)</td>
<td>ar-SA</td>
</tr>
<tr>
<td>Arabic (Syria)</td>
<td>ar-SY</td>
</tr>
<tr>
<td>Arabic (Tunisia)</td>
<td>ar-TN</td>
</tr>
<tr>
<td>Arabic (U.A.E.)</td>
<td>ar-AE</td>
</tr>
<tr>
<td>Arabic (Yemen)</td>
<td>ar-YE</td>
</tr>
<tr>
<td>Armenian (Armenia)</td>
<td>hy-AM</td>
</tr>
<tr>
<td>Azeri (Cyrillic)</td>
<td>az-Cyrl-AZ</td>
</tr>
<tr>
<td>Azeri (Latin)</td>
<td>az-Latn-AZ</td>
</tr>
<tr>
<td>Basque</td>
<td>eu-ES</td>
</tr>
<tr>
<td>Belarusian</td>
<td>be-BY</td>
</tr>
<tr>
<td>Bosnian (Cyrillic, Bosnia and Herzegovina)</td>
<td>bs-Cyrl-BA</td>
</tr>
<tr>
<td>Bosnian (Latin, Bosnia and Herzegovina)</td>
<td>bs-Latn-BA</td>
</tr>
<tr>
<td>Bulgarian</td>
<td>bg-BG</td>
</tr>
<tr>
<td>Catalan</td>
<td>ca-ES</td>
</tr>
<tr>
<td>Chinese (Hong Kong S.A.R.)</td>
<td>zh-HK</td>
</tr>
<tr>
<td>Chinese (Macau S.A.R.)</td>
<td>zh-MO</td>
</tr>
<tr>
<td>Chinese (PRC)</td>
<td>zh-CN</td>
</tr>
<tr>
<td>Chinese (Singapore)</td>
<td>zh-SG</td>
</tr>
<tr>
<td>Chinese (Taiwan)</td>
<td>zh-TW</td>
</tr>
<tr>
<td>Croatian (Croatia)</td>
<td>hr-HR</td>
</tr>
<tr>
<td>Czech (Czech Republic)</td>
<td>cs-CZ</td>
</tr>
<tr>
<td>Danish (Denmark)</td>
<td>da-DK</td>
</tr>
<tr>
<td>Divehi (Maldives)</td>
<td>dv-MV</td>
</tr>
<tr>
<td>Dutch (Belgium)</td>
<td>nl-BE</td>
</tr>
<tr>
<td>Dutch (Netherlands)</td>
<td>nl-NL</td>
</tr>
<tr>
<td>English (Australia)</td>
<td>en-AU</td>
</tr>
<tr>
<td>English (Belize)</td>
<td>en-BZ</td>
</tr>
<tr>
<td>English (Canada)</td>
<td>en-CA</td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td>en-029</td>
</tr>
<tr>
<td>English (Ireland)</td>
<td>en-IE</td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td>en-JM</td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td>en-NZ</td>
</tr>
<tr>
<td>English (Philippines)</td>
<td>en-PH</td>
</tr>
<tr>
<td>Language</td>
<td>ID</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td>en-ZA</td>
</tr>
<tr>
<td>English (Trinidad)</td>
<td>en-TT</td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td>en-GB</td>
</tr>
<tr>
<td>English (United States)</td>
<td>en-US</td>
</tr>
<tr>
<td>English (Zimbabwe)</td>
<td>en-ZW</td>
</tr>
<tr>
<td>Estonian (Estonia)</td>
<td>et-EE</td>
</tr>
<tr>
<td>Faroese (Faroe Islands)</td>
<td>fo-FO</td>
</tr>
<tr>
<td>Farsi</td>
<td>fa-IR</td>
</tr>
<tr>
<td>Filipino (Philippines)</td>
<td>fil-PH</td>
</tr>
<tr>
<td>Finnish (Finland)</td>
<td>fi-FI</td>
</tr>
<tr>
<td>French (Belgium)</td>
<td>fr-BE</td>
</tr>
<tr>
<td>French (Canada)</td>
<td>fr-CA</td>
</tr>
<tr>
<td>French (France)</td>
<td>fr-FR</td>
</tr>
<tr>
<td>French (Luxembourg)</td>
<td>fr-LU</td>
</tr>
<tr>
<td>French (Monaco)</td>
<td>fr-MC</td>
</tr>
<tr>
<td>French (Switzerland)</td>
<td>fr-CH</td>
</tr>
<tr>
<td>Frisian (Netherlands)</td>
<td>fy-NL</td>
</tr>
<tr>
<td>FRYO (Macedonian)</td>
<td>mk-MK</td>
</tr>
<tr>
<td>Galician</td>
<td>gl-ES</td>
</tr>
<tr>
<td>Georgian</td>
<td>ka-GE</td>
</tr>
<tr>
<td>German (Austria)</td>
<td>de-AT</td>
</tr>
<tr>
<td>German (Germany)</td>
<td>de-DE</td>
</tr>
<tr>
<td>German (Liechtenstein)</td>
<td>de-LI</td>
</tr>
<tr>
<td>German (Luxembourg)</td>
<td>de-LU</td>
</tr>
<tr>
<td>German (Switzerland)</td>
<td>de-CH</td>
</tr>
<tr>
<td>Greek (Greece)</td>
<td>el-GR</td>
</tr>
<tr>
<td>Gujarati (India)</td>
<td>gu-IN</td>
</tr>
<tr>
<td>Hebrew (Israel)</td>
<td>he-IL</td>
</tr>
<tr>
<td>Hindi (India)</td>
<td>hi-IN</td>
</tr>
<tr>
<td>Hungarian (Hungary)</td>
<td>hu-HU</td>
</tr>
<tr>
<td>Icelandic (Iceland)</td>
<td>is-IS</td>
</tr>
<tr>
<td>Indonesian (Indonesia)</td>
<td>id-ID</td>
</tr>
<tr>
<td>Inuktitut (Latin, Canada)</td>
<td>iu-Latn-CA</td>
</tr>
<tr>
<td>Irish (Ireland)</td>
<td>ga-IE</td>
</tr>
<tr>
<td>Language</td>
<td>ID</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Italian (Italy)</td>
<td>it-IT</td>
</tr>
<tr>
<td>Italian (Switzerland)</td>
<td>it-CH</td>
</tr>
<tr>
<td>Japanese (Japan)</td>
<td>ja-JP</td>
</tr>
<tr>
<td>Kannada (India)</td>
<td>kn-IN</td>
</tr>
<tr>
<td>Kazakh (Kazakhstan)</td>
<td>kk-KZ</td>
</tr>
<tr>
<td>Konkani (India)</td>
<td>kok-IN</td>
</tr>
<tr>
<td>Korean (Korea)</td>
<td>ko-KR</td>
</tr>
<tr>
<td>Kyrgyz (Cyrillic)</td>
<td>ky-KG</td>
</tr>
<tr>
<td>Latvian (Latvia)</td>
<td>lv-LV</td>
</tr>
<tr>
<td>Lithuanian (Lithuania)</td>
<td>lt-LT</td>
</tr>
<tr>
<td>Luxembourgish (Luxembourg)</td>
<td>lb-LU</td>
</tr>
<tr>
<td>Malay (Brunei Darussalam)</td>
<td>ms-BN</td>
</tr>
<tr>
<td>Malay (Malaysia)</td>
<td>ms-MY</td>
</tr>
<tr>
<td>Maktese</td>
<td>mt-MT</td>
</tr>
<tr>
<td>Maori</td>
<td>mi-NZ</td>
</tr>
<tr>
<td>Mapudungun (Chile)</td>
<td>arn-CL</td>
</tr>
<tr>
<td>Marathi (India)</td>
<td>mr-IN</td>
</tr>
<tr>
<td>Mohawk (Mohawk)</td>
<td>moh-CA</td>
</tr>
<tr>
<td>Mongolian (Cyrillic)</td>
<td>mn-MN</td>
</tr>
<tr>
<td>Norwegian (Bokmal)</td>
<td>nb-NO</td>
</tr>
<tr>
<td>Norwegian (Nynorsk)</td>
<td>nn-NO</td>
</tr>
<tr>
<td>Polish (Poland)</td>
<td>pl-PL</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>pt-BR</td>
</tr>
<tr>
<td>Portuguese (Portugal)</td>
<td>pt-PT</td>
</tr>
<tr>
<td>Punjabi</td>
<td>pa-IN</td>
</tr>
<tr>
<td>Quechua (Bolivia)</td>
<td>quz-BO</td>
</tr>
<tr>
<td>Quechua (Equador)</td>
<td>quz-EC</td>
</tr>
<tr>
<td>Quechua (Peru)</td>
<td>quz-PE</td>
</tr>
<tr>
<td>Romanian (Romania)</td>
<td>ro-RO</td>
</tr>
<tr>
<td>Romansh (Switzerland)</td>
<td>rm-CH</td>
</tr>
<tr>
<td>Russian (Russia)</td>
<td>ru-RU</td>
</tr>
<tr>
<td>Sami, Inari (Finland)</td>
<td>smn-FI</td>
</tr>
<tr>
<td>Sami, Lule (Norway)</td>
<td>smj-NO</td>
</tr>
<tr>
<td>Sami, Lule (Sweden)</td>
<td>smj-SE</td>
</tr>
<tr>
<td>Language</td>
<td>ID</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Sami, Northern (Finland)</td>
<td>se-FI</td>
</tr>
<tr>
<td>Sami, Northern (Norway)</td>
<td>se-NO</td>
</tr>
<tr>
<td>Sami, Northern (Sweden)</td>
<td>se-SE</td>
</tr>
<tr>
<td>Sami, Skolt (Finland)</td>
<td>sms-FI</td>
</tr>
<tr>
<td>Sami, Southern (Norway)</td>
<td>sma-NO</td>
</tr>
<tr>
<td>Sami, Southern (Sweden)</td>
<td>sma-SE</td>
</tr>
<tr>
<td>Sanskrit - India</td>
<td>sa-IN</td>
</tr>
<tr>
<td>Serbian (Cyrillic)</td>
<td>sr-Cyril-CS</td>
</tr>
<tr>
<td>Serbian (Cyrillic, Bosnia and Herzegovina)</td>
<td>sr-Cyril-BA</td>
</tr>
<tr>
<td>Serbian (Latin)</td>
<td>sr-Latin-CS</td>
</tr>
<tr>
<td>Serbian (Latin, Bosnia and Herzegovina)</td>
<td>sr-Latin-BA</td>
</tr>
<tr>
<td>Sesotho sa Leboa (South Africa)</td>
<td>ns-ZA</td>
</tr>
<tr>
<td>Sesothswana (South Africa)</td>
<td>tn-ZA</td>
</tr>
<tr>
<td>Slovak</td>
<td>sk-SK</td>
</tr>
<tr>
<td>Slovenian (Slovenia)</td>
<td>sl-SI</td>
</tr>
<tr>
<td>Spanish (Argentina)</td>
<td>es-AR</td>
</tr>
<tr>
<td>Spanish (Bolivia)</td>
<td>es-BO</td>
</tr>
<tr>
<td>Spanish (Chile)</td>
<td>es-CL</td>
</tr>
<tr>
<td>Spanish (Colombia)</td>
<td>es-CO</td>
</tr>
<tr>
<td>Spanish (Costa Rica)</td>
<td>es-CR</td>
</tr>
<tr>
<td>Spanish (Dominican Republic)</td>
<td>es-DO</td>
</tr>
<tr>
<td>Spanish (Ecuador)</td>
<td>es-EC</td>
</tr>
<tr>
<td>Spanish (El Salvador)</td>
<td>es-SV</td>
</tr>
<tr>
<td>Spanish (Guatemala)</td>
<td>es-GT</td>
</tr>
<tr>
<td>Spanish (Honduras)</td>
<td>es-HN</td>
</tr>
<tr>
<td>Spanish (International Sort)</td>
<td>es-ES</td>
</tr>
<tr>
<td>Spanish (Mexico)</td>
<td>es-MX</td>
</tr>
<tr>
<td>Spanish (Nicaragua)</td>
<td>es-NI</td>
</tr>
<tr>
<td>Spanish (Panama)</td>
<td>es-PA</td>
</tr>
<tr>
<td>Spanish (Paraguay)</td>
<td>es-PY</td>
</tr>
<tr>
<td>Spanish (Peru)</td>
<td>es-PE</td>
</tr>
<tr>
<td>Spanish (Puerto Rico)</td>
<td>es-PR</td>
</tr>
<tr>
<td>Spanish (Traditional Sort)</td>
<td>es-ES_tradnl</td>
</tr>
<tr>
<td>Spanish (Uruguay)</td>
<td>es-UY</td>
</tr>
<tr>
<td>Language</td>
<td>ID</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Spanish (Venezuela)</td>
<td>es-VE</td>
</tr>
<tr>
<td>Swahili (Kenya)</td>
<td>sw-KE</td>
</tr>
<tr>
<td>Swedish (Finland)</td>
<td>sv-FI</td>
</tr>
<tr>
<td>Swedish</td>
<td>sv-SE</td>
</tr>
<tr>
<td>Syriac (Syria)</td>
<td>syr-SY</td>
</tr>
<tr>
<td>Tamil (India)</td>
<td>ta-IN</td>
</tr>
<tr>
<td>Tatar (Russia)</td>
<td>tt-RU</td>
</tr>
<tr>
<td>Telugu (India)</td>
<td>te-IN</td>
</tr>
<tr>
<td>Thai (Thailand)</td>
<td>th-TH</td>
</tr>
<tr>
<td>Turkish (Turkey)</td>
<td>tr-TR</td>
</tr>
<tr>
<td>Ukrainian (Ukraine)</td>
<td>uk-UA</td>
</tr>
<tr>
<td>Urdu (Pakistan)</td>
<td>ur-PK</td>
</tr>
<tr>
<td>Uzbek (Cyrillic)</td>
<td>uz-Cyrl-UZ</td>
</tr>
<tr>
<td>Uzbek (Latin)</td>
<td>uz-Latn-UZ</td>
</tr>
<tr>
<td>Vietnamese (Vietnam)</td>
<td>vi-VN</td>
</tr>
<tr>
<td>Welsh</td>
<td>cy-GB</td>
</tr>
<tr>
<td>Xhosa</td>
<td>xh-ZA</td>
</tr>
<tr>
<td>Zula</td>
<td>zu-ZA</td>
</tr>
</tbody>
</table>

For more information, see “Enter alarm messages in Excel”.
Symbols

appears at run time in graphic displays 152
.csv files
do not support Unicode in RSLogix 5000 141
.NET Framework
installing 185
.txt files
using with Unicode character sets for language switching in RSLogix 5000 141
.xls files
exporting alarm messages from Tag Alarm and Event Servers 147
.xml files
exporting alarm messages from Tag Alarm and Event Servers 147

A
about
acknowledging alarms 104
Alarm and Event Banner 11
Alarm and Event Historian 10
Alarm and Event Log Viewer 10, 11
Alarm and Event Summary 11, 73
Alarm Status Explorer 11, 73
Coordinated System Time 197
Coordinated Universal Time 198
data displayed at run time 6
database definitions 11
device-based alarm monitoring 5, 9, 13
distributed applications 215
FactoryTalk Alarms and Events 5
FactoryTalk Audit Log 10, 11
FactoryTalk Diagnostics 10
FactoryTalk Diagnostics Viewer 11
graphic displays 69
HMI Tag Alarm Monitoring 11
language switching 139
Local applications 15, 45, 59
monitoring for alarm conditions 11
Network applications 15
OPC Data Servers 6
planning your system 15
process data 6
security for alarms and events 6
setting up FactoryTalk Alarms and Events 10
software-based tag servers 5
Tag Alarm and Event Servers 57
tag-based alarm monitoring 5, 10, 11, 16, 43
time stamps for alarms 6
warning icons 49, 63
acknowledgement required
setting in RSLogix 5000 40
acknowledging alarms 104
all in event list 106
all on page 106
with comment 105
activations
planning 18
Alarm and Event Banner
about 11
adding to graphic displays 75, 76
definition of 11
number of alarms displayed 78
opening Alarm and Event Summary from 78
run-time columns in 103
setting up 78
silencing alarms 73
uses for 14
Alarm and Event Historian
See also Alarm and Event Log
about 10
Alarm and Event Log
See also Alarm and Event Historian
language switching 139
Alarm and Event Log Viewer 113
about 10, 11
adding to graphic displays 122
definition of 11
showing or hiding areas 124
specifying database 124
uses for 14
Alarm and Event Summary
about 11, 73
adding to graphic displays 73, 156
definition of 11
uses for 14
alarm blocks
configuring properties in RSLogix 5000 40
overview 200
alarm buffering
device-based 21
tag-based 119
alarm expressions 84
alarm history. See historical logging
alarm instructions
adding to rung in RSLogix 5000 27
built into RSLogix5000 controllers 5
alarm messages
advantages of using Excel to edit 157
creating in FactoryTalk View Studio 147
default location for exported 162
editing exported in Notepad 141, 146
editing in Alarm and Event Setup editor 147
editing in alternate languages 157
editing in Microsoft Excel 157, 162
embedded variables in RSLogix 5000 40
exporting to Microsoft Excel 160
importing into RSLogix 5000 143, 146
importing into Tag Alarm and Event Servers 164
language switching 139
maximum length 29, 157, 163
tag-based alarm monitoring 147
testing at run time 170
uploaded to controllers by RSLinx Enterprise 139
alarm monitoring
about device-based 5, 13
about HMI Tag Alarm Monitoring 11
about tag-based 5, 11, 16, 43
adding Tag Alarm and Event Servers 64
choosing between tag- and device-based 16, 43
comparison of methods 13
how device-based works 13
how HMI Tag Alarm Monitoring works 11
how tag-based works 11
uses for device-based 14
uses for tag-based 14
Alarm Status Explorer
about 11, 73
definition of 11
enabling alarms 109
opening 109
uses for 14, 108
alarm system tags
in FactoryTalk View 14
alarms and events
See also alarm monitoring
See also alarms and events
See also FactoryTalk Alarms and Events
about acknowledging 104
about monitoring for 11
acknowledging all in event list 106
acknowledging all on page 106
acknowledging selected 104
acknowledging with comment 105
ALMA instructions 36
condition-related 113
creating in Logix5000 controllers 21
creating in RSLogix 5000 32
creating in Tag Alarm and Event Servers 65, 149
default location for exported 162
digital 24
disabling 107, 108
enabling 73, 107, 109
enabling in RSLinx Enterprise 50
enabling support for data servers 48
filtering 112
generating time-stamped using CST time 202
historical do not switch languages 137
historical logging 113
interacting with 95
monitoring 95
new graphic objects 14
no support for FactoryTalk View ME 45, 59
quantity displayed in Alarm and Event Banner 78
securing 103
setting up 10
silencing 73
simple 113
suppressing 110
synchronizing time stamps 197, 203
tracking-related 113
trigger conditions for digital 151
triggering in Logix5000 controllers 31
unsuppressing 73, 110, 111
viewing details 105
viewing historical 131
ALMA instructions 36
connecting to input references 39
ALMD instructions
adding to RSLogix 5000 27
Always Updating option
for graphic displays in FactoryTalk View 74
analog alarms
creating in RSLogix 5000 32
animation
color 87
applications
adding Tag Alarm and Event Servers in FactoryTalk View 64
creating in FactoryTalk View 45, 59
Local 15, 45, 59
Network 15
opening existing in FactoryTalk View Studio 55
opening in a different language 157
running in SE Client 98, 99
areas
not supported in Local applications 15
showing or hiding in Alarm and Event Log Viewer 124
Audit Log. See FactoryTalk Audit Log
authoring. See historical logging
B
Banner. See Alarm and Event Banner
bits
toggling in RSLogix 5000 32
buttons
adding captions 128, 155
adding to graphic displays 126
using to switch languages at run time 153
C
captions
adding to buttons 128, 155
centering graphic displays on screen 79
clock synchronization
  CompactLogix controllers 213
  ControlLogix processors 213
  DriveLogix controllers 213
  FlexLogix controllers 213
  manual 211
  MicroLogix controllers 213
  PLC-5 controllers 213
  PowerMonitor controllers 213
  SLC 500 controllers 213
  using the Logix5000 Clock Update Tool 205
color animation
  adding to graphic displays 87
columns
  in Alarm and Event Banner at run time 103
Command Wizard 127, 155
  in FactoryTalk View 78, 79, 82, 83
  in startup macros 130
commands
  adding to Alarm and Event Banner 78
  adding to buttons 127, 155
  adding to startup macros 82, 83, 130
  Display 83, 127, 155
  SuppressOff 14
  SuppressOn 14
comments
  entering when acknowledging alarms 105
Communication Setup editor
  in RSLinx Enterprise 49, 62
CompactLogix controllers
  clock synchronization 213
  compatible firmware versions 3
  support for alarms and events 3
comparison
  between software-based and device-based alarm monitoring 13
components
  of FactoryTalk Alarms and Events 9
  start up in FactoryTalk View SE Client 99
condition-related events 113
configuration files
  for FactoryTalk View SE Client 97, 166
connections
  database, for alarm and event historical logging 117
  status of Tag Alarm and Event Server at run time 103
ControlFLASH
  device-based alarm monitoring 22
  language switching 138
  version required 1
controllers
  compatible with Alarms and Events 3
  linking tags with FactoryTalk Directory 54
  selecting paths for device shortcuts in RSLinx Enterprise 50, 63
  synchronizing time clocks 203
ControlLogix processors
  clock synchronization 213
  compatible firmware versions 3
  ControlLogix Safety Processor 3
  support for alarms and events 3
Coordinated System Time
  about 197
  generating time-stamped alarms and events 202
Coordinated Universal Time
  about 198
  coordinating multiple controllers’ clocks 203
CST. See Coordinated System Time

D

data
  viewing for historical alarms 131
data access
  FactoryTalk Administration Console 53
  FactoryTalk View Studio 53
  OPC programmable controllers 53
  PLC-5 controllers 53
  SLC 500 controllers 53
data servers
  adding 47, 53
  adding for PLC-5 controllers 43
  adding for SLC 500 controllers 43
  adding RSLinx Enterprise 43
  adding to applications in FactoryTalk View 55
  enabling alarms and events 48
  RSLinx OPC Server versus RSLinx Remote OPC Server 56

database definitions
  about 11
  adding for historical alarm and event logging 116
  associating with alarm servers 119
  definition of 11
  for historical logging 113
  specifying to display in Log Viewer 124

default language
  using for undefined strings 152

design
  for typical distributed system 215
  for typical stand-alone system 18
  planning your system 18

details
  viewing for alarms 105

device servers
  adding for Logix5000 controllers 43

device shortcuts
  creating in RSLinx Enterprise 49, 62

mapping to controller paths 50, 63

device-based alarm monitoring
  about 5, 9, 13
  choosing over tag-based 16, 43
  compared with software-based 13
  ControlFLASH 22
  definition of 9
  FactoryTalk Administration Console 43
  FactoryTalk View Studio 43
  how it works 13
  language switching 139
  Logix5000 firmware 22
  RSLinx Classic 22
  RSLinx Enterprise 43
  RSLogix 5000 22
  uses for 14

devices
  adding to clock synchronization schedule 208, 210
  removing from clock synchronization schedule 209
  synchronizing clocks manually 211
  viewing clock synchronization 209

Diagnostics Viewer. See FactoryTalk Diagnostics Viewer

digital alarms
  creating in RSLogix 5000 24
  creating in Tag Alarm and Event Servers 149
  trigger conditions 151

disabling alarms 108
  in Tag Alarm and Event Servers 107

Display command 83, 127, 155
  using in FactoryTalk View 79

distributed applications
  about 215
  typical 215

docking
  graphic displays 130
documentation
  finding 4
drawing objects
  adding to graphic displays 86

DriveLogix controllers
  clock synchronization 213
  compatible firmware versions 3
  DriveLogix5370 3
Embedded variables

- in RSLogix 5000 40

Enabling alarms 73, 109

- in Alarm Status Explorer 109
- in Tag Alarm and Event Servers 107

Existing applications. See applications

Adding functions to graphic displays 88

In alarms 84

FactoryTalk Administration Console

- as alternative to FactoryTalk View Studio 54, 61
- data access 53
- device-based alarm monitoring 43
- language switching 138
- tag-based alarm monitoring 57

FactoryTalk Alarms and Events

- about 5
- compatible controllers 3
- components 9
- installing manually 179
- new graphic objects 14
- setting up 10
- version required 1
- versus HMI Tag Alarm Monitoring 5, 6

FactoryTalk Audit Log

- about 10, 11
- definition of 11

FactoryTalk Diagnostics

- about 10

FactoryTalk Diagnostics Viewer

- about 11
- definition of 11

FactoryTalk Directory

- linking with controller tags 54

FactoryTalk documentation

- finding 4

FactoryTalk Security

- and alarms and events 6

FactoryTalk Services Platform

- version required 1

FactoryTalk View ME 45, 59

- See also FactoryTalk View Studio

FactoryTalk View SE 95

- See also FactoryTalk View SE Client
- See also FactoryTalk View Studio
- documentation 4
- new graphic objects for alarms and events 14
- version required 1

FactoryTalk View SE Client 95, 113, 114

- auto logout period 100
- configuring 97, 166
- language switching 138
- running applications 98, 99
- setting up run-time window 100
- starting from within FactoryTalk View Studio 132
- startup components 99
FactoryTalk View Studio 69, 114
   See also FactoryTalk View ME
   See also FactoryTalk View SE
adding data servers 55
adding Tag Alarm and Event Servers 64
as alternative to FactoryTalk Administration Console 54, 61
Command Wizard 79
creating alarm messages 147
creating applications 45, 59
creating graphic displays 69
data access 53
device-based alarm monitoring 43
historical logging 114
language switching 138
opening existing applications 55
saving graphic displays 75, 157
setting up graphic displays 74, 81, 129
starting the FactoryTalk View SE Client 132
tag-based alarm monitoring 57
version required 1
filtering alarms 112
firmware. See Logix5000 firmware
FlexLogix controllers
clock synchronization 213
support for alarms and events 3
function block diagrams
   in RSLinx 5000 35, 36
functions
   adding to graphic displays 88
G
   getting started 8
   graphic displays
      See also graphic objects
      about 69
      adding buttons 126
      adding drawing objects 86
      centering on screen 79
      creating in FactoryTalk View 71, 72
      creating in FactoryTalk View Studio 69
docking to bottom of screen 84
docking to top of screen 130
performance 74
refreshing automatically 74
saving 75, 82, 91, 125, 129, 157
sizing 74, 81, 129
test running 92
title bars 74, 81, 129
graphic objects
   Alarm and Event Banner 14, 75, 76
   Alarm and Event Log Viewer 14, 122
   Alarm and Event Summary 14, 73, 156
   Alarm Status Explorer 14
   HMI Tag Alarm Log Viewer 14
   HMI Tag Alarm Summary 14
   new alarms and events objects 14
H
   Help
      finding 4
   Historian. See Alarm and Event Historian
historical alarms
  do not switch languages 137
  viewing 131
historical logging
  associating databases with alarm servers 119
  database definitions 113
  enabling in RSLinx Enterprise 119
  enabling in Tag Alarm and Event Servers 119
  language switching 139
  Microsoft SQL Server Express 114
  setting up for alarms and events 113
  SQL Server Express 113
HMI Tag Alarm Log Viewer 14
HMI Tag Alarm Monitoring
  about 11
  how it works 11
  versus FactoryTalk Alarms and Events 5, 6
HMI Tag Alarm Summary 14

icons
  about warning icons 49, 63
input references
  connecting to input of ALMA block 39
  in RSLogix 5000 37
installation
  .NET Framework 185
  Logix5000 Clock Update Tool 204
  manual installation 179
  Microsoft SQL Server 2005 Express 19, 183
  planning 18

J
  JSR instructions
    adding to RSLogix 5000 41

K
  KEPWare OPC data server
    support for alarms and events 4

L
  labels
    adding to buttons 128
language switching 137
  about 139
  Alarm and Event Banner 173
  Alarm and Event Log Viewer 174
  Alarm and Event Summary 173
  alarm messages in FactoryTalk View Studio 147
  ControlFLASH 138
  device-based alarm messages 139
  displaying undefined strings in default language 152
  editing alarm messages 157
  editing applications in different languages 157
  FactoryTalk Administration Console 138
  FactoryTalk View SE Client 138
  FactoryTalk View Studio 138
  historical alarms do not switch languages 137
  how it works 139
  importing alarm messages into Tag alarm and Event Servers 164
  items that do not switch languages 137
  Logix5000 controllers 138
  Microsoft Excel 138
  PLC-5 controllers 138
  RSLinx Classic 138
  RSLinx Enterprise 138, 139
  RSLogix 5 138
  RSLogix 500 138
  RSLogix 5000 138
  SLC 500 controllers 138
  Tag Alarm and Event Servers 147
  tag-based alarm messages 147
  testing at run time 170
  text that does not switch languages at run time 173
  text that switches languages at run time 173
  time and date formats do not switch 137
  tips for setting up 172
  .txt files for Unicode character sets in RSLogix 5000 141
  Unicode character sets in RSLogix 5000 141
  using buttons to switch languages at run time 153

languages
  editing alarm messages 157
  editing applications in different 157
  importing alarm messages into Tag Alarm and Event Servers 164

limits
  controller specifications 175
  tested system limits 175, 176

Local applications. See applications
  log file
    changing location for Logix5000 Clock Update Tool 211
    viewing for Logix5000 Clock Update Tool 211
  Log Viewer. See Alarm and Event Log Viewer
  logging. See historical logging
  logic
    creating new in RSLogix 5000 25
  Logix5000 Clock Update Tool 203
    changing location of log file 211
    installing 204
    starting automatically 204
    synchronizing clocks 205
    synchronizing clocks manually 211
    viewing log file 211
Logix5000 controllers 31
  See also Logix5000 firmware
  about built-in alarm instructions 5
  acknowledgement required 40
  adding device servers 43
  ALMA instructions 36
  analog alarms 32
  configuring alarm blocks 40
  creating alarms 21
  defining routines 34
  digital alarms 24
  downloading programs to 30
  embedded variables in alarm messages 40
  firmware required for device-based alarm monitoring 16
  function block diagrams 35, 36
  input references 37
  JSR instructions 41
  language switching 138
  mapping to device shortcuts in RSLinx Enterprise 50, 63
  Run Mode 42
  support for alarms and events 3, 4
  tag-based alarm monitoring 10, 57
  tags 38
  triggering alarms 31
  Who Active 42
Logix5000 firmware
  device-based alarm monitoring 22
  versions compatible with Alarms and Events 3
  when to update 19
logout
  in FactoryTalk View SE Client 100

M
  macros
    creating 129
    editing 130
    saving 84, 131
    startup 82, 129, 130
  manuals
    finding 4
  maximum length
    alarm messages 29, 157, 163
  MDAC 2.8
    installing for SQL Server 185
  MicroLogix controllers
    clock synchronization 213
Microsoft Excel
  editing alarm messages 157, 162
  exporting alarm messages from Tag Alarm and Event Servers 160
  language switching 138
Microsoft SQL Server 14
  See also Microsoft SQL Server 2005 Express
  version required 1
Microsoft SQL Server 2005 Express
  configuring Windows firewall 190
  historical logging 113, 114
  install batch file 186
  installing 19, 183
  installing .NET Framework 185
  installing MDAC 2.8 185
  installing Microsoft SQL Server Management Studio Express 189
  installing MSXML6 186
  installing Windows Installer 3.1 186
Microsoft SQL Server Management Studio Express
  error during installation 189
  installing 189
Microsoft SQL Server. See SQL Server
monitoring for alarms
about 11
about device-based 13
about HMI Tag Alarm Monitoring 11
about tag-based 11
choosing between tag- and device-based 16, 43
comparison of methods 13
how device-based works 13
how HMI Tag Alarm Monitoring works 11
how tag-based works 11
uses for device-based 14
uses for tag-based 14
MSXML6
installing for SQL Server 186

N
Network applications. See applications
Notepad
editing exported alarm messages 141

O
objects. See graphic objects
OPC Data Servers
about 6
OPC data servers
adding to applications in FactoryTalk View 55
RSLinx OPC Server vs. RSLinx Remote OPC Server 56
specifying name 55
support for alarms and events 4
tag-based alarm monitoring 10
OPC Data Servers. See OPC Data Servers
OPC programmable controllers
data access 53

P
performance
controller specifications 175
of graphic displays 74
tested system limits 176
tested system performance 175
tested system topology 177
planning your system 15
distributed applications 215
install and activation 18
local applications 18
PLC-5 controllers
adding data servers for 43
adding Tag Alarm and Event Servers for 57
clock synchronization 213
data access 53
language switching 138
support for alarms and events 4
tag-based alarm monitoring 10, 57
PowerMonitor controllers
clock synchronization 213
process data
about 6
process faceplates
adding 46, 60
ProgID
for data servers 55
programs
downloading to controllers from RSLogix 5000 30, 42, 144, 147
projects
creating new in RSLogix 5000 24
downloading to controllers from RSLogix 5000 144, 147

Q
question marks
appear at run time in graphic displays 152
required hardware 2
required software 1
resizing
  graphic displays 74, 81, 129
Rockwell Automation Device Server. See RSLinx Enterprise
  routines
    defining in RSLogix 5000 34
routing services
  for alarms and events 10
RSLogix Classic
  device-based alarm monitoring 22
documentation 4
downloading programs to controllers 30, 42
language switching 138
support for PLC-5 and SLC 500 controllers 4, 57
tag-based alarm monitoring 10, 57, 138
version required 1
RSLinx Enterprise 10, 69, 95, 114
  adding data servers 43, 47
  associating databases for historical logging 119
Communication Setup editor 49, 62
ccontroller paths for device shortcuts 50, 63
device shortcuts 49, 62
device-based alarm monitoring 43
documentation 4
enabling alarms and events 48, 50
historical logging 114
language switching 138, 139
uploads alarm messages to controllers 139
version required 1
RSLinx Gateway
tag-based alarm monitoring 10
RSLinx OPC Server
  versus RSLinx Remote OPC Server 56
RSLinx Remote OPC Server
  versus RSLinx OPC Server 56
RSLogix 5 53
  language switching 138
tag-based alarm monitoring 57
  version required 1
RSLogix 500 53
  language switching 138
tag-based alarm monitoring 57
  version required 1
RSLogix 5000
  acknowledgement required 40
  adding alarm instructions 27
  ALMA instructions 36
  ALMD instructions 27
  analog alarms 32
  configuring alarm blocks 40
  creating a new project 24
  creating new logic 25
  creating tags 26
  .csv format does not support Unicode 141
  device-based alarm monitoring 22
  documentation 4
  downloading programs to controllers 30, 42, 144, 147
  embedded variables in alarm messages 40
  function block diagrams 35, 36
  importing alarm messages 143, 146
  input references 37
  JSR instructions 41
  language switching 138
  Run Mode 42
  starting 24
  switching controllers to Run Mode 31
  toggling bits 32
  triggering alarms 31
  version required 1
  Who Active 42
RSLogix Emulate 5000
  support for alarms and events 3
Run Mode
for Logix5000 controllers 31, 42
run time
about displayed data at 6
interacting with alarms 95
monitoring alarms 95
setting up window in FactoryTalk View SE Client 100

S
schedules
  adding devices for synchronizing clocks 208, 210
  creating for synchronizing clocks 206
  enabling or disabling for synchronizing clocks 207
  modifying for synchronizing clocks 207
  removing devices for synchronizing clocks 209
  removing for synchronizing clocks 207
security
  auto logout in FactoryTalk View SE Client 100
  for alarms and events 103
services
  routing for alarms and events 10
shortcuts. See device shortcuts
silencing alarms 73
simple events 113
sizing
  graphic displays 74, 81, 129
SLC 500 controllers
  adding data servers for 43
  adding Tag Alarm and Event Servers for 57
  clock synchronization 213
  data access 53
  language switching 138
  support for alarms and events 4
  tag-based alarm monitoring 10, 57
SoftLogix controllers
  compatible firmware versions 3
  support for alarms and events 3
  version required 1
software
  required 1
software-based alarm monitoring
  compared with device-based 13
software-based tag servers. See Tag Alarm and Event Servers
stand-alone applications. See applications
stand-alone system
  design for typical 18
startup components
  in FactoryTalk View SE Client 99
startup macros
  adding commands 83, 130
  creating 129
  editing 130
  for graphic displays in FactoryTalk View 82
  saving 131
  specifying in FactoryTalk View SE Client 99
Summary. See Alarm and Event Summary
Suppressed list
  in FactoryTalk View SE 14
  suppressing alarms 110
SuppressOff command 14
SuppressOn command 14
switching languages. See language switching
switching to Run Mode 31
synchronization schedules
  adding devices for synchronizing clocks 208, 210
  creating for synchronizing clocks 206
  enabling or disabling for synchronizing clocks 207
  modifying for synchronizing clocks 207
  removing devices for synchronizing clocks 209
  removing for synchronizing clocks 207
synchronizing controller clocks 203
system performance. See performance
system tags
  in FactoryTalk View 14
system time 198
Tag Alarm and Event Servers

- adding for PLC-5 controllers 57
- adding for SLC 500 controllers 57
- adding for third-party controllers 57
- adding in FactoryTalk View Studio 64
- adding to applications 64
- connection status at run time 103
- creating alarms 65, 149
- enabling historical logging 119
- exporting alarm messages in Excel format 147
- exporting alarm messages in XML format 147
- exporting alarm messages to Microsoft Excel 160
- language switching 147
- time stamps 212
- uses for 4

Tag-based alarm monitoring

- about 5, 10, 11, 16, 43
- adding Tag Alarm and Event Servers 64
- creating alarms in Tag Alarm and Event Servers 65
- definition of 10
- FactoryTalk View Studio 57
- how it works 11
- language switching 147
- Logix5000 controllers 10, 57
- OPC data servers 10
- PLC-5 controllers 10, 57
- RSLinx Classic 10, 57, 138
- RSLinx Gateway 10
- RSLogix 5 57
- RSLogix 500 57
- SLC 500 controllers 10, 57
- third-party controllers 10
- uses for 14

Tag-based alarms

- time stamps 212
undefined strings
displaying in default language 152

Unicode character sets
language switching in RSLogix 5000 141
using .txt files with RSLogix 5000 141

unsuppressing alarms 73, 110, 111
user’s guides. See documentation
uses for device-based alarm monitoring 14
uses for tag-based alarm monitoring 14
UTC. See Coordinated Universal Time

variables. See embedded variables

wall clock time 197
warning icons
about 49, 63
Who Active
in RSLogix 5000 42
windows
docked to bottom of screen 84
docking to top of screen 130
setting up for run time in FactoryTalk View SE Client 100

Windows 2000
version required 1
Windows firewall
configuring for SQL Server 190

Windows Installer 3.1
installing for SQL Server 186

Windows Server 2003
version required 1
Windows XP
version required 1

yellow triangles. See warning icons